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Warranty

The media on which you receive National Instruments software are warranted not to fail to execute programmi
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media th
not execute programming instructions if National Instruments receives notice of such defects during the warra
period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the ou
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shi
costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefull
reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments re
the right to make changes to subsequent editions of this document without prior notice to holders of this editio
reader should consult National Instruments if errors are suspected. In no event shall National Instruments be lia
any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND 
SPECIFICALLY DISCLAIMS ANY  WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. 
CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  
INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL  INSTRUMENTS 
WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA , PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This l imitation of the l iability of National 
Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any ac
against National Instruments must be brought within one year after the cause of action accrues. National Instru
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty pro
herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow t
National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third par
other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part,
without the prior written consent of National Instruments Corporation.

Trademarks

DAQCard™, DAQPad™, DAQPnP™, DAQ-STC™, LabVIEW®, MITE™, National Instruments®, natinst.com™, 
NI-DAQ®, NI-PGIA™, RTSI®, and SCXI™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reli
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving
medical or clinical treatment can create a potential for accidental injury caused by product failure, or by errors 
part of the user or application designer. Any use or application of National Instruments products for or involvin
medical or clinical treatment must be performed by properly trained and qualified medical personnel, and all trad
medical safeguards, equipment, and procedures that are appropriate in the particular situation to prevent seriou
or death should always continue to be used when National Instruments products are being used. National Instr
products are NOT intended to be a substitute for any form of established process, procedure, or equipment us
monitor or safeguard human health and safety in medical or clinical treatment.



© National Instruments Corporation v LabVIEW Data Acq
Contents
xix
xx
.xxii
xxiii

-4
-5

-8
8
0
-12

3-1
-3
-4

3-4
-5

-5
-5

.3-5
3-6
About This Manual
Organization of This Manual ...........................................................................................
Conventions Used in This Manual...................................................................................
Related Documentation...................................................................................................
Customer Communication ...............................................................................................

Section One:  Before You Get Started

Chapter 1

How To Use This Book

Chapter 2

Installing and Configuring Your Data Acquisition Hardware
LabVIEW Data Acquisition Hardware Support ..............................................................2
Installing and Configuring Your National Instruments Device.......................................2

Installing and Configuring Your DAQ Device in Windows.............................2-6
Configuring Your DAQ Device Using NI-DAQ on the Macintosh..................2-6
Installing and Configuring Your SCXI Chassis ................................................2

Hardware Configuration .....................................................................2-
(Macintosh)  Software Configuration..................................................2-1

Configuring Your Channels in Windows ........................................................................2

Chapter 3

Basic LabVIEW Data Acquisition Concepts
Location of Common DAQ Examples.............................................................................
Locating the Data Acquisition VIs in LabVIEW.............................................................3
DAQ VI Organization......................................................................................................3

Easy VIs.............................................................................................................
Intermediate VIs ................................................................................................3
Utility VIs ..........................................................................................................3
Advanced VIs ....................................................................................................3

VI Parameter Conventions..............................................................................................
Default and Current Value Conventions..........................................................................
uisition Basics Manual



Contents

3-7

3-8
. 3-9

-14

4-3

5-1
-2
-2
-3
. 5-3
5-3
5-4
-5
5-6
-9
5-11
5-12
-14
14
-15
5-18

6-1
-3
-6
6
8
-10
Common DAQ VI Parameters.........................................................................................
Error Handling.................................................................................................................3-8
(Windows)  Channel Name Addressing...........................................................................
Channel, Port, and Counter Addressing .........................................................................
Limit Settings .................................................................................................................. 3-11
Data Organization for Analog Applications.................................................................... 3

Chapter 4

Where You Should Go Next
Questions You Should Answer .......................................................................................

Section Two:  Catching the Wave with Analog Input

Chapter 5

Things You Should Know about Analog Input
Defining Your Signal ......................................................................................................

To What Is Your Signal Referenced? ............................................................... 5
Grounded Signal Sources ................................................................... 5
Floating Signal Sources...................................................................... 5

Choosing Your Measurement System............................................................................
Resolution .........................................................................................................
Device Voltage Range ......................................................................................
Signal Voltage Range (Limit Settings) ............................................................. 5

Considerations for Selecting Analog Input Settings .......................................................
Differential Measurement System .................................................................... 5
Referenced Single-Ended Measurement System..............................................
Nonreferenced Single-Ended Measurement System.........................................

LabVIEW and Analog Input ........................................................................................... 5
Channel Addressing with the AMUX-64T ....................................................... 5-
The AMUX-64T Scanning Order ..................................................................... 5

Important Terms You Should Know ...............................................................................

Chapter 6

One-Stop Single-Point Acquisition
Single-Channel, Single-Point Analog Input....................................................................
Multiple-Channel Single-Point Analog Input ................................................................. 6
Using Analog Input/Output Control Loops..................................................................... 6

Using Software-Timed Analog I/O Control Loops........................................... 6-
Using Hardware-Timed Analog I/O Control Loops ......................................... 6-
Improving Control Loop Performance.............................................................. 6
LabVIEW Data Acquisition Basics Manual vi © National Instruments Corporation



Contents

7-1
-2
3
7-5
5
7
8
-8
-9

11
-12
-14

-14
-15
5

15
15
16
-16
-16

8-1
-2
3
5
-5
7
8-9
12

-3
-5

9-8
Chapter 7

Buffering Your Way through Waveform Acquisition
Can You Wait for Your Data? .........................................................................................

Acquiring a Single Waveform...........................................................................7
Acquiring Multiple Waveforms ........................................................................7-

Simple-Buffered Analog Input Examples........................................................................
Simple-Buffered Analog Input with Graphing..................................................7-
Simple-Buffered Analog Input with Multiple Starts .........................................7-
Simple-Buffered Analog Input with a Write to Spreadsheet File .....................7-
Triggered Analog Input .....................................................................................7

Do You Need To Access Your Data during Acquisition?...............................................7
Continuously Acquiring Data from Multiple Channels ....................................7-
Asynchronous Continuous Acquisition using DAQ Occurrences.....................7

Circular-Buffered Analog Input Examples......................................................................7
Basic Circular-Buffered Analog Input ..............................................................7
Other Circular-Buffered Analog Input Examples .............................................7

Cont Acq&Chart (buffered).vi............................................................7-1
Cont Acq&Graph (buffered).vi...........................................................7-
Cont Acq to File (binary).vi................................................................7-
Cont Acq to File (scaled).vi ................................................................7-
Cont Acq to Spreadsheet File.vi .........................................................7

Simultaneous Buffered Waveform Acquisition and Waveform Generation...................7

Chapter 8

Controlling Your Acquisition with Triggers
Hardware Triggering........................................................................................................

Digital Triggering..............................................................................................8
Digital Triggering Examples...............................................................8-
Digital Triggering Examples...............................................................8-

Analog Triggering .............................................................................................8
Analog Triggering Examples..............................................................8-

Software Triggering .........................................................................................................
Conditional Retrieval Examples .........................................................8-

Chapter 9

Letting an Outside Source Control Your Acquisition Rate
Externally Controlling your Channel Clock ....................................................................9
Externally Controlling your Scan Clock..........................................................................9
Externally Controlling the Scan and Channel Clocks .....................................................
© National Instruments Corporation vii LabVIEW Data Acquisition Basics Manual



Contents

10-
10-1

11-1
11-3

12-1
2-3
-5
12-5

3-1
3-3

14-1
4-1

14-3
14-4
4-4

14-6
14-7
Section Three:  Making Waves with Analog Output

Chapter 10

Things You Should Know about Analog Output
Single-Point Output .........................................................................................................1
Buffered Analog Output ..................................................................................................

Chapter 11

One-Stop Single-Point Generation
Single-Immediate Updates ..............................................................................................
Multiple-Immediate Updates...........................................................................................

Chapter 12

Buffering Your Way through Waveform Generation
Buffered Analog Output ..................................................................................................
Changing the Waveform during Generation: Circular-Buffered Output ........................ 1
Eliminating Errors from Your Circular-Buffered Application........................................ 12
Buffered Analog Output Examples .................................................................................

Chapter 13

Letting an Outside Source Control Your Update Rate
Externally Controlling Your Update Clock..................................................................... 1
Supplying an External Test Clock from Your DAQ Device........................................... 1

Chapter 14

Simultaneous Buffered Waveform Acquisition and Generation
Using E-Series MIO Boards............................................................................................

Software Triggered ........................................................................................... 1
Hardware Triggered ..........................................................................................

Using Legacy MIO Boards..............................................................................................
Software Triggered ........................................................................................... 1
Hardware Triggered ..........................................................................................

Using Lab/1200 Boards...................................................................................................
LabVIEW Data Acquisition Basics Manual viii © National Instruments Corporation



Contents

5-2

7-2
17-5
17-6
7-7
7-9

18-1

.18-5

19-5
-5

6
-6
9-6
7

Section Four:  Getting Square with Digital I/O

Chapter 15

Things You Should Know about Digital I/O
Types of Digital Acquisition/Generation.........................................................................1

Chapter 16

When You Need It Now�Immediate Digital I/O

Chapter 17

Shaking Hands with a Digital Partner
Sending Out Multiple Digital Values ..............................................................................1
Non-Buffered Handshaking .............................................................................................
Buffered Handshaking .....................................................................................................

Simple Buffered Examples................................................................................1
Circular-Buffered Examples..............................................................................1

Section Five:  SCXI�Getting Your Signals in Great Condition

Chapter 18

Things You Should Know about SCXI
What is Signal Conditioning? ..........................................................................................
Amplification ...................................................................................................................18-3
Isolation ...........................................................................................................................18-4
Filtering............................................................................................................................18-5
Transducer Excitation .....................................................................................................
Linearization ....................................................................................................................18-5

Chapter 19

Hardware and Software Setup for Your SCXI System
SCXI Operating Modes ...................................................................................................

Multiplexed Mode for Analog Input Modules ..................................................19
(Windows)  Multiplexed Mode for the SCXI-1200.............................19-5
Multiplexed Mode for Analog Output Modules .................................19-

Multiplexed Mode for Digital and Relay Modules ...........................................19
Parallel Mode for Analog Input Modules..........................................................1

(Windows)  Parallel Mode for the SCXI-1200....................................19-
© National Instruments Corporation ix LabVIEW Data Acquisition Basics Manual



Contents

9-7
9-8

20-1

0-5

21-2
1-2
1-3
-5
1-6
1-10
21-13
1-16
1-17
1-19

21-20

2-1
22-3
-4
2-5
-6

2-7

23-2
3-4
3-5
Parallel Mode for Digital Modules ................................................................... 1
SCXI Software Installation and Configuration ............................................................... 1

Chapter 20

Special Programming Considerations for SCXI
SCXI Channel Addressing ..............................................................................................
SCXI Gains...................................................................................................................... 20-2

SCXI Settling Time........................................................................................... 2

Chapter 21

Common SCXI Applications
Analog Input Applications for Measuring Temperature and Pressure............................

Measuring Temperature with Thermocouples .................................................. 2
Temperature Sensors for Cold-Junction Compensation..................... 2
Amplifier Offset ................................................................................. 21
VI Examples ....................................................................................... 2

Measuring Temperature with RTDs ................................................................. 2
Measuring Pressure with Strain Gauges ...........................................................

Analog Output Application Example.............................................................................. 2
Digital Input Application Example ................................................................................. 2
Digital Output Application Example............................................................................... 2
Multi-Chassis Applications .............................................................................................

Chapter 22

SCXI Calibration�Increasing Signal Measurement Precision
EEPROM—Your System’s Holding Tank for Calibration Constants ............................ 2
Calibrating SCXI Modules ..............................................................................................

SCXI Calibration Methods for Signal Acquisition........................................... 22
One-Point Calibration......................................................................... 2
Two-Point Calibration ........................................................................ 22

Calibrating SCXI Modules for Signal Generation............................................ 2

Section Six:  Counting Your Way to High Precision Timing

Chapter 23

Things You Should Know about Counters
Knowing the Parts of Your Counter ................................................................................
Knowing Your Counter Chip .......................................................................................... 2
Counting Operations When All Your Counters Are Used .............................................. 2
LabVIEW Data Acquisition Basics Manual x © National Instruments Corporation



Contents

..24-1

..24-3
.24-5
24-5
24-7
4-8

.24-9

.25-1
25-2
5-3
25-4

26-1
..26-2
26-4
26-5

.27-3
7-5

.29-1
29-2
Chapter 24

Generating a Square Pulse or Pulse Trains
Generating a Square Pulse .............................................................................................
Generating a Single Square Pulse ..................................................................................
Generating a Pulse Train.................................................................................................

Generating a Continuous Pulse Train................................................................
Generating a Finite Pulse Train.........................................................................

Knowing the Accuracy of Your Counters .......................................................................2
Stopping Counter Generations........................................................................................

Chapter 25

Measuring Pulse Width
Measuring a Pulse Width ................................................................................................
Determining Pulse Width.................................................................................................
Controlling Your Pulse Width Measurement ..................................................................2
Increasing Your Measurable Width Range......................................................................

Chapter 26

Measuring Frequency and Period
Knowing How and When to Measure Frequency and Period..........................................
Connecting Counters to Measure Frequency and Period...............................................
Measuring the Frequency and Period of Low Frequency Signals ...................................
Measuring the Frequency and Period of High Frequency Signals ..................................

Chapter 27

Counting Signal Highs and Lows
Counting Events or Elapsed Time ..................................................................................
Gaining More Control over Your Counting Operations..................................................2

Chapter 28

Dividing Frequencies

Section Seven:  Debugging Your Data Acquisition Application

Chapter 29

Debugging Techniques
Hardware Connection Errors ..........................................................................................
Software Configuration Errors.........................................................................................
© National Instruments Corporation xi LabVIEW Data Acquisition Basics Manual



Contents

29-2
9-2
9-3
9-4
29-4
9-4

-2
3
6
7

10
0

3-3
-3
-4
6
8
3-9
-11

3-12
3-13
-14

-15
-15
16
-16
VI Construction Errors ....................................................................................................
Error Handling .................................................................................................. 2
Single-Stepping through a VI ........................................................................... 2
Execution Highlighting ..................................................................................... 2
Using the Probe Tool ........................................................................................
Setting Breakpoints and Showing Advanced DAQ VIs ................................... 2

Appendix A

LabVIEW Data Acquisition Common Questions

Appendix B

Customer Communication

Glossary

Index

Figures
Figure 2-1. Installing and Configuring DAQ Devices............................................... 2
Figure 2-2. How NI-DAQ Relates to Your System and DAQ Devices .................... 2-
Figure 2-3. NI-DAQ Device Window Listing........................................................... 2-
Figure 2-4. Accessing the Device Configuration Window in NI-DAQ .................... 2-
Figure 2-5. Device Configuration and I/O Connector Windows in NI-DAQ ........... 2-8
Figure 2-6. Accessing the NI-DAQ SCXI Configuration Window........................... 2-
Figure 2-7. SCXI Configuration Window in NI-DAQ.............................................. 2-1

Figure 3-1. Accessing the Data Acquisition Palette ..................................................
Figure 3-2. Data Acquisition VIs Palette................................................................... 3
Figure 3-3. Analog Input VI Palette Organization .................................................... 3
Figure 3-4. LabVIEW Help Window Conventions ................................................... 3-
Figure 3-5. LabVIEW Error In Input and Error Out Output Error Clusters.............. 3-
Figure 3-6. Channel String Controls..........................................................................
Figure 3-7. Channel String Array Controls ............................................................... 3
Figure 3-8. Limit Settings, Case 1.............................................................................
Figure 3-9. Limit Settings, Case 2.............................................................................
Figure 3-10. Example of a Basic 2D Array ................................................................. 3
Figure 3-11. 2D Array in Row Major Order................................................................ 3
Figure 3-12. 2D Array in Column Major Order .......................................................... 3
Figure 3-13. Extracting a Single Channel from a Column Major 2D Array ............... 3-
Figure 3-14. Analog Output Buffer 2D Array............................................................. 3
LabVIEW Data Acquisition Basics Manual xii © National Instruments Corporation



Contents

5-1
5-2
5-3
-4
-5

-6
-10
-11

.5-12

.5-13

-2
2

-3
-4
4
5
-7

-2
3
-3
4
-6
-6
-7
-8
-10
12
-13
15

-2

4
-6

7
8
-10
-11
Figure 5-1. Types of Analog Signals .........................................................................
Figure 5-2. Grounded Signal Sources........................................................................
Figure 5-3. Floating Signal Sources...........................................................................
Figure 5-4. The Effects of Resolution on ADC Precision .........................................5
Figure 5-5. The Effects of Range on ADC Precision.................................................5
Figure 5-6. The Effects of Limit Settings on ADC Precision....................................5
Figure 5-7. 8-Channel Differential Measurement System.........................................5
Figure 5-8. Common-Mode Voltage..........................................................................5
Figure 5-9. 16-Channel RSE Measurement System .................................................
Figure 5-10. 16-Channel NRSE Measurement System...............................................

Figure 6-1. AI Sample Channel VI ............................................................................6
Figure 6-2. Acquiring Data Using the Acquire 1 Point from 1 Channel VI ..............6-
Figure 6-3. Acquiring a Voltage from Multiple Channels with the

AI Sample Channels VI...........................................................................6
Figure 6-4. The AI Single Scan VI Help Diagram.....................................................6
Figure 6-5. Using the Intermediate VIs for a Basic Non-Buffered Application........6-
Figure 6-6. The Cont Acq&Chart (immediate) VI Block Diagram...........................6-
Figure 6-7. Software-Timed Analog I/O....................................................................6
Figure 6-8. Analog IO Control Loop (hw timed) VI Block Diagram........................6-9

Figure 7-1. How Buffers Work ..................................................................................7
Figure 7-2. The AI Acquire Waveform VI ................................................................7-
Figure 7-3. The AI Acquire Waveforms VI...............................................................7
Figure 7-4. Using the Intermediate VIs to Acquire Multiple Waveforms .................7-
Figure 7-5. Simple Buffered Analog Input Example.................................................7
Figure 7-6. Simple Buffered Analog Input with Graphing........................................7
Figure 7-7. Taking a Specified Number of Samples with the Intermediate VIs........7
Figure 7-8. Writing to a Spreadsheet File after Acquisition ......................................7
Figure 7-9. How a Circular Buffer Works .................................................................7
Figure 7-10. Continuously Acquiring Data with the Intermediate VIs........................7-
Figure 7-11. Continuous Acq&Chart (Async Occurrence) VI ....................................7
Figure 7-12. Basic Circular-Buffered Analog Input Using the Intermediate VIs........7-

Figure 8-1. Diagram of a Digital Trigger...................................................................8
Figure 8-2. Digital Triggering with Your DAQ Device ............................................8-3
Figure 8-3. Block Diagram of the Acquire N Scans Digital Trig VI.........................8-
Figure 8-4. Diagram of an Analog Trigger ................................................................8
Figure 8-5. Analog Triggering with Your DAQ Device............................................8-
Figure 8-6. Block Diagram of the Acquire N Scans Analog Hardware Trig VI .......8-
Figure 8-7. Timeline of Conditional Retrieval...........................................................8
Figure 8-8. The AI Read VI Conditional Retrieval Cluster .......................................8
© National Instruments Corporation xiii LabVIEW Data Acquisition Basics Manual



Contents

5

Figure 8-9. Block Diagram of the Acquire N Scans Analog Software Trig VI ........ 8-12

Figure 9-1. Channel and Scan Intervals Using the Channel Clock ........................... 9-1
Figure 9-2. Round-Robin Scanning Using the Channel Clock.................................. 9-2
Figure 9-3. Example of a TTL Signal........................................................................ 9-3
Figure 9-4. Getting Started Analog Input Example VI.............................................. 9-4
Figure 9-5. Setting the Clock Source Code for External Conversion Pulses 

for E Series Devices.............................................................................. 9-
Figure 9-6. Externally Controlling Your Scan Clock with the Getting Started

Analog Input Example VI ....................................................................... 9-7
Figure 9-7. Controll ing the Scan and Channel Clock Simultaneously...................... 9-8

Figure 11-1. Single Immediate Update Using the AO Update Channels VI ............... 11-1
Figure 11-2. Single Immediate Update Using the AO Update Channel VI ................ 11-2
Figure 11-3. Single Immediate Update Using Intermediate VI................................... 11-2
Figure 11-4. Multiple Immediate Updates Using Intermediate VI.............................. 11-3

Figure 12-1. Waveform Generation Using the AO Generate Waveforms VI ............. 12-1
Figure 12-2. Waveform Generation Using the AO Waveform Gen VI....................... 12-2
Figure 12-3. Waveform Generation Using Intermediate VIs...................................... 12-3
Figure 12-4. Circular Buffered Waveform Generation Using the AO 

Continuous Gen VI ................................................................................. 12-4
Figure 12-5. Circular Buffered Waveform Generation Using Intermediate VIs......... 12-5
Figure 12-6. Display and Output Acq’d File (scaled) VI ............................................ 12-6

Figure 13-1. Generate N Updates-ExtUpdateClk VI................................................... 13-2

Figure 14-1. Simultaneous Input/Output using the Simul AI/AO Buffered
(E-series MIO) VI ................................................................................... 14-2

Figure 14-2. Simultaneous Input/Output using the Simul AI/AO Buffered Trigger
(E-series MIO) VI ................................................................................... 14-3

Figure 14-3. Simultaneous Input/Output using the Simul AI/AO Buffered
(legacy MIO) VI ..................................................................................... 14-5

Figure 14-4. Simultaneous Input/Output using the Simul AI/AO Buffered Trigger
(legacy MIO) VI ..................................................................................... 14-6

Figure 15-1. Digital Ports and Lines............................................................................ 15-1

Figure 16-1. The Easy Digital VIs............................................................................... 16-2

Figure 17-1. Connecting Signal Lines for Digital Input.............................................. 17-3
Figure 17-2. Connecting Digital Signal Lines for Digital Output ............................... 17-4
Figure 17-3. Non-buffered Handshaking Using the DIO Single Read/Write VI ........ 17-5
LabVIEW Data Acquisition Basics Manual xiv © National Instruments Corporation



Contents
Figure 17-4. Non-buffered Handshaking Using the DIO Single Read/Write VI.........17-6
Figure 17-5. Pattern Generation Using the DIO-32 Series Devices............................17-7
Figure 17-6. Pattern Generation Using DAQ Devices (Other Than DIO-32

Series Devices) ........................................................................................17-8
Figure 17-7. Reading Data with the Digital VIs Using Digital Handshaking

(DIO-32 Series Devices) .........................................................................17-9
Figure 17-8. Reading Data with the Digital VIs Using Digital Handshaking .............17-9
Figure 17-9. Digital Handshaking Using a Circular Buffer.........................................17-10

Figure 18-1. Common Types of Transducers/Signals and Signal Conditioning .........18-3
Figure 18-2. Amplifying Signals Near the Source to Increase

Signal-to-Noise Ratio..............................................................................18-4

Figure 19-1. SCXI System...........................................................................................19-2
Figure 19-2. Components of an SCXI System.............................................................19-3
Figure 19-3. SCXI Chassis...........................................................................................19-4

Figure 21-1. Continuous Transducer Measurement VI................................................21-6
Figure 21-2. Measuring a Single Module with the Acquire and Average VI ..............21-7
Figure 21-3. Measuring Temperature Sensors Using the Acquire and Average VI ....21-8
Figure 21-4. Continuously Acquiring Data Using Intermediate VIs...........................21-9
Figure 21-5. Measuring Temperature Using Information from the DAQ

Channel Wizard.......................................................................................21-12
Figure 21-6. Measuring Temperature Using the Convert RTD Reading VI................21-13
Figure 21-7. Half-Bridge Strain Gauge........................................................................21-14
Figure 21-8. Measuring Pressure Using Information from the DAQ

Channel Wizard.......................................................................................21-15
Figure 21-9. Convert Strain Gauge Reading VI...........................................................21-16
Figure 21-10. SCXI-1124 Update Channels VI .............................................................21-17
Figure 21-11. Inputting Digital Signals through an SCXI Chassis Using

Easy Digital VIs......................................................................................21-17
Figure 21-12. Outputting Digital Signals through an SCXI Chassis Using

Easy Digital VIs......................................................................................21-19

Figure 23-1. CTR Control VI Front Panel and Block Diagram...................................23-5

Figure 24-1. Pulse Created with Positive Polarity and Toggled Output ......................24-2
Figure 24-2. Pulse Duty Cycles ...................................................................................24-3
Figure 24-3. Physical Connections for Generating a Square Pulse.............................24-4
Figure 24-4. Using the Generate Delayed Pulse VI .....................................................24-4
Figure 24-5. Generating a Single Delayed Pulse Using Intermediate Vis...................24-5
Figure 24-6. Physical Connections for Generating a Continuous Pulse Train ............24-5
© National Instruments Corporation xv LabVIEW Data Acquisition Basics Manual



Contents

4-6
4-6

24-7
4-8

24-9

4-9
. 24-10

5-2
5-2
5-3
5-4

26-1
26-2

6-3

6-3

-4
6-5
26-6
6-6

7-1
7-3
7-4
7-5

27-6

8-1
8-2

9-3
9-3

4
5

Figure 24-7. Generating a Continuous Pulse Train with the Generate
Pulse Train VI ......................................................................................... 2

Figure 24-8. Generating a Continuous Pulse Train Using Intermediate VIs............... 2
Figure 24-9. Physical Connections for Generating a Finite Pulse Train .....................
Figure 24-10. Creating a Finite Pulse Train Using the Intermediate VIs ...................... 2
Figure 24-11. Uncertainty of One Timebase Period......................................................
Figure 24-12. Using the Generate Delayed Pulse and Stopping the

Counting Operation................................................................................. 2
Figure 24-13. Stopping a Generated Pulse Train..........................................................

Figure 25-1. Counting Input Signals to Determine Pulse Width................................. 2
Figure 25-2. Physical Connections for Determining Pulse Width .............................. 2
Figure 25-3. Determining Pulse Width Using the Pulse Width or Period VI.............. 2
Figure 25-4. Measuring Pulse Width Using Intermediate VIs .................................... 2

Figure 26-1. Measuring Square Wave Frequency .......................................................
Figure 26-2. Measuring a Square Wave Period...........................................................
Figure 26-3. Physical Connections for Period Measurement of Low

Frequency Signals ................................................................................... 2
Figure 26-4. Physical Connections for Period Measurement of High

Frequency Signals ................................................................................... 2
Figure 26-5. Measuring Low-Frequency Signals with the Measure Pulse

Width or Period VI.................................................................................. 26
Figure 26-6. Measuring Low-Frequency Signals Using Intermediate VIs.................. 2
Figure 26-7. Measure Frequency VI............................................................................
Figure 26-8. Measuring High-Frequency Signals Using Intermediate VIs ................. 2

Figure 27-1. Connecting Counters to Your Device to Count Events or Time ............ 2
Figure 27-2. Using the Count Events or Time VI to Count External Events .............. 2
Figure 27-3. Using the Count Events or Time VI to Measure Elapsed Time ............. 2
Figure 27-4. Using the Intermediate VIs to Count External Events............................ 2
Figure 27-5. Using the Intermediate VIs to Measure Elapsed Time ...........................

Figure 28-1. Wiring Your Counters for Frequency Division ...................................... 2
Figure 28-2. Programming a Single Divider for Frequency Division......................... 2

Figure 29-1. Error Checking Using the General Error Handler VI ............................. 2
Figure 29-2. Error Checking Using the Simple Error Handler VI .............................. 2

Tables
Table 2-1. LabVIEW DAQ Hardware Support for Windows.................................. 2-
Table 2-2. LabVIEW DAQ Hardware Support for Macintosh ................................ 2-
LabVIEW Data Acquisition Basics Manual xvi © National Instruments Corporation



Contents

-8
5-14

6

17

9-6

13-2

..18-1

0-4

27-2
Table 5-1. Measurement Precision for Various Device Ranges and
Limit Settings ..........................................................................................5

Table 5-2. Analog Input Channel Range ..................................................................
Table 5-3. Scanning Order for Each DAQ Device Input Channel 

with One or Two AMUX-64Ts...............................................................5-1
Table 5-4. Scanning Order for Each DAQ Device Input Channel with Four 

AMUX-64Ts ...........................................................................................5-

Table 9-1. External Scan Clock Input Pins...............................................................

Table 13-1. External Update Clock Input Pins...........................................................

Table 18-1. Phenomena and Transducers .................................................................

Table 20-1. SCXI-1100 Channel Arrays, Input Limits Arrays, and Gains ................2

Table 27-1. Adjacent Counters for Counter Chips .....................................................
© National Instruments Corporation xvii LabVIEW Data Acquisition Basics Manual



© National Instruments Corporation xix LabVIEW Data Acqu
About
This

Manual
W. 
ad 

 
ded 

 
u 

 
e 

is 

n 

 
 

The LabVIEW Data Acquisition Basics Manual includes the 
information you need to get started with data acquisition and LabVIE
You should have a basic knowledge of LabVIEW before you try to re
this manual. If you have never worked with LabVIEW, please read 
through the LabVIEW Tutorial Manual, the LabVIEW Quick Start Guide, 
or the LabVIEW Online Tutorial before you begin. This manual shows
you how to configure your software, teaches you basic concepts nee
to accomplish your task, and refers you to common example VIs in
LabVIEW. If you have used LabVIEW for data acquisition before, yo
can use this book as a troubleshooting guide.

This manual supplements the LabVIEW User Manual, and assumes that
you are familiar with that material. You should also be familiar with th
operation of LabVIEW, your computer, your computer's operating 
system, and your data acquisition (DAQ) board.

Organization of This Manual
The LabVIEW Data Acquisition Basics Manual is organized by 
sections, which in turn are made up of chapters. The sections in th
manual are as follows:

• Section One, Before You Get Started, contains all the information 
you should know before you start learning about data acquisitio
with LabVIEW. 

• Section Two, Catching the Wave with Analog Input, contains basic 
information on acquiring data with LabVIEW, including acquiring
a single point or multiple points, triggering your acquisition, and
using outside sources to control acquisition rates. 

• Section Three, Making Waves with Analog Output, contains basic 
information on generating data with LabVIEW, including 
generating a single point or multiple points. 

• Section Four, Getting Square with Digital I/O, describes basic 
concepts on how to use digital signals with data acquisition in 
LabVIEW, including immediate and handshaked digital I/O. 
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• Section Five, SCXI—Getting Your Signals in Great Condition, 
contains basic information on setting up and using SCXI modu
with your data acquisition application, special programming 
considerations, common SCXI applications, and calibration 
information.

• Section Six, Counting Your Way to High Precision Timing, describes 
the different ways you can use counters with your data acquisit
application, including generating a pulse or pulses; measuring 
pulse width; measuring frequency, and period, counting events; 
dividing frequencies for precision timing.

• Section Seven, Debugging Your Data Acquisition Application, 
contains a brief explanation of ways you can debug your data 
acquisition application to make sure your application is accurat
and runs smoothly. 

• Appendix A, LabVIEW Data Acquisition Common Questions, lists 
answers to questions frequently asked by LabVIEW users.

• Appendix B, Customer Communication, contains forms you can use
to request help from National Instruments or to comment on ou
products and manuals.

• The Glossary contains an alphabetical list and description of term
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.

• The Index contains an alphabetical list of key terms and topics i
this manual, including the page where you can find each one.

Conventions Used in This Manual
The following conventions are used in this manual: 

[ ] In Help window pictures of VI inputs and outputs, square brackets 
enclose parameters whose values you rarely need to set.

<> Angle brackets enclose the name of a key on the keyboard—for 
example, <Shift>.

- A hyphen between two or more key names enclosed in angle brack
denotes that you should simultaneously press the named keys—fo
example, <Shift-Delete>. Key names are lowercase.

AI device An analog input device that has AI in its name, such as the 
NEC-AI-16E-4.
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Am9513-based These MIO devices do not have an E- in their names. These devi
devices include the NB-MIO-16, NB-MIO-16X, NB-A2000, NB-TIO-10, and

NB-DMA2800 on the Macintosh; and the AT-MIO-16, AT-MIO-16F-5
AT-MIO-16X, AT-MIO-16D, AT-MIO-64F-5 in Windows.

bold Bold text denotes menus, menu items, or dialog box buttons or optio
In addition, bold text denotes VI input and output parameters. In He
window pictures of VI inputs and outputs, boldfaced parameters ar
parameters whose values you must specify.

bold italic Bold italic text denotes a note, caution, or warning.

configuration Configuration utility refers to NI-DAQ on the Macintosh, 
utility nicfg16.exe  on Windows 3.1, and nidaqcfg.exe  on 

Windows 95/NT.

driver Driver refers to the NI-DAQ data acquisition device driver. 

DIO devices DIO devices refer to all devices with the letters DIO in their name,
unless otherwise noted.

italic Italic text denotes emphasis, a cross reference, or an introduction t
key concept. 

monospace Text in this font denotes text or characters that you should enter liter
using the keyboard. Sections of code, programming and syntax 
examples, and the proper names of files also appear in this font. 

This icon to the left of bold italicized text denotes a note, which ale
you to important information.

LabVIEW Data Each VI description gives a data type picture for each input and ou
Types parameter, as illustrated in the following table.

Control Indicator Data Type

Signed 8-bit integer

Signed 16-bit integer

Signed 32-bit integer

Unsigned 8-bit integer

Unsigned 16-bit integer

Unsigned 32-bit integer
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Abbreviations, acronyms, metric prefixes, mnemonics, symbols, an
terms are listed in the Glossary.

Related Documentation
The following documents contain information you might find helpful a
you read this manual:

• LabVIEW Online Tutorial

• LabVIEW Quick Start Guide

• LabVIEW Tutorial Manual

• LabVIEW Function and VI Reference Manual

• DAQ VI Help (online)

• LabVIEW User Manual

• LabVIEW online help, available by selecting
Help»Online Reference…

• Application Note 025, Field Wiring and Noise Considerations fo
Analog Signals

• Application Note 005, Thermocouples and Temperature 
Measurements

• The user manuals for the data acquisition boards you use

Single-precision floating-point number

Double-precision floating-point number

Extended-precision floating-point number

String

Boolean

Array of signed 32-bit integers

2D Array of signed 32-bit integers

Cluster

File Refnum

Control Indicator Data Type
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Customer Communication
National Instruments wants to receive your comments on our produ
and manuals. We are interested in the applications you develop with
products, and we want to help if you have problems with them. To m
it easy for you to contact us, this manual contains comment and 
configuration forms for you to complete. These forms are in 
Appendix B, Customer Communication, at the end of this manual. 
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This section contains all the information you should know before yo
start learning about data acquisition with LabVIEW. 

Section One, Before You Get Started, contains the following chapters:

• Chapter 1, How To Use This Book, explains how this manual is 
organized.

• Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware, explains how to set up your system to use data 
acquisition with LabVIEW and your Data Acquisition hardware.

• Chapter 3, Basic LabVIEW Data Acquisition Concepts, explains key 
concepts in understanding how data acquisition works with 
LabVIEW.

• Chapter 4, Where You Should Go Next, serves as a map to this 
manual and directs you to the chapter or chapters that explain y
particular application.
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This chapter explains how this manual is organized and what 
information you can find in this manual. The following outline show
you what kind of information you can find in this manual.

Section One: Before You Get Started

How to Use This Book

Installing and Configuring Your Data Acquisition Hardware

Basic Data Acquisition Concepts

Where You Should Go Next (Your map to this manual)

Section Two: Catching the Wave With Analog Input

Things You Should Know about Analog Input

One-Stop Single-Point Acquisition

Buffering Your Way through Waveform Acquisition

Controlling Your Acquisition with Triggers

Letting an Outside Source Control Your Acquisition Rate

Using Analog I/O Control Loops

Section Three: Making Waves with Analog Output

Things You Should Know about Analog Output

One-Stop Single-Point Generation

Buffering Your Way through Waveform Generation

Letting an Outside Source Control Your Update Rate

Simultaneous Buffered Waveform Acquisition and Generati

Section Four: Getting Square with Digital I/O

Things You Should Know about Digital I/O

When You Need It Now—Immediate Digital I/O

Shaking Hands with a Digital Partner
isition Basics Manual
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Section Five: SCXI—Getting Your Signals in Great Condition

Things You Should Know about SCXI

Hardware and Software Setup for Your SCXI System

Special Programming Considerations for SCXI

Common SCXI Applications

SCXI Calibration—Increasing Signal Measurement Precisio

Section Six: Counting Your Way to High Precision Timing

Things You Should Know about Counters

Generating a Square Pulse or Pulse Train

Measuring Pulse Width

Measuring Frequency and Period

Counting Signal Highs and Lows

Dividing Frequencies

Section Seven: Debugging Your Data Acquisition Applications

Debugging Techniques

If you already have started a LabVIEW DAQ application, please ref
to Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware, to check your configuration. You also can refer to Sectio
Seven, Debugging Your Data Acquisition Application, for information on 
common errors for your application. The following flowchart shows th
steps you should follow before running your application:
LabVIEW Data Acquisition Basics Manual 1-2 © National Instruments Corporation
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1. Install and Configure Your Hardware—When you install 
LabVIEW, the program prompts you to have the data acquisitio
(DAQ) drivers installed. This manual guides you through setting 
NI-DAQ software with your DAQ device and SCXI hardware. Yo
should read any unique installation instructions for your platform
in Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware. 

2. Learn Basic Data Acquisition Concepts—Chapter 3, Basic 
LabVIEW Data Acquisition Concepts, shows you the location of 
DAQ example VIs; DAQ VI organization; VI parameter 
conventions; default and current value conventions; common V
parameter definitions; error handling; channel, port and counte
addressing; limit settings; and data organization for analog 
applications. 

3. Go to Your Specific Application Section—Chapter 4, Where You 
Should Go Next, shows you where to find information in this manua
for your application.

Install and Configure Your Hardware

Learn Basic Data Acquisition Concepts

Go to Your Specific Application Section

Review LabVIEW Example Applications

Learn How to Debug Your Application
© National Instruments Corporation 1-3 LabVIEW Data Acquisition Basics Manual
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4. Review LabVIEW Example Applications—The remaining 
chapters teach you basic concepts in analog input and output, 
digital I/O, counters, and SCXI. Each application section first lis
example VIs, then describes the basic concepts needed to 
understand these example VIs. Whenever possible, you should
have the VI open as you refer to these examples. 

5. Learn How to Debug Your Application—Chapter 29, Debugging 
Techniques, describes the different ways you can debug your 
application. This chapter helps you trouble-shoot for common 
programming errors.

Now you can begin the rewarding adventure of data acquisition wit
LabVIEW. 
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This chapter explains how to set up your system to use data acquis
with LabVIEW. The chapter contains hardware installation and 
configuration and software configuration instructions and some gene
information and techniques.

Note: (Windows) The LabVIEW installer prompts you to have the NI-DAQ driver
software installed. All National Instruments data acquisition (DAQ) 
devices also are packaged with NI-DAQ driver software. The version of 
NI-DAQ packaged with your DAQ device might be newer than the versio
installed by LabVIEW. You can determine the NI-DAQ version in 
LabVIEW by running the Get DAQ Device Information VI, located in 
Functions»Data Acquisition»Calibration and Configuration. 

After installing LabVIEW and the NI-DAQ driver, follow the steps in
Figure 2-1 to install your hardware and complete the software 
configuration. LabVIEW uses the software configuration information
to recognize your hardware and to set default DAQ parameters.

Get DAQ Device
Information VI
isition Basics Manual
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Figure 2-1.  Installing and Configuring DAQ Devices

NI-DAQ driver software provides LabVIEW with a high-level interfac
to DAQ devices and signal conditioning hardware.

Figure 2-2 shows the relationship between LabVIEW, NI-DAQ, and
DAQ hardware.

Install Plug-in Devices

Use Your Configuration Utility 
to Configure Devices

Install and Configure SCXI

Read Chapter 3, Basic Data Acquisition Concepts, 
and Chapter 4, Where You Should Go Now

Using SCXI?
YesNo

(Windows) Use the DAQ Channel Wizard 
to Configure Channels
LabVIEW Data Acquisition Basics Manual 2-2 © National Instruments Corporation



Chapter 2 Installing and Configuring Your Data Acquisition Hardware

 
ur 

XI 
 
es 
 

 

Figure 2-2.  How NI-DAQ Relates to Your System and DAQ Devices

(Macintosh) NI-DAQ for the Macintosh device drivers are bundled in a
single file that determines which drivers to load. When you restart yo
computer, this control panel driver, called NI-DAQ,  determines which 
devices are installed in the system and loads their corresponding 
drivers. NI-DAQ uses its control panel settings to determine what SC
hardware is configured and what the default device settings are for
devices in the computer. If you use DMA, NI-DAQ also communicat
with the NI-DMA/DSP for DMA services. When you install LabVIEW,
the installer places both of these files on your hard drive. 

(Windows) The NI-DAQ Driver, called NIDAQ.DLL  in Windows 3.x and 
NIDAQ32.DLL  in Windows 95/NT, is installed in your Windows system
directory.

LabVIEW VIs

NI-DAQ Drivers

Data Acquisition Devices
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LabVIEW Data Acquisition Hardware Support

National Instruments periodically upgrades LabVIEW to add suppo
for new DAQ hardware. To make sure this version of LabVIEW 
supports the hardware you use, refer to the following tables.

Table 2-1.  LabVIEW DAQ Hardware Support for Windows

Device Type Devices Supported

AT Series 
Devices

AT-AO-6/10, AT-DIO-32F, AT-DIO-32HS, AT-MIO-16/16D, 
AT-MIO-16DE-10, AT-MIO-16E-1, AT-MIO-16E-2, AT-MIO-16E-10, 
AT-MIO-16F-5, AT-MIO-16X, AT-MIO-16XE-50, AT-MIO-64E-3, 
AT-MIO-64F-5, AT-AI-16XE-10, AT-MIO-16XE-10, AT-5102, AT-5411

PC Series 
Devices

Lab-PC+, PC-AO-2DC, PC-DIO-24, PC-DIO-96, PC-LPM-16, 
PC-OPDIO-16, PC-TIO-10, PC-DIO-96PnP, PC-DIO-24PnP, 
PC-LPM-16PnP, PC-516, Lab-PC-1200, Lab-PC-1200AI

PCI Series 
Devices

PCI-MIO-16E-1, PCI-MIO-16E-4, PCI-MIO-16XE-50, PCI-MIO-16E-70, 
PCI-1200, PCI-DIO-96, PCI-1200, PCI-5102, PCI-5411, PCI-DIO-32HS

NEC Devices NEC-AI-16E-4, NEC-AI-16XE-50, NEC-MIO-16E-4, NEC-MIO-16XE-50

External Devices AMUX-64T, SC-2040, SC-2042-RTD, SC-2043-SG, DAQPad-12001, 
DAQPad-MIO-16XE-501

PCMCIA Devices DAQCard-500, DAQCard-700, DAQCard-1200, DAQCard-AO-2DC, 
DAQCard- DIO-24, DAQCard-AI-16E-4, DAQCard-AI-16XE-50, 
DAQCard-516, DAQCard-4050, DAQCard-5102

SCXI Chassis and 
Modules

SCXI-1000, SCXI-1000DC, SCXI-1001, SCXI-1100, SCXI-1102, 
SCXI-1120, SCXI-1120D, SCXI-1121, SCXI-1122, SCXI-1124, SCXI-1140
SCXI-1141, SCXI-1160, SCXI-1161, SCXI-1162, SCXI-1162HV, 
SCXI-1163, SCXI-1163R, SCXI-12001, SCXI-2000, SCXI-2400

VXI Modules VXI-MIO-64E-1, VXI-MIO-64XE-50, VXI-DIO-128, VXI-AO-48XDC

1The DAQPad-MIO-16XE-50 and DAQPad-1200 do not work with NEC PC-9800 Series computers. The SCXI-1200
work with NEC PC-9800 Series computers ONLY when used with Remote SCXI.
LabVIEW Data Acquisition Basics Manual 2-4 © National Instruments Corporation
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If you have any other questions regarding hardware support for 
LabVIEW, refer to Appendix A, Hardware Capabilities, in the LabVIEW 
Function and VI Reference Manual, or the LabVIEW online help, by 
selecting Help»Online Reference....

Installing and Configuring 
Your National Instruments Device

Some DAQ devices have jumpers to set analog input polarity, inpu
mode, analog output reference, and so on. Before you install your 
device, check your hardware user manuals to see if your device ha
jumpers and how to change its settings. You then can determine whe
you need to change any jumper settings. Record any jumper settin
that you change so that you can enter the information correctly in t
configuration utility.

After you check and record your jumper settings, turn off your 
computer and insert your National Instruments devices.

The next step depends on what type of computer you have. Go to t
appropriate section below to continue the configuration of your devic

Table 2-2.  LabVIEW DAQ Hardware Support for Macintosh

Device Type Devices Supported

Plug-In Devices DAQCard-500, DAQCard-700, DAQCard-1200, 
DAQCard-DIO-24, DAQCard-AO-2DC, Lab-LC, Lab-NB, 
NB-DIO-24, NB-DIO-32F, NB-DIO-96, NB-DMA-8-G, 
NB-DMA2800, NB-MIO-16, NB-MIO-16X, NB-TIO-10, 
DAQCard-AI-16E-4, NB-AO-6, NB-A2150, NB-A2100, 
NB-A2000, PCI-1200, PCI-DIO-96, PCI-MIO-16XE-50, 
DAQCard-AI-16XE-50

External Devices AMUX-64T, SC-2040, SC-2042-RTD, SC-2043-SG

SCXI Modules SCXI-1000, SCXI-1001, SCXI-1100, SCXI-1102, 
SCXI-1120, SCXI-1121, SCXI-1122, SCXI-1124, 
SCXI-1140, SCXI-1141, SCXI-1160, SCXI-1161, 
SCXI-1162, SCXI-1162HV, SCXI-1163, SCXI-1163R
© National Instruments Corporation 2-5 LabVIEW Data Acquisition Basics Manual
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Installing and Configuring Your DAQ Device in Windows
You can refer to the NI-DAQ Configuration Utility online help file, 
nidaqcfg.hlp , for specific instructions on how to install and configur
your DAQ device. If you are using Windows 3.x or Windows NT 3.5.1, 
you can find the help file in the Program Group LabVIEW . If you are 
using Windows 95 or Windows NT 4.0, you can find the help file in 
Start»Programs»LabVIEW»NI-DAQ Configuration Utility Help .

Configuring Your DAQ Device Using NI-DAQ on the Macintosh
Turn your computer back on. You can find NI-DAQ  in your control 

panels  folder. The NI-DAQ icon looks like the one shown to the lef
Double-click on this icon to launch NI-DAQ.

When you launch the program, NI-DAQ displays a list of all of the 
devices in your computer. Each device has a small list of attributes
shown in Figure 2-3. The number specified in the device line is the
logical device number that NI-DAQ assigned to the device. You wil
use this number in LabVIEW as the device number to select that dev
for any operation. 

Figure 2-3.  NI-DAQ Device Window Listing
LabVIEW Data Acquisition Basics Manual 2-6 © National Instruments Corporation
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Now show the Device Configuration window by selecting the Device 
Configuration  option from the menu as shown in Figure 2-4.

Figure 2-4.  Accessing the Device Configuration Window in NI-DAQ

Figure 2-5 shows the NI-DAQ Device Configuration window. When
you are in the Device Configuration window of the utility, you can ed
the default settings for parameters such as analog input polarity 
(bipolar—negative and positive voltages, and unipolar—only positiv
voltages) and range on a per-device basis. If you are using AMUX-6
or signal conditioning devices with your DAQ device, select the 
appropriate device using the Accessories menu. LabVIEW uses these 
settings when initializing the device instead of the default settings lis
in the descriptions of the hardware configuration VIs. (You can use
these VIs to change any setting recorded by NI-DAQ.) When you cl
on the name of the device, NI-DAQ displays the I/O connector for t
device, as shown in Figure 2-5.
© National Instruments Corporation 2-7 LabVIEW Data Acquisition Basics Manual
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Figure 2-5.  Device Configuration and I/O Connector Windows in NI-DAQ

You also can find helpful information by clicking on the Help button. 
If at any time during configuration you need to view a list of the 
LabVIEW DAQ error codes and their meanings, you can do so by 
clicking on the NI-DAQ menu bar, located to the right of the Help 
button, and choosing Errors .

Note: Some DAQ devices, such as the Lab-NB and NB-MIO-16 devices, requi
hardware jumper changes in addition to software configuration. Consult
your DAQ device hardware reference manual for more information.

Installing and Configuring Your SCXI Chassis

Hardware Configuration
Your SCXI hardware kit includes the Getting Started with SCXI manual, 
which contains detailed instructions for assembling your SCXI syste
module jumper settings, cable assemblies, and terminal blocks. Th
following are the basic steps you must complete to assemble your 
SCXI system.

1. Check the jumpers on your modules. Generally, you will leave t
jumpers in their default positions. However, the Getting Started with 
SCXI manual contains a section for each module type that lists ca
where you might want to change the jumper settings.
LabVIEW Data Acquisition Basics Manual 2-8 © National Instruments Corporation
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2. Turn off the chassis power. Plug in your modules through the fro
of the chassis. You can put the modules in any slot. For simplici
start with slot 1 on the left side of the chassis and move right w
each additional module. Be sure to tightly screw the modules in
the chassis frame.

3. If you are using an SCXI-1180 feedthrough panel, you must ins
the SCXI-1180 in the slot immediately to the right of the module
that you will cable to the DAQ device. Otherwise, the cable 
connectors might not fit together conveniently.

4. If you have more than one chassis, select a unique jumpered 
address for each additional chassis by using the jumpers direct
behind the front panel of the chassis.

5. Plug the appropriate terminal blocks into the front of each modu
and screw them tightly into the chassis frame.

6. If you are using a DAQ device in your computer to control your
SCXI chassis, connect the mounting bracket of the SCXI-134x 
(where x is a number) cable assembly to the back of one of the 
modules and screw it into the chassis frame. Connect the other 
of the cable to the DAQ device in your computer. In multiplexed
mode, you only need to cable one module to the DAQ device. I
most cases, it does not matter which module you cable. The 
following are two special cases where you should cable a spec
module to the device:

a. If you use SCXI-1140 modules along with other types of 
modules, you need to cable one of the SCXI-1140 modules
the DAQ device. 

b. If you use analog input modules and other types of module
you need to cable one of the analog input modules to the DA
device. 

7. Refer to the Getting Started with SCXI manual for more information 
on related topics, such as multichassis cabling.

8. Turn on your chassis power.
© National Instruments Corporation 2-9 LabVIEW Data Acquisition Basics Manual



Chapter 2 Installing and Configuring Your Data Acquisition Hardware

ch 
(Macintosh) Software Configuration
To use SCXI with LabVIEW, you must enter the configuration for ea
SCXI chassis using NI-DAQ. Select SCXI Configuration in the 
NI-DAQ menu bar to bring up the SCXI Configuration window as 
shown in Figure 2-6.

Figure 2-6.  Accessing the NI-DAQ SCXI Configuration Window

Figure 2-7 shows NI-DAQ with the SCXI Configuration window 
selected.

Figure 2-7.  SCXI Configuration Window in NI-DAQ
LabVIEW Data Acquisition Basics Manual 2-10 © National Instruments Corporation
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1. Leave the Chassis set to 1 if you have only one chassis. You will 
use this number to access the SCXI chassis from your applicati
If you have multiple chassis, advance the Chassis to configure the 
next chassis after you finish configuring the first chassis. 

2. Select the appropriate chassis type for your chassis. This activ
the remaining fields on the panel.

3. If you only have one chassis, leave the Address field and the 
address jumpers on your SCXI chassis set to 0. If you have 
additional chassis, you must select a unique hardware-jumpere
address for each chassis and enter it in the Address field.

4. Leave the Method set to Serial , which means that LabVIEW 
communicates with the chassis serially using a DIO port of the 
plug-in DAQ device. The Path automatically sets itself to the 
device number of the appropriate DAQ device when you enter 
Cabled Device information in step 5b.

5. Enter the configuration for each slot in the chassis. The fields in 
bottom two sections of the window reflect the settings for the 
selected Module number. Refer to your SCXI chassis hardware 
manual to determine how the slots in a chassis are numbered. 
must set the following fields for each SCXI module you install:

a. Module type—Select the correct module type for the module
installed in the current slot. If the current slot does not have
module, leave this field set to None and advance the Module 
number to the next slot. 

b. Cabled Device—If the module in the current slot is directly 
cabled to a DAQ device in your computer, set this field to th
device number of that DAQ device. Leave the Cabled Device 
field set to None if the module in the current slot is not directly
cabled to a DAQ device. If you are operating your modules 
multiplexed mode, you only need to cable one module in ea
chassis to your DAQ device. If you are not using multiplexe
mode, refer to the SCXI Operating Modes section of Chapter 19, 
Hardware and Software Setup for Your SCXI System, for 
instructions about module cabling.

c. Operating Mode—The system defaults to the multiplexed 
operating mode, which is recommended for almost all SCX
applications. The operating modes available for each SCXI
module type are described in the SCXI Operating Modes section 
of Chapter 19, Hardware and Software Setup for Your SCXI 
System. 
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If the module is an analog input module, enter the gain and
filter settings for each channel in the bottom section of the 
window. The system disables the Channel control for any 
modules that use only one gain and filter setting for the ent
module.

Configuring Your Channels in Windows

Once you install and configure your hardware, you can configure yo
channels. LabVIEW DAQ software includes a configuration wizard f
configuring your analog input channels. This wizard, the DAQ Chann
Wizard, is a Windows application you can use to configure the ana
input channels on your DAQ device—DAQ plug-in boards, stand-alo
DAQ products, or SCXI modules. The DAQ Channel Wizard helps y
define the physical quantities you are measuring on each DAQ 
Hardware channel by querying for information about the physical 
quantity being measured, the sensor being used, and the associate
DAQ hardware. As you configure channels in the DAQ Channel 
Wizard, you give each channel configuration a unique name which 
used when addressing your channels in LabVIEW. The channel 
configurations you define are saved in a file that instructs the NI-DA
Driver how to scale and process each DAQ channel by its name. Y
can simplify the programming required to measure your signal by us
the DAQ Channel Wizard to configure your channels.

Refer to the DAQ Channel Wizard online help file, ChanWiz.hlp , for 
specific instructions on how to use the DAQ Channel Wizard. If you a
using Windows 3.x, you can find the help file in the Program Group 
LabVIEW . If you are using Windows 95 or NT 4.0, you can find the
help file in Start»Programs»LabVIEW»DAQ Channel Wizard Help.

Refer to the (Windows) Channel Name Addressing section of Chapter 3, 
Basic LabVIEW Data Acquisition Concepts, for information on how to 
use your named channels in LabVIEW.

Now that you have successfully installed and configured your DAQ
hardware for LabVIEW, read Chapter 3, Basic LabVIEW Data 
Acquisition Concepts, for more information on data acquisition with 
LabVIEW.
LabVIEW Data Acquisition Basics Manual 2-12 © National Instruments Corporation



© National Instruments Corporation 3-1 LabVIEW Data Acqu
Chapter

3
Basic LabVIEW Data 
Acquisition Concepts
a 
g 

 

ata 

 

This chapter explains key concepts in understanding how data 
acquisition works with LabVIEW. Before you start building your dat
acquisition (DAQ) application, you should know some of the followin
basic LabVIEW DAQ concepts:

• Location of Common DAQ Examples

• Locating the Data Acquisition VIs in LabVIEW

• DAQ VI Organization

• VI Parameter Conventions

• Common DAQ VI Parameters

• Default and Current Value Conventions

• Error Handling

• Channel Name Addressing

• Channel, Port, and Counter Addressing

• Limit Settings

• Data Organization for Analog Applications

If you do not already understand basic programming concepts in 
LabVIEW, refer to your LabVIEW Tutorial Manual and LabVIEW User 
Manual for help with programming in LabVIEW.

Location of Common DAQ Examples

(Windows)  The easiest way to locate the DAQ examples is to run the
DAQ Solution Wizard. You can access the DAQ Solution Wizard by 
clicking on the DAQ Solution Wizard button when you first launch 
LabVIEW.

The DAQ examples address many common applications involving d
acquisition in LabVIEW. You can find these examples in 
labview\examples\daq . The following list briefly describes the VI 
libraries (designated by the .llb  file extension) and directories located
in the daq  directory.
isition Basics Manual
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anlogin Folder containing the anlogin.llb  
VIs that perform analog input and the 
strmdsk.llb  VIs that can write or 
stream the acquired data to disk.

anlogout Folder containing the anlogout.llb  
VIs that generate single values or 
multiple values (waveforms) to output 
through analog channels.

anlog_io Folder containing the anlog_io.llb  
VIs for analog I/O control loops and 
simultaneous analog input and output.

counter Folder containing the counter.llb  
VIs that count the rising and falling 
edges of TTL signals, generate TTL 
pulses, and measure the frequency an
period of TTL signals.

digital Folder containing the digio.llb  VIs 
that perform immediate digital I/O and
digital handshaking.

scxi Folder containing the scxi_ai.llb , 
scxi_ao.llb , and scxi_dig.llb  
VIs, for use with SCXI modules.

solution Folder containing the benchtop.llb , 
control.llb , datalog.llb , and 
transduc.llb  VIs, a variety of 
ready-to-run application VIs.

run_me.llb Library containing the VIs that perform 
basic operations concerning analog I/O
digital I/O, and counters.

Each chapter in this manual teaches the basic concepts behind sev
of the DAQ examples. For a brief description of any example, open 
example VI and choose Windows»Show VI Info for a text description 
of the example. You also can choose Help»Show Help to open the Help 
window. When the Help window is open, you can put your cursor ov
any front panel or block diagram item and see a description of that it
in the window. 
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Locating the Data Acquisition VIs in LabVIEW

You can find the Data Acquisition VIs in the Functions palette from 
your block diagram in LabVIEW. When you put your cursor over ea
of the icons in the Functions palette, LabVIEW displays the palette 
name you are about to access at the top of the Functions palette. You 
can find the Data Acquisition icon near the bottom of the Functions 
palette, as shown in Figure 3-1.

Figure 3-1.  Accessing the Data Acquisition Palette

The Data Acquisition palette contains six subpalette icons that take y
to the different classes of DAQ VIs. Figure 3-2 shows what each of 
icons in the Data Acquisition palette mean. 

Figure 3-2.  Data Acquisition VIs Palette

Display of Palette Name

Data Acquisition Icon

Counter VIs

Digital I/O VIsAnalog Output VIs

Analog Input VIs

Calibration and
Configuration VIs

Signal Conditioning VIs
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DAQ VI Organization

In most of the DAQ VI subpalettes, the VIs are arranged in differen
levels according to their functionality. You can find some of the 
following four levels of DAQ VIs within the DAQ VI subpalettes.

• Easy VIs

• Intermediate VIs

• Utility VIs

• Advanced VIs

A good example of a palette that contains all of the available levels
DAQ VIs is the Analog Input palette. Figure 3-3 shows this palette.

Figure 3-3.  Analog Input VI Palette Organization

Easy VIs
The Easy VIs perform simple DAQ operations and are typically the fi
row of VIs in the DAQ palettes. You can run these VIs from the fron
panel or use them as subVIs in basic applications.

These VIs are stand-alone in that you only need one Easy VI to perf
each basic DAQ operation. Unlike intermediate- and advanced-leve
VIs, Easy VIs automatically alert you to errors with a dialog box tha
asks you to stop the execution of the VI or to ignore the error. 

The Easy VIs actually are composed of Intermediate VIs, which are
turn composed of Advanced VIs. The Easy VIs provide a basic, 
convenient interface with only the most commonly used inputs and
outputs. For more complex applications, you should use the 
intermediate- or advanced-level VIs for more functionality and bette
performance.

Easy Analog Input VIs

Intermediate
Analog Input VIs
Advanced
Analog Input VIs

Analog Input Utility VIs
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Refer to your particular type of VI in the LabVIEW Function and VI 
Reference Manual for specific VI information, or refer to the LabVIEW 
online help, by selecting Help»Online Reference....

Intermediate VIs
The Intermediate VIs have more hardware functionality and efficien
in developing your application than the Easy VIs. Actually, the 
Intermediate VIs contain groups of Advanced VIs, but they use few
parameters and do not have some of the more advanced capabilitie

Intermediate VIs give you more control over error-handling than the
Easy VIs. With each VI, you can check for errors or pass the error 
cluster on to other VIs.

Note: Most LabVIEW data acquisition examples shown in this manual are base
on the Intermediate VIs. You can find these example VIs in the examples  
folder.

Utility VIs
The Utility VIs, found in many of the LabVIEW DAQ palettes, are als
intermediate-level VIs and thus have more hardware functionality a
efficiency in developing your application than the Easy VIs. Read th
previous Intermediate VIs section for more information on how thes
operate.

Advanced VIs
The Advanced VIs are the lowest-level interface to the DAQ driver.
Very few applications require the use of the Advanced VIs. Use the
Advanced VIs when the Easy or Intermediate VIs do not have the inp
necessary to control an unusual DAQ function. Advanced VIs return 
greatest amount of status information from the DAQ driver. This 
manual primarily focuses on applications using the Easy or 
Intermediate VIs. 

VI Parameter Conventions

In each LabVIEW DAQ VI front panel or Help window, the appearanc
of the control and indicator labels denote the importance of that 
parameter. Control and indicator names in bold typically must be wir
to a node on the block diagram for your application to run. Controls a
indicators not necessary for your program to operate appear in plai
© National Instruments Corporation 3-5 LabVIEW Data Acquisition Basics Manual
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text. You rarely need to use the parameters with labels in square 
brackets ([ ]). Keep in mind that these conventions apply only to the
information in the Help window and on the front panel. Both this 
manual and the LabVIEW Function and VI Reference Manual list all 
parameter names in bold to distinguish them from other elements of
text. The default inputs appear in parentheses to the right of the 
parameter names.

Figure 3-4 illustrates these Help window parameter conventions for 
AI Read One Scan VI. As the window text for this VI indicates, you
should wire the device, channels, error in , and iteration  input 
parameters and the voltage data and error out  output parameters. In 
order to pass error information from one VI to another, connect the
error out  cluster of the current VI to the error in  cluster of the next VI. 
The coupling & input config, input limits , and output units input 
parameters and the binary data output parameter are optional 
parameters. You rarely need to use the number of AMUX boards 
parameter.

Figure 3-4.  LabVIEW Help Window Conventions

Default and Current Value Conventions

To use the DAQ VIs, you should know the difference between a defa
input, a default setting, and a current setting. A default input is the 
default value of a front panel control. When you do not wire an input
a terminal of a VI, the default input for the control associated with th
terminal passes to the driver. In the Help window, default inputs app
in parentheses to the right of the parameter names. A default setting is 
a default parameter value recorded in the driver. The current setting is 
the value of a control at any given moment. The default setting of a
control becomes the current setting and remains so until you change
value of the control. 
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In many cases, a control input defaults to a certain value (most often
which means you can use the current setting. For example, the def
input for a parameter may be do not change the current setting , 
and the current setting may be no AMUX-64T boards . If you change 
the value of such a parameter, the new value becomes the current 
setting.

Common DAQ VI Parameters

The device input on analog I/O, digital I/O, and counter VIs specifies
the number assigned to your DAQ device in the DAQ configuration
software. Your software assigns a unique number to each DAQ dev
The device parameter usually appears as an input to the configurati
VIs. Another common configuration VI output, task ID, assigns your 
specific I/O operation and device a unique number that identifies it 
throughout your program flow. The task ID can also contain group 
information about the channels and gain used in your operation.

Some DAQ VIs perform either the device configuration or the I/O 
operation, while other DAQ VIs perform both configuration and the 
operation. The VIs that handle both functions have an iteration  input. 
When your VI has the iteration  set to 0, LabVIEW configures the DAQ 
device and then performs the specific I/O operation. For iteration val
greater than 0, LabVIEW uses the existing configuration to perform 
I/O operation. You can improve the performance of your application 
not configuring the DAQ device every time an I/O operation occurs
Typically, you should wire the iteration  input to an iteration terminal in 
a loop as shown in the following illustration.
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Wiring the iteration input this way means the device is only configure
on the first I/O operation. Subsequent I/O operations use the existi
configuration.

Error Handling

Each Easy VI contains an error handling VI. A dialog box appears 
immediately if an error occurs in an Easy VI.

Every Intermediate and Advanced VI contains an error in  input cluster 
and an error out  output cluster as shown in Figure 3-5. The clusters
contain a Boolean that indicates whether an error occurred, the code for 
the error, and source or the name of the VI that returned the error. If 
error in  indicates an error, the VI passes the error information to error 
out and does not execute any DAQ functions.

Figure 3-5.  LabVIEW Error In Input and Error Out Output Error Clusters

For more information on error handling, refer to Part 7, Debugging Your 
Data Acquisition Application, in this manual.

(Windows) Channel Name Addressing

If you use the DAQ Channel Wizard to configure your analog input 
channels, you can address your channels by name in LabVIEW. Th
Analog Input VIs have a channels parameter where you can specify th
channel names from which the VIs read. The channels parameter can be 
an array of strings or, as with the Easy VIs, a scalar string control, 
shown in Figure 3-6. If you have a channels array, you can use one 
channel entry per array element, specify the entire list in a single 
element, or use any combination of these two. If you enter multiple
channel names in the channels parameter, all of the channels in the lis
must be measured by the same DAQ Device. If you have configure
channels with names of temperature  and pressure , both of which are 
measured by the same DAQ Device, you can specify a list of chann
LabVIEW Data Acquisition Basics Manual 3-8 © National Instruments Corporation
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in a single element by separating them by commas—for example 
temperature,pressure . In specifying channel names, spelling and
spaces are important, but case is not.

Figure 3-6.  Channel String Controls

Using channel names, you do not need to wire the device, input limits , 
or input config input parameters. LabVIEW configures your hardwar
to make the measurement in terms of your channel configuration. 
Unless you need to overwrite your channel name configuration, do 
wire these inputs; allow LabVIEW to set it up for you. In addition, 
LabVIEW orders and pads the channels in your channel control for y
as needed.

Channel, Port, and Counter Addressing

The Analog Input and Analog Output VIs have a channel list parameter 
where you can specify the channels from which the VIs read or to wh
they write. The Digital Input and Output VIs have a similar paramete
called port list  and the equivalent value is called counter list for the 
Counter VI’s. For ease of understanding of channel addressing 
concepts, the channel list, port list , and counter list parameters are 
referred to as channel list in this section. Any special exceptions for 
these parameters will be noted.

Each channel you specify in the channel list becomes a member of a 
group. For each group, you can acquire or generate data on the cha
listed in the group. VIs scan (during acquisition) or update (during 
generation) the channels in the same order they are listed. To eras
group, pass an empty channel list and the group number to the VI or 
assign a new channel list to the group. Changing groups can only be 
done at the Advanced VI level. Refer to the LabVIEW Function and VI 
© National Instruments Corporation 3-9 LabVIEW Data Acquisition Basics Manual
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Reference Manual or the LabVIEW online help, by selecting 
Help»Online Reference..., for more information.

The channel list can be an array of strings or, as with the Easy VIs, 
scalar string control. If you have a channel list array, you can use one 
channel entry per array element, specify the entire list in a single 
element, or use any combination of these two methods. For instanc
0, 1, and 2 are your channels, you can specify a list of channels in a
single element by separating the individual channels by commas—
example, 0, 1, 2 . Or, because 0 refers to the first channel in a 
consecutive channel range and 2 refers to the last channel, you can 
specify the range by separating the first and last channels with a colo
for example, 0:2 .

Note: Keep in mind that some Macintosh devices, such as NB-MIO-16, requir
1, 2, 4, or 8 channels in the channel list.

Some Easy and Advanced Digital VIs and Intermediate Counter VI
only need one port or counter to be specified. Refer to the LabVIEW 
Function and VI Reference Manual for more information or choose 
Help»Show Help and put your cursor on the VI to view the VI Help 
window for the VI you intend to use.

LabVIEW recognizes three types of analog channels on a DAQ dev
onboard, AMUX-64T, and SCXI channels. It recognizes two types o
digital ports and counters: onboard and SCXI. This section describ
addressing onboard channels, ports, and counters. AMUX-64T 
addressing is described later in Chapter 5, Things You Should Know 
about Analog Input. SCXI channel, port, and counter addressing is 
described in Chapter 18, Things You Should Know about SCXI. 

Onboard channels refer to analog or digital I/O channels provided b
the plug-in DAQ device. If x  is an onboard channel, you can specify th
by entering x  or OBx as the channel list element. Refer to the description
of your device in your hardware user manual for restrictions on chan
order. Figure 3-7 shows several ways you can address onboard cha
0, 1, and 2. The top three examples apply to VIs whose channel 
parameters are string arrays. The bottom two examples apply to VI
whose channel parameters are scalar strings.
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Figure 3-7.  Channel String Array Controls

Note: Refer to Appendix A, Hardware Capabilities, in the LabVIEW Function and 
VI Reference Manual for the number of channels your device can acquire 
data from at one time, or refer to the LabVIEW online help, by selecting
Help»Online Reference....

Limit Settings 

Limit settings are the maximum and minimum values of the analog 
signal(s) you are measuring or generating. The pair of limit setting 
values can be unique for each analog input or output channel. For 
analog input applications, the limit setting values must be within the
voltage range for the device. For more information on the voltage ran
for your device, refer to Chapter 5, Things You Should Know about 
Analog Input.

Each pair of limit setting values forms a cluster. (Analog output limi
have a third member, the reference source; but, for simplicity, 
LabVIEW refers to limit settings as a pair of values.) LabVIEW uses 
array of these clusters to assign limits to the channels in your channel 
string array.

If you use the DAQ Channel Wizard to configure your analog input 
channels, the unit applied to the limit settings is the physical unit yo
specified for a particular channel name in the DAQ Channel Wizard
For example, if you configured a channel in the DAQ Channel Wiza
to have physical units of Deg C , the limit settings are treated as limits
in degrees Celsius. LabVIEW configures your hardware to make th
© National Instruments Corporation 3-11 LabVIEW Data Acquisition Basics Manual
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measurement in terms of your channel name configuration. Unless 
need to overwrite your channel name configuration, do not wire this
input; allow LabVIEW to set it up for you.

If you are not using the DAQ Channel Wizard, the default unit appli
to the limit settings is volts.

The default range of the device, set in the configuration utility or by
LabVIEW according to the channel name configuration in the DAQ 
Channel Wizard, is used whenever you leave the limit settings term
unwired or you enter 0 for your upper and lower limits.

As the previous Channel, Port, and Counter Addressing section explains, 
LabVIEW uses an array of strings to specify which channels belong
a group. Also, remember LabVIEW lists as few as one channel to a
many as all of the device’s channels in a single array element in th
channel string array. LabVIEW also assigns all the channels listed in
channel string array element the same settings in the corresponding
limit settings cluster array element. Figure 3-8 illustrates one case o
this.

Figure 3-8.  Limit Settings, Case 1

In this example, channels 0:3  (or 0, 1, 2, and 3) are assigned limits o
10.00  to –10.00 . Channel 4 has limits of 5.00  to –5.00 . Channels 5, 
6, and 7 have limit settings of 1.00 to 0.00 . 

If the limit settings cluster array has fewer elements than the channel 
string array, LabVIEW assigns any remaining channels the limit 
settings contained in the last entry of the limit settings cluster array. 
Figure 3-9 illustrates this case.
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Figure 3-9.  Limit Settings, Case 2

In this example, channels 0, 1, 2, and 3 have limits of 10.00  to –10.00 . 
There are more channels left, but the limit settings cluster array is 
exhausted. Therefore, the remaining channels (4, 5, 6, and 7) are a
assigned limits of 10.00  to –10.00 . 

The Easy Analog Input VIs have only one pair of input limits. This pa
forms a single cluster element. If you are not using channel names, all 
channels scanned with these VIs have identical limit settings. The E
Analog Output VIs do not have limit settings. All the Intermediate VI
both analog input and output, have the channel string array and the limit 
settings (or input limits ) cluster array on the same VI. Assignment of
limits to channels works exactly as described above. Refer to the 
LabVIEW Function and VI Reference Manual for more information on 
how to assign limit settings to a particular analog channel using the
Advanced VIs, the Group Config VI and the Hardware Config VI, or
refer to the LabVIEW online help, by selecting Help»Online 
Reference....

In analog applications, you not only specify the voltage range of the
signal, you must also specify the voltage range and the polarity of t
device. A unipolar voltage range is a range containing either positive
negative voltages, but never both. A bipolar voltage range is a rang
that has both positive and negative voltages. When a device uses 
jumpers or dip switches to select its voltage range and polarity, you
must enter the correct jumper setting in the configuration utility. In 
DAQ hardware manuals and in the configuration utility, you might fin
the word gain. Gain is the amplification or attenuation of a signal. Mos
National Instruments DAQ devices have programmable gains (no 
jumpers), but some SCXI modules require the use of jumpers or dip
switches. For all DAQ devices used with LabVIEW, the gain is 
determined by limit settings, so you never have to figure out the ga
© National Instruments Corporation 3-13 LabVIEW Data Acquisition Basics Manual
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However, for some SCXI modules, you must enter the gain in the 
configuration utility.

Data Organization for Analog Applications

If you acquire data from more than one channel multiple times, the d
is returned as a two-dimensional (2D) array. If you were to create a
array and label the index selectors on a LabVIEW front panel, the ar
might looks like Figure 3-10.

Figure 3-10.  Example of a Basic 2D Array

The two vertically-arranged boxes on the left are the row and colum
index selectors for the array. The top index selects a row and the bot
index selects a column. 

You can organize data for a 2D array in one of two ways. First, you c
organize the data by rows. If the array contained data from analog in
channels, this would mean that each row holds data from one chan
Selecting a row selects a channel. Selecting a column selects a sca
data. This ordering method is often referred to as row major order. 
When you create data in a nested For Loop, the inner loop creates a
for each iteration of the outer loop. If you were to label your index 
selectors for a row major 2D array, the array might look like 
Figure 3-11.
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Figure 3-11.  2D Array in Row Major Order

You also can organize 2D array data by columns. The Analog Input 
in LabVIEW organize their data in this way. Each column holds dat
from one channel, so selecting a column selects a channel. Selecti
row selects a scan of data. This ordering method is often called column 
major order. If you were to label your index selectors for a column 
major 2D array, the array might look like Figure 3-12.

Figure 3-12.  2D Array in Column Major Order

To graph a column major order 2D array, you must configure the 
waveform chart or graph to treat the data as transposed by turning
this option in the graph pop-up menu. 

Note: This option appears in gray until you wire the 2D array to a graph. If you
need to convert the data to row major order, select Functions»Array & 
Cluster»Transpose 2D Array.

If you want to extract a single channel from a column major 2D arra
use the Index Array function from Functions»Array & Cluster . Add a 
dimension so that you have two black rectangles in the lower left 
corner. The top rectangle selects the row and the bottom rectangle
selects the column. Popup on the row rectangle and select Disable 
Indexing. Now, when you select a column (or channel) by wiring you
© National Instruments Corporation 3-15 LabVIEW Data Acquisition Basics Manual
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selection to the bottom rectangle, the Index Array function produces
entire column of data as a 1D array, as shown in Figure 3-13.

Figure 3-13.  Extracting a Single Channel from a Column Major 2D Array

Analog output buffers that contain data for more than one channel 
also column major 2D arrays. To create such an array, first make th
data from each output channel a 1D array. Then select the Build Ar
function from Functions»Array & Cluster . Add as many input 
terminals (rows) to the Build Array terminal as you have channels o
data. Wire each 1D array to the Build Array terminal to combine the
arrays into a single row major 2D array. Then use the Transpose 2
Array function to convert the array to a column major array. The 
finished array is ready for the AO Write VI, as shown in Figure 3-14

Figure 3-14.  Analog Output Buffer 2D Array

Now that you have read some basic LabVIEW DAQ concepts, you c
go to the section(s) that describe your specific application. In the 
following chapter, Chapter 4, Where You Should Go Next, you can 
answer questions about your application to narrow down where you
should go next for help in this manual. 
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This chapter directs you to the chapter in the manual best suited to
answer questions about your data acquisition application. You answ
series of questions that help determine the purpose of your applicat
The questions start very broad and narrow in scope until you are 
referred to a specific section in the manual dealing with your type o
application. 

Note: You always should read the Things You Should Know chapter at the 
beginning of each section specific to your application. The Things You 
Should Know chapters teach you about basic concepts dealing with your
application.

Use the following flowchart as a guide as you answer the questions 
follow it. The questions should pinpoint the sections in the manual t
you should read for your particular application.
isition Basics Manual



Chapter 4 Where You Should Go Next
Type of
Measuring Device?

Analyzing
Analog or Digital

Signals?

Signal Acquisition
or Generation?

Digital or
Counter Interfacing?

Single-Point
or Multiple-Point

Generation?

Single-Point
or Multiple-Point

Acquisition?

Using an Internal
or External Clock?

Triggering a Signal?

Latched or
Non-Latched Digital

I/O?

Plug-in DAQ Device Only SCXI

Analog Digital

Digital Counter

Latched Non-Latched

Acquisition Generation

Single Multiple

Internal External

Single

Yes No

Read about the DAQ Channel Wizard
in Chapters 2 and 3, and Section 5,

SCXI–Getting
Your Signals in Great Condition.

Read Chapter 23, Things You 
Should Know about Counters.

Read Chapter 17, Shaking Hands
with a Digital Partner.

Read Chapter 6, One-Stop
Single-Point Acquisition.

Read Chapter 8, Controlling
 Your Acquisition with Triggers.

Read Chapter 7, BufferingYour 
Way Through Waveform Acquisition.

Read Chapter 9, Letting an Outside
Source Control Your Acquisition Rate.

Read Chapter 11, One-Stop
Single-Point Generation.

Multiple

Read Chapter 12, Buffering Your
Way through Waveform Generation.

Read Chapter 16, When You Need
It Now–Immediate Digital I/O.

Read Chapter 24, Generating a 
Square Pulse or Pulse Train.

Read Chapter 25, Measuring
Pulse Width.

Read Chapter 26, Measuring 
Frequency and Period.

Read Chapter 27, Counting Signal 
Highs and Lows.

Read Chapter 28,
Dividing Frequencies.

Both

Read Chapter 14, Simultaneous Buffered 
Waveform Acquisition and Generation.

Internal or
External?

Internal

Read Chapter 13, Letting an Outside 
Source Control Your Update Rate.

External
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Questions You Should Answer

1. Measuring Device: DAQ Device or SCXI Module?
Are you working in a noisy environment? If you are, then you may ha
Signal Conditioning eXtensions for Instrumentation (SCXI) modules
connected to your DAQ device or the parallel port of your compute
SCXI modules can filter and isolate noise from signals. They can a
amplify low voltage or current signals. SCXI modules expand the 
number of channels to acquire or generate data. 

DAQ devices are primarily used alone when extra signal conditioni
is not necessary. 

If you are using a DAQ device, then read question 2. If you are usin
SCXI, go to Section Five, SCXI—Getting Your Signals in Great 
Condition.

2. Analog or Digital Signal Analysis?
Does your signal have two discrete values that are TTL signals? If 
then you have a digital signal. Otherwise, you have an analog sign
The type of information you would need to know from an analog sign
is the level (discrete value), shape, and frequency content.

Analog or Digital Signal Acquisition or Generation?
If you want to measure and analyze signals from a source outside 
computer, you want to acquire signals. If you want to send signals to a
outside instrument to control its operation, then you want to generate 
signals.

If you want to acquire analog signals, go to question 4. If you want to
generate analog signals, refer to question 5. If you want to acquire a
generate analog signals, refer to the Using Analog Input/Output Control 
Loops section of Chapter 6, One-Stop Single-Point Acquisition.

If you want to acquire or generate digital signals, read the next question

3. Digital or Counter Interfacing?
Digital I/O interfaces primarily with binary operations, such as turnin
external equipment on or off or sense logic states, such as the on/o
position of the switch. Counters generate individual digital pulses o
waves or count digital events, like how many times a digital signal ris
or falls in value.
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If you are performing digital I/O, refer to question 7. If you need to u
counters, read question 8. 

4. Single-Point or Multiple-Point Acquisition?
Do you want to acquire a voltage value(s) at one time or over a per
of time at a certain rate? If you measure a voltage at a given instan
time, you are performing single-point acquisition. If you measure 
voltages over a period of time at a certain rate, then you are perform
multiple-point or waveform acquisition.

If you want single-point acquisition, refer to Chapter 6, One-Stop 
Single-Point Acquisition. If you answered multiple-point acquisition, 
read question 6.

5. Single-Point or Multiple-Point Generation?
Are you outputting a steady (DC) voltage or voltages are you genera
a changing signal at a certain rate? A constant or slowly-changing 
voltage output is called single-point generation. The output of a 
changing signal at a certain rate is called multiple-point or waveform 
generation.

If you want to perform single-point generation, refer to Chapter 11, 
One-Stop Single-Point Generation. If you answered multiple point 
generation, refer to Chapter 12, Buffering Your Way through Waveform 
Generation.

6. Triggering a Signal or Using a Clock?
You can start an analog acquisition when a certain analog or digita
value occurs by triggering the acquisition.

If you want to trigger an analog acquisition, refer to Chapter 8, 
Controlling Your Acquisition with Triggers.

Multiple-Point Acquisition with an Internal or External Clock?
Multiple point or waveform acquisition can be done at a rate set by
internal DAQ device clock or an external clock. The external clock w
be a TTL signal produced at a certain rate.

If you want to acquire a waveform at the rate of an external signal, re
to Chapter 9, Letting an Outside Source Control Your Acquisition Rate. If 
not, read Chapter 7, Buffering Your Way through Waveform Acquisition.
LabVIEW Data Acquisition Basics Manual 4-4 © National Instruments Corporation
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7. Non-Latched or Latched Digital I/O?
If you want your program to read the latest digital input or immediate
write a new digital output value, you should use non-latched 
(immediate) digital I/O. When a DAQ device accepts or transfers da
after a digital pulse has been received, it is called latched (handsha
digital I/O. With latched digital I/O, you can store the values you wa
to transfer in a buffer. Only one value will be transferred after each
handshaked pulse. 

If you want to use non-latched (immediate) digital I/O, refer to 
Chapter 16, When You Need It Now—Immediate Digital I/O. If you need 
to perform latched (handshaked) digital I/O, refer to Chapter 17, 
Shaking Hands with a Digital Partner. 

8. Counters: Counting or Generating Digital Pulses?
If you want to generate digital pulses from a counter at a certain ra
read Chapter 24, Generating a Square Pulse or Pulse Trains. If you want 
to measure the width of a digital pulse, refer to Chapter 25, Measuring 
Pulse Width. If you want to measure the frequency or period of a digit
signal, refer to Chapter 26, Measuring Frequency and Period. If you just 
want to count how many times a digital signal rises or falls, refer to
Chapter 27, Counting Signal Highs and Lows. To learn how to slow the 
frequency of a digital signal, refer to Chapter 28, Dividing Frequencies. 
© National Instruments Corporation 4-5 LabVIEW Data Acquisition Basics Manual
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This section contains basic information on acquiring data with 
LabVIEW, including acquiring a single point or multiple points, 
triggering your acquisition, and using outside sources to control 
acquisition rates. 

Section Two, Catching the Wave with Analog Input, contains the 
following chapters:

• Chapter 5, Things You Should Know about Analog Input, explains 
basic concepts on using analog input with LabVIEW.

• Chapter 6, One-Stop Single-Point Acquisition, shows you how to 
acquire one data point from a single channel and then one data p
from each of several channels using LabVIEW, and explains ho
software-timing and/or hardware-timing affects the performance
analog I/O.

• Chapter 7, Buffering Your Way through Waveform Acquisition, 
reviews the different methods of reading multiple channels and
explains how LabVIEW stores the acquired data with each meth

• Chapter 8, Controlling Your Acquisition with Triggers, explains how 
to set your analog acquisition to occur at a certain time using eit
software or hardware triggering methods.

• Chapter 9, Letting an Outside Source Control Your Acquisition Rat, 
shows you how to control your data acquisition rate by some oth
external source in your system.
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Hunting has been a part of survival from the beginning of time. Peo
used to hunt for the things they needed to survive, like food and wa
Today, engineers and scientists use data acquisition to “hunt down”
information they need to survive in the information age. This chapte
focuses on defining the tools you need to be a successful hunter in
world of data acquisition.

Defining Your Signal

You and your friends plan a hunting trip for this weekend. What do y
plan to bring with you? This question is really not valid, because yo
must know first what you will be hunting before you pack your fishing
pole or elephant rifle. The same idea applies to scientists and engin
engaged in the quest for information. You must know the defining 
characteristics of what you want to “hunt,” be it a wild animal or an 
analog signal. You cannot just say, “I will hunt voltages,” or even “I
will hunt analog voltages.” Voltages come in various forms. This 
chapter gives you the terms, tools, and techniques designed to hel
show you the best way to catch your wave.

You can break down analog signals into three categories: DC, time
domain, and frequency domain. You must ask yourself, “Is the 
information I seek primarily contained in the level, the shape, or the
frequency content of my signal?” Figure 5-1 illustrates which signal
correspond to certain types of signal information.

Figure 5-1.  Types of Analog Signals

Analog Signal Time Domain

Frequency Domain

DC ADC/DAC
(slow)

ADC/DAC
(fast)

ADC (fast)
Analysis

Level

Shape

Freq. Content
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You might be saying to yourself, “I know that I have a thermocoupl
and that the primary information (temperature) is contained in the le
of the analog voltage. Now I am ready to go hunting!” Well, you are
almost ready to hunt, but you first must figure out a few more signa
characteristics before you can begin. For example, to what is your 
signal referenced? How fast does the signal vary with time? The rat
which you sample determines how often the A/D conversions take 
place. A fast sampling rate acquires more points in a given time an
therefore can often form a better representation of the original sign
than a slow sampling rate. According to the Nyquist Theorem, you m
sample at greater than twice the rate of the maximum frequency 
component in that signal, if you want accurate frequency informatio
about that signal. The frequency at one half the sampling frequenc
referred to as the Nyquist frequency. You must have answers like this to
all of your questions, so you can use the proper tools to acquire the
signal.

To What Is Your Signal Referenced?
Signals come in two forms: referenced and non-referenced signal 
sources. More often, referenced sources are said to be grounded signals, 
and non-referenced sources are called floating signals.

Grounded Signal Sources
Grounded signal sources have voltage signals that are referenced 
system ground, such as earth or a building ground. Devices that pl
into a building ground through wall outlets, such as signal generato
and power supplies, are the most common examples of grounded si
sources, as shown in Figure 5-2.

Figure 5-2.  Grounded Signal Sources
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Floating Signal Sources
Floating signal sources contain a signal whose voltage signal is no
connected to an absolute reference, such as earth or a building gro
Some common examples of floating signals are batteries, 
battery-powered sources, thermocouples, transformers, isolation 
amplifiers, and any instrument that explicitly floats its output signal
Notice that in Figure 5-3 neither terminal of the floating source is 
connected to the electrical outlet ground.

Figure 5-3.  Floating Signal Sources

Now that you know how your signal is referenced, read on to learn 
about the different systems available to acquire these signals.

Choosing Your Measurement System

Now that you have defined your signal, you must choose a measurem
system. You have an analog signal, so you must convert the signal 
an ADC measurement system, which converts your signal into 
information the computer can understand. Some of the issues you m
resolve before choosing a measurement system are your ADC bit 
resolution, device voltage range, and signal voltage range. 

Resolution
The number of bits used to represent an analog signal determines 
resolution of the ADC. You can compare the resolution on a DAQ 
device to the marks on a ruler. The more marks you have, the more
precise your measurements. Similarly, the higher the resolution, th
higher the number of divisions into which your system can break do
the ADC range, and therefore, the smaller the detectable voltage 

Vs

Ground

+
_
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change. A 3-bit ADC divides the range into 23 or 8 divisions. A binary 
or digital code between 000 and 111 represents each division. The A
translates each measurement of the analog signal to one of the dig
divisions. Figure 5-4 shows a sine wave digital image as obtained b
3-bit ADC. Clearly, the digital signal does not represent the origina
signal adequately, because the converter has too few digital division
represent the varying voltages of the analog signal. By increasing t
resolution to 16 bits, however, the ADC’s number of divisions increas
from 8 to 65,536 (216). The ADC can now obtain an extremely accurat
representation of the analog signal.

Figure 5-4.  The Effects of Resolution on ADC Precision

Device Voltage Range
Range refers to the minimum and maximum analog voltage levels t
the ADC can digitize. Many DAQ devices feature selectable ranges
you can match the ADC range to that of the signal to take best advan
of the available resolution. For example, in Figure 5-5, the 3-bit AD
as shown in the left chart, has eight digital divisions in the range fro
0 to 10 volts. If you select a range of –10.00  to 10.00  volts, as shown 
in the right chart, the same ADC now separates a 20 volt range into e
divisions. The smallest detectable voltage increases from 1.25  to 2.50  
LabVIEW Data Acquisition Basics Manual 5-4 © National Instruments Corporation
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volts, and you now have a much less accurate representation of th
signal.

Figure 5-5.  The Effects of Range on ADC Precision

Signal Voltage Range (Limit Settings)
Limit settings are the maximum and minimum voltages of the signa
you are measuring. A more precise limit setting allows the ADC to u
more digital divisions to represent the signal. Figure 5-6 shows an 
example of this theory. Using a 3-bit ADC and a device range setting
0.00  to 10.00  volts, Figure 5-6 shows the effects of a limit setting 
between 0 and 5 volts and 0 and 10 volts. With a limit setting of 0 to
volts, the ADC uses only four of the eight divisions in the conversio
But using a limit setting of 0 to 5 volts, the ADC now has access to 
eight digital divisions. This makes the digital representation of the 
signal more accurate.
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Figure 5-6.  The Effects of Limit Settings on ADC Precision

Considerations for Selecting Analog Input Settings

The resolution and device range of a DAQ device determine the 
smallest detectable change in the input voltage. You can calculate 
smallest detectable change, called the code width, using the following 
formula.

Limit Settings 0 to 10V

Limit Settings 0 to 5V

10.00

8.75

7.5

6.25

5.00

3.75

2.50

1.25

0.00

111

110

101

100

011

010

001

000

V

10.00

8.75

7.5

6.25

5.00

3.75

2.50

1.25

0.00

V

000
001
010
011
100
101
110
111

Limit Settings 0 to 5V

codewidth
device range

2resolution
----------------------------------=
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For example, a 12-bit DAQ device with a 0 to 10 V input range dete
a 2.4 mV change, while the same device with a –10 to 10 V input ra
detects only a change of 4.8 mV.

A high resolution A/D converter provides a smaller code width given
device voltage ranges shown above.

The smaller your code width, the more accurate your measuremen
will be.

There are times you must know whether your signals are unipolar o
bipolar. Unipolar signals are signals that range from 0 V to a positiv
voltage (i.e., 0 to 5 V). Bipolar signals are signals that range from a
negative to a positive voltage (–5 to 5 V). To achieve a smaller cod
width if your signal is unipolar, specify that the device voltage range
unipolar, as shown previously. If your signal range is smaller than t
device voltage range, you should set your limit settings to values th
more accurately reflect your signal range. Table 5-1 shows how the
code width of the 12-bit DAQ devices vary with device ranges and lim

device range

2reso lutio n
----------------------------------

10

212------- 2.4 mV==

device range

2reso lutio n----------------------------------
20

2
12------- 4.8 mV==

device range

2resolution----------------------------------
10

2
16------- .15 mV==

device range

2resolution----------------------------------
20

2
16------- .3 mV==
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settings, because your limit settings automatically adjust the gain o
your device.

For more information on the device range and limit settings for you
device, refer to the tables in Appendix A, Hardware Capabilities, in the 
LabVIEW Function and VI Reference Manual, or to the LabVIEW online 
help, available by selecting Help»Online Reference…. In these tables, 
there is information on gain settings for each device. For more 
information on gain, refer to the Limit Settings section of Chapter 3, 
Basic LabVIEW Data Acquisition Concepts.

Table 5-1.  Measurement Precision for Various Device Ranges and Limit Settings

Device Voltage Range Limit Settings Precision1

0 to 10V 0 to 10 V
0 to 5 V
0 to 2.5 V
0 to 1.25 V
0 to 1 V
0 to 0.1 V
0mV to 20 mV

2.44mV
1.22 mV
610 µV
305 µV
244 µV
24.4 µV
4.88 µV

–5 to 5V –5 to 5V
–2.5 to 2.5 V
–1.25 to 1.25 V
–0.625 to 0.625 V
–0.5 to 0.5 V
–50mV to 50 mV
–10mV to 10 mV

2.44 mV
1.22 mV
610 µV
305 µV
244 µV
24.4 µV
4.88 µV

–10 to 10V –10 to 10 V
–5 to 5 V
–2.5 to 2.5 V
–1.25 to 1.25 V
–1 to 1 V
–0.1 to 0.1 V
–20mV to 20 mV

4.88 mV
2.44 mV
1.22 mV
610 µV
488 µV
48.8 µV
9.76 µV

1The value of 1 LSB of the 12-bit ADC. In other words, the voltage 
increment corresponding to a change of 1 count in the ADC 12-bit cou
LabVIEW Data Acquisition Basics Manual 5-8 © National Instruments Corporation
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Now that you know which kind of ADC to use and what settings to u
for your signal, you can connect your signals to be measured. On m
DAQ devices, there are three different ways to configure your device
read the signals: Differential, Referenced Single-Ended (RSE), and
Non-Referenced Single-Ended (NRSE).

Differential Measurement System
In a differential measurement system, you do not need to connect ei
input to a fixed reference, such as earth or a building ground. DAQ
devices with instrumentation amplifiers can be configured as 
differential measurement systems. Figure 5-7 depicts the 8-channe
differential measurement system used in the MIO series devices. 
Analog multiplexers increase the number of measurement channel
while still using a single instrumentation amplifier. For this device, th
pin labeled AIGND (the analog input ground) is the measurement 
system ground.
© National Instruments Corporation 5-9 LabVIEW Data Acquisition Basics Manual
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Figure 5-7.  8-Channel Differential Measurement System

In general, a differential measurement system is preferable becaus
rejects not only ground loop-induced errors, but also the noise pick
up in the environment to a certain degree. You should use different
measurement systems when all input signals meet the following 
criteria:

+

+

CH0–

CH2–

CH1–

CH7–

CH0+
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CH1+

CH7+

MUX

MUX
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AIGND

–
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• Low-Level Signals (less than 1 V)

• Long or Non-Shielded Cabling/Wiring Traveling through a Nois
Environment 

• Any of the Input Signals Require a Separate Ground-Reference
Point or Return Signal

An ideal differential measurement system reads only the potential 
difference between its two terminals—the (+) and (–) inputs. Any 
voltage present at the instrumentation amplifier inputs with respect
the amplifier ground is called a common-mode voltage. An ideal 
differential measurement system completely rejects (does not meas
common-mode voltage, as shown in Figure 5-8.

Figure 5-8.  Common-Mode Voltage

While a differential measurement system is often the best choice, a
single-ended configuration uses twice as many measurement chan
A single-ended measurement system is acceptable when the magn
of the induced errors is smaller than the required accuracy of the d

Referenced Single-Ended Measurement System
A referenced single-ended (RSE) measurement system, is used to
measure a floating signal, because it grounds the signal with respe
building ground. Figure 5-9 depicts a 16-channel RSE measuremen
system. You only should use this measurement system when you n

+

+
+
–

+

Vs

Vcm

Instrumentation Amplifier

Measured Voltage
Grounded Signal Source

Common Mode Voltage,
Ground Potential, Noise, etc. –

– –
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a single-end system and your device does not work with nonreferen
single-ended measurement.

Figure 5-9.  16-Channel RSE Measurement System

Nonreferenced Single-Ended Measurement System
DAQ devices often use a variant of the RSE measurement techniqu
known as the nonreferenced single-ended (NRSE) measurement 
system. In an NRSE measurement system, all measurements are m
with respect to a common reference, because all of the input signals
already grounded. Figure 5-10 depicts an NRSE measurement sys
where AISENSE is the common reference for taking measurements
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CH15
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AIGND is the system ground. All signals must share a common 
reference at AISENSE.

Figure 5-10.  16-Channel NRSE Measurement System

In general, a differential measurement system is preferable becaus
rejects not only ground loop-induced errors, but also the noise pick
up in the environment to a certain degree. On the other hand, the 
single-ended configuration allows for twice as many measurement 
channels and is acceptable when the magnitude of the induced erro
smaller than the required accuracy of the data. You can use 
single-ended measurement systems when all input signals meet th
following criteria.

• High Level Signals (normally, greater than 1 V)

• Short or Properly-Shielded Cabling/Wiring Traveling through a 
Noise-Free Environment (normally, less than 15 ft.)

• All Signals Can Share a Common Reference Signal at the Sour

Use differential connections when your system violates any of the 
above criteria.

Until now, you have learned about analog input in general. Now, yo
should focus on some analog input concepts that are specific to 
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LabVIEW. The following section describes these LabVIEW-specific
issues.

LabVIEW and Analog Input

Channel Addressing with the AMUX-64T
An AMUX-64T external multiplexer device expands the number of 
analog input signals a plug-in DAQ device can measure. You can 
address AMUX-64T channels when you attach one, two, or four 
AMUX-64T devices to a plug-in DAQ device. With this device, you ca
multiplex four, eight, or 16 AMUX-64T channels into one device 
channel. The scanning order of these AMUX-64T channels is fixed. 
specify a range of AMUX-64T channels, enter the device channel in
which the range is multiplexed in the channel list. For example, if you 
have no AMUX-64T devices, a channel list element of 0 specifies 
device channel 0. If you have a AMUX-64T device, a channel list 
element of 0 specifies channels 0 through 3 on each AMUX-64T 
device. Table 5-2 shows the number of channels available on a DA
device with an external multiplexer.

You specify the number of AMUX devices through the configuration
utility or the AI Hardware Config VI. Refer to the LabVIEW Function 
and VI Reference Manual or the LabVIEW online help, available by 
selecting Help»Online Reference…, for more information on this VI.

Table 5-2.  Analog Input Channel Range

Number of 
AMUX-64Ts

Channel Range 
(Single-Ended)

Channel Range 
(Differential)

0 0 through 15 0 through 7

1 AM1!0  through AM1!63 AM1!0  through AM1!31

2 AM1!0  through AM1!63 ,
AM2!0  through AM2!63

AM1!0  through AM1!31 , 
AM2!0  through AM2!31

4 AM1!0  through AM1!63 , 
AM2!0  through AM2!63 , 
AM3!0  through AM3!63 , 
AM4!0  through AM4!63

AM1!0  through AM1!31 , 
AM2!0  through AM2!31 , 
AM3!0  through AM3!31 , 
AM4!0  through AM4!31
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The AMUX-64T Scanning Order
This section explains how LabVIEW scans channels from the 
AMUX-64T. You must know this scanning order so that you can 
determine which analog input channel LabVIEW scanned during a d
acquisition operation. 

The scanning counters on the AMUX-64T and on the DAQ device 
perform automatic scanning of the AMUX-64T analog input channe
When you perform a multiple-channel scanned data acquisition with
AMUX-64T, a counter on the DAQ device switches the DAQ device
multiplexers.

When you connect a single AMUX-64T device to the DAQ device, yo
must scan four AMUX-64T input channels for every DAQ device 
channel. If you attach two AMUX-64T devices to the DAQ device, 
LabVIEW scans eight AMUX-64T channels for every DAQ device 
input channel. For example, assume that channels 0 through 3 on 
AMUX-64T device 1 and channels 0 through 3 on AMUX-64T 
device 2 are multiplexed together into DAQ device channel 0. In th
case, LabVIEW scans the first four channels on AMUX-64T device 
followed by the first four channels on AMUX-64T device 2.

If you attach four AMUX-64T devices to the DAQ device, LabVIEW
scans 16 AMUX-64T channels for every DAQ device input channel
For example, channels 0 through 3 on AMUX-64T device 1, 2, 3, an
are multiplexed together into DAQ device channel 0. In this case, 
LabVIEW scans the first four channels on device 1, followed by the
first four channels on device 2, the first four channels on device 3, a
then the first four channels on device 4.

The order in which LabVIEW scans channels depends on the chan
list you specify in the AI Group Config VI. You specify this channel lis
as an array of DAQ device channel numbers indicating the order in
which LabVIEW scans the DAQ device channels. When scanning 
multiple channels, list only the device channels—not the AMUX-64
channels. (You only use the AMy!x  syntax in your channel list when you
sample a single AMUX-64T channel.) LabVIEW then scans four, eig
or 16 channels for every device channel for one, two, or four 
AMUX-64T devices, respectively. However, the AMUX-64T has a 
fixed scanning order. Table 5-4 shows the order in which LabVIEW
scans the AMUX-64T channels for every DAQ device input channe
when you use one or two AMUX-64T devices. Table 5-4 shows the
© National Instruments Corporation 5-15 LabVIEW Data Acquisition Basics Manual
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ter 
order in which LabVIEW scans the AMUX-64T channels for every 
DAQ device input channel when you use four AMUX-64T devices.

If you want to scan more than one AMUX-64T channel, you must en
the device channels in your scan list.  

Table 5-3.  Scanning Order for Each DAQ Device Input Channel 
with One or Two AMUX-64Ts

DAQ
Device 

Channel

AMUX-64T Channels

One Device Two Devices

Device 1 Device 1 Device 2

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63
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To determine which AMUX-64T channels LabVIEW scans and the 
scanning order, perform the following steps. 

1. Locate the channel for each DAQ device channel in your chann
list in the DAQ Device Channel column in Table 5-4 or 5-4. Sta
with the first device channel and continue through the list in yo
specified channel order.

2. Read from left to right along the table row where you located th
channel number to find the AMUX-64T scanning order.

To read a single AMUX-64T channel, use channel specifier AMy!x . 
This specifier returns data from channel x  of the AMUX-64T with 
ID y . To read more than one AMUX-64T channel, use channel speci
OBx:y . This specifier returns data from the AMUX-64T channels tha
correspond to device channel x  through device channely . 

Table 5-4.  Scanning Order for Each DAQ Device Input Channel with Four AMUX-64Ts

DAQ 
Device 

Channel

AMUX-64T Channels

Device 1 Device 2 Device 3 Device 4

0
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63

0, 1, 2, 3
4, 5, 6, 7
8, 9, 10, 11
12, 13, 14, 15
16, 17, 18, 19
20, 21, 22, 23
24, 25, 26, 27
28, 29, 30, 31
32, 33, 34, 35
36, 37, 38, 39
40, 41, 42, 43
44, 45, 46, 47
48, 49, 50, 51
52, 53, 54, 55
56, 57, 58, 59
60, 61, 62, 63
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When the channel list contains a single AMUX-64T channel, you mus
also specify the number of the AMUX-64T device, as shown in the 
following table.

You refer to AMUX-64T channels only when a single AMUX-64T 
channel comprises the entire list. Otherwise, you refer to them 
indirectly through the device channels that you use to scan the 
AMUX-64T channels. Refer to Appendix A, Hardware Capabilities, of 
the LabVIEW Function and VI Reference Manual, or the LabVIEW online 
help, available by selecting Help»Online Reference…, for more 
information on addressing AMUX-64T channels.

Refer to the AMUX-64T User Manual for more information on the 
external multiplexer device.

Important Terms You Should Know

The following are some definitions of common terms and paramete
that you should remember when acquiring your data.

• A scan is one acquisition or reading from each channel in your 
channel string.

• The number of scans to acquire parameter refers to the number o
data acquisitions or readings to acquire from each channel in th
channel string. The number of samples is the number of data points
you want to sample from each channel.

• The scan rate determines how many times per second LabVIEW
acquires data from channels. The scan rate parameter enables 
interval scanning (a longer interval between scans than between
individual channels comprising a scan) on devices that support 
feature. The channel clock rate parameter defines the time betwee
the acquisition of consecutive channels in your channel string. F
more information on scan and channel clock rates, refer to 
Chapter 9, Letting an Outside Source Control Your Acquisition Rat.

channel list Parameter Channel Specified

AMy!x Channel x  on AMUX-64T device y . 

AM4!8 Channel 8 on AMUX-64T device 4. 
LabVIEW Data Acquisition Basics Manual 5-18 © National Instruments Corporation



Chapter 5 Things You Should Know about Analog Input
For specific information about the Analog Input VIs, refer to 
Chapter 13, Introduction to the LabVIEW Data Acquisition VIs, in the 
LabVIEW Function and VI Reference Manual, or to the LabVIEW online 
help, available by selecting Help»Online Reference….
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This chapter shows you how to acquire one data point from a singl
channel and then one data point from each of several channels usi
LabVIEW. 

Single-Channel, Single-Point Analog Input

A single-channel, single-point analog input is an immediate, 
non-buffered operation. In other words, the software reads one volt
from an input channel and immediately returns the value to you. Th
operation does not require any buffering or timing. You should use 
single-channel, single-point analog input when you need one data p
from one channel and when the information you seek is an analog 
voltage. A good example of when you might want to use this would 
if you periodically needed to monitor the fluid level in a tank. You ca
connect the transducer that produces a voltage representing the flu
level to a single channel on your DAQ device and initiate a 
single-channel, single-point acquisition whenever you want to know 
fluid level.

For most basic operations, use the AI Sample Channel VI, located in
Functions»DAQ»Analog Input palette. The Easy Analog Input VI, AI 
Sample Channel, measures the signal attached to the channel you
specify on your DAQ device and returns the scaled voltage. Figure
shows how you can wire this VI.

Note: (Windows) If you previously set up your channel in the DAQ Channel 
Wizard, you do not need to enter the device or input limits. Instead, enter
channel name and the value returned will be relative to the physical unit
you specified for that channel in the DAQ Channel Wizard. If input limits
are specified, they also are treated as being relative to the physical units
the channel. This principal applies throughout this manual.
isition Basics Manual
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Figure 6-1.  AI Sample Channel VI

Figure 6-2 shows how you program the Acquire 1 Point from 1 Chan
VI, located in labview\examples\daq\anlogin\anlogin.llb , 
using the AI Sample Channel VI to acquire data.

Figure 6-2.  Acquiring Data Using the Acquire 1 Point from 1 Channel VI

The Acquire 1 Point from 1 Channel VI initiates an A/D conversion o
the DAQ device and returns the scaled voltage as an output. The high 
limit  is the highest expected voltage level of the signals you want t
measure. The low limit  is the lowest expected voltage level of the 
signals you want to measure. If you want to acquire multiple point fro
a single channel, see Chapter 7, Buffering Your Way through Waveform
Acquisition.

Single-channel acquisition makes acquiring one channel very basic,
what if you need to take more than one channel sample? For instan
you might need to monitor the temperature of the fluid as well as th
fluid level of the tank. In this case, two transducers must be monitor
You can monitor both transducers using a multiple-channel, 
single-point acquisition in LabVIEW.
LabVIEW Data Acquisition Basics Manual 6-2 © National Instruments Corporation
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Multiple-Channel Single-Point Analog Input

With a multiple-channel, single-point read (or scan), LabVIEW retur
the voltage on several channels at once. Use this type of operation w
you have multiple transducers to monitor and you want to retrieve d
from each transducer at the same time. Your DAQ device executes
scan across each of the specified channels and returns the voltage v
when finished. Refer to Appendix A, Hardware Capabilities, in the 
LabVIEW Function and VI Reference Manual, for the number of channels
your device can scan at one time. You also can refer to the LabVIE
online help, available by selecting Help»Online Reference….

The Easy I/O VI, AI Sample Channels, acquires single voltage valu
from multiple channels. The AI Sample Channels VI performs a sing
A/D conversion on the specified channels and returns the scaled 
voltages in a 1-dimensional (1D) array. The expected voltage range
all the signals, specified by high limit  and low limit inputs, applies to 
all the channels. Figure 6-3 shows how you can acquire a voltage fr
multiple channels with this VI.

Note: Remember to use commas to delimit individual channels in the channel
string, or use a colon to indicate an inclusive list of channels.

Figure 6-3.  Acquiring a Voltage from Multiple Channels with the AI Sample Channels VI

You can benefit from using the Easy Analog Input VIs because you o
need one icon in your diagram to perform the task, there are only a 
basic inputs to the VIs, and the VIs have built-in error checking; 
however, the lack of programming flexibility with these VIs can be a
limitation. Because Easy VIs have only a few inputs, you cannot 
implement some of the more detailed features of DAQ devices, such
triggering or interval scanning. In addition, these VIs always 
reconfigure at start-up. When you need a hi-speed or efficiently-run
© National Instruments Corporation 6-3 LabVIEW Data Acquisition Basics Manual
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program, these configurations can slow down processing time. Wh
you need speed and more efficiency, use the Intermediate VIs, whi
configure an acquisition only once and then continually acquire dat
without ever re-configuring. The Intermediate VIs also offer more err
handling control, more hardware functionality, and efficiency in 
developing your application than the Easy VIs. You typically use th
Intermediate VIs to perform buffered acquisitions. You can read mo
about buffered acquisitions in Chapter 7, Buffering Your Way 
through Waveform Acquisition. The Intermediate Analog Input VI, AI 
Single Scan VI, does multiple-channel, single-point acquisitions, as
shown in Figure 6-4.

Figure 6-4.  The AI Single Scan VI Help Diagram

The AI Single Scan VI returns one scan of data. You can also use 
VI to read only one point if you specify one channel. Use this VI on
in conjunction with the AI Config VI. 

Figure 6-5 shows a simplified block diagram for non-buffered 
applications. LabVIEW calls the AI Config VI, which configures the 
channels, selects the input limits  (the high limit  and low limit 
parameters in the Easy VIs), and generates a taskID. The program 
passes the taskID and the error cluster to the AI Single Scan VI, whic
returns the voltage data in an array (one point for each channel 
specified).

Figure 6-5.  Using the Intermediate VIs for a Basic Non-Buffered Application
LabVIEW Data Acquisition Basics Manual 6-4 © National Instruments Corporation
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Figure 6-6 shows how you can program the AI Config and AI Single
Scan VIs to perform a series of single scans by using software timin
While Loop) and processing each scan. This example shows the 
Cont Acquire&Chart (immediate) VI, which you can find in 
labview\examples\daq\anlogin\anlogin.llb . 

The advantage to using the intermediate-level VIs is that you do no
have to configure the channels every time you want to acquire data
you do when using the Easy VIs. To call the AI Config VI only once
put it outside of the While Loop in your program. The AI Config VI 
configures channels, selects a high/low limit, and generates a taskID. 
Then, the AI Config VI passes the taskID and error cluster into the 
While Loop, where LabVIEW calls the AI Single Scan VI to retrieve 
scan. The program then passes the returned data to the My Single-
Processing VI. With this VI, you can program whatever processing 
needs your application calls for, such as looking for a limit to be 
exceeded. The VI then passes the data through the build array func
to a waveform chart for display on the front panel. The Wait Until Ne
ms Multiple (metronome) function controls the loop timing. You ente
a scan rate, the application converts the value into milliseconds an
passes the converted value to the Wait Until Next ms Multiple functio
The loop then executes at the rate of scanning. The loop ends when
press the stop button or an when error occurs. Once the loop finish
the Simple Error Handler VI displays any errors that occurred on th
screen.

Figure 6-6.  The Cont Acq&Chart (immediate) VI Block Diagram
© National Instruments Corporation 6-5 LabVIEW Data Acquisition Basics Manual
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The previous examples use software-timed acquisition. With this ty
of acquisition, the CPU system clock controls the rate at which you
acquire data. Your system clock can be interrupted by user interact
so if you do not need a precise acquisition rate, use software-timed
analog input.

Using Analog Input/Output Control Loops

When you want to output analog data after receiving some analog in
data, use analog input/output (I/O) control loops. With control loops
this process is repeated over and over again.

The single-point analog input and output VIs support several analo
I/O control loops at once because you can acquire analog inputs fr
several different channels in one scan, and write all the analog out
values with one update. You perform a single analog input call, proc
the analog output values for each channel and then perform a sing
analog output call to update all the output channels. 

The following sections describe the two different types of analog I/O
control loop techniques: software-timed and hardware-timed 
analog I/O.

Using Software-Timed Analog I/O Control Loops
With software-timed analog control loops the analog acquisition rat
and subsequent control loop rate are controlled by a software timer s
as the Wait Until Next Millisecond multiple timer. The acquisition is
performed during each loop iteration when the AI Single Scan VI is
called and the control loop is executed once for each time interval. Y
loop timing can be interrupted by any user interaction which means
your acquisition rate is not as consistent as that which can be achie
through hardware-timed control loops. Generally, if you do not need
precise acquisition rate for your control loop, software timing is 
appropriate.

Besides user interaction, a large number or large-sized front panel
indicators, like charts and graphs, affect control loop rates. Refresh
the monitor screen interrupts the system clock, which controls loop
rates. Therefore, you should keep the number of charts and graphs
minimum when you are using software-timed control loops.
LabVIEW Data Acquisition Basics Manual 6-6 © National Instruments Corporation
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An example of software-timed control loops is the Analog IO Contro
Loop (immed) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .

The following diagram shows how to perform software-timed analo
I/O using the AI Read One Scan and AO Write One Update VIs.

Figure 6-7.  Software-Timed Analog I/O

The AI Read One Scan VI configures your DAQ device to acquire d
from analog input channels 0 and 1. Once your program acquires a 
point from channels 0 and 1, it performs calculations on the data an
outputs the results through analog output channels 0 and 1. Becaus
iteration count is connected to the AI Read One Scan and AO Write O
Update VIs, the application configures the DAQ device for analog inp
and output only on the first iteration of the loop. The loop rate as w
as the acquisition rate is specified by loop rate. The reason why the 
actual loop period is important is because user interaction affects th
loop and acquisition rate. When a user presses the mouse button f
instance, that action interrupts the system clock which controls the lo
rate. If your analog acquisition rate for control loops does not need
be consistent, then use software-timed control loops.
© National Instruments Corporation 6-7 LabVIEW Data Acquisition Basics Manual
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Using Hardware-Timed Analog I/O Control Loops
For a more precise timing of your control loops, and more precise 
analog input scan rate, use hardware-timed control loops. 

An example of hardware-timed, non-buffered control loops is the 
Analog IO Control Loop (hw timed) VI located in 
labview\examples\daq\anlog_io\anlog_io.llb . 

With hardware-timed control loops, your acquisition is not interrupte
by user interaction. Hardware-timed analog input automatically places 
the data in your DAQ device FIFO buffer at an interval determined 
the analog input scan rate. You can synchronize you control loop 
diagram to this precise analog input scan rate by repeatedly calling
AI Single Scan VI to read the oldest data in the FIFO. 

The AI Single Scan VI returns as soon as the next scan has been 
acquired by the DAQ Device. If more than one scan was stored in t
DAQ device FIFO when the AI Single Scan VI was called, the 
LabVIEW diagram was not able to keep up with the acquisition rate
This is detected by monitoring the data remaining output of the AI 
Single Scan VI. In other words, you have missed at least one contr
loop interval. This indicates that your software overhead is prevent
you from keeping up with your hardware-timed loop rate. In Figure 6
the loop too slow Boolean indicator is set to TRUE whenever this 
occurs.
LabVIEW Data Acquisition Basics Manual 6-8 © National Instruments Corporation
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Figure 6-8.  Analog IO Control Loop (hw timed) VI Block Diagram

In this diagram, the AI Config VI configures the device to acquire da
on channels 0 and 1. The application does not use a buffer created
CPU memory, but instead uses the DAQ device FIFO. The input limits 
parameter (also known as limit settings) affects the expected voltage 
range of the input signals. For more information on input limits (lim
settings), refer to Chapter 3, Basic LabVIEW Data Acquisition Concepts. 
The AI Start VI begins the analog acquisition at the loop rate (scan rate) 
parameter. On the first iteration of the loop, the AI Single Scan VI rea
the newest data in the FIFO. Some data may have been acquired 
between the execution of the AI Start and the AI Single Scan VIs. O
the first iteration of the loop, the application reads the latest data 
acquired between the AI Start and the AI Single Scan VIs. On ever
subsequent iteration of the loop, the application reads the oldest da
the FIFO, which is the next acquired point in the FIFO. 

If more than one value was stored in the DAQ device FIFO when y
read it, your application was not able to keep up with the control lo
acquisition and you have not responded with one control loop interv
This eventually leads to an error condition, which makes the loops 
complete. After the application completes analog acquisition and 
generation, then the AI Clear VI clears the analog input task. 
© National Instruments Corporation 6-9 LabVIEW Data Acquisition Basics Manual
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Figure 6-8 also includes a waveform chart in the control loop. This 
reduces your maximum loop rate. You can speed up the maximum 
of the control loop by removing this graph indicator.

You easily can add other processing to your analog I/O control loop
putting the analog input, control loop calculations and analog outpu
the first frame of a sequence inside the loop, and additional proces
in subsequent frames of the sequence. Keep in mind that this additi
processing must be less than your control loop interval. Otherwise, 
will not be able to keep up with your control loop rate.

Improving Control Loop Performance
There are some performance issues you should take into account if
plan to have other VIs or loops execute in parallel with your 
hardware-timed control loop. When you call the AI Single Scan VI in
hardware-timed control loop, the VI waits until the next scan is acquir
before returning, which means that the CPU is waiting inside the 
NI-DAQ driver until the scan is acquired. Consequently, if you try to
run other LabVIEW VIs or while loops in the same diagram in parall
with your hardware-timed control loop, they may run more slowly o
intermittently. You can reduce this problem by putting a software de
(with the Wait (ms) VI) at the end of your loop after you write your 
analog output values. Your other LabVIEW VIs and loops can then
execute during this time.

Another good technique is to poll for your analog input without waitin
in the driver. You can set the AI Single Scan VI time limit in sec to zero. 
Then, the VI reads the DAQ Device FIFO and immediately returns—
regardless of whether the next scan was acquired. The AI Single S
VI voltage data output array is empty if the scan was not yet acquire
Poll for your analog input by using a Wait (ms) or Wait Until Next m
Multiple function together with the AI Single Scan VI in a while loop
within your control loop diagram. Set the wait time smaller than you
control loop interval (at least twice as small). If the voltage data output 
array is not empty, exit the polling loop passing out the voltage data 
array and execute the rest of your control loop diagram. This metho
does not return data as soon as the scan has been acquired, as in 
example described previously, but provides ample time for other VI
and loops to execute. This method is a good technique for balancing
CPU load between several loops and VIs running in parallel.
LabVIEW Data Acquisition Basics Manual 6-10 © National Instruments Corporation
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In the previously described techniques, if you are using software del
for control loop speeds greater than 1 Hz turn the Use Default Timer 
option off in the Performance dialog box in your LabVIEW 
Preferences. Turning this off gives you around 1 ms software timer
resolution, instead of the default 55 ms timer resolution.
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If you want to take more than one reading on one or more channels
there are two techniques you can use depending on what you want t
with the data after you acquire it. This chapter reviews these differe
methods and explains how LabVIEW stores the acquired data with e
method. You will discover which method you should use by answeri
the following questions. 

• Do you want to analyze your data as it is being acquired or afte
has been acquired?

• Do you want to acquire a predetermined or indefinite number o
data points?

If you want to analyze your data as it is being measured and the num
of data points does not matter, read the Do You Need To Access Your 
Data during Acquisition? section in this chapter. If you acquire a 
predetermined number of data points and you want to analyze the 
after it has been acquired, refer to the Can You Wait for Your Data? 
section in this chapter. Also, throughout the chapter there are some
basic examples of some common data acquisition (DAQ) applicatio
that use these two methods.

Can You Wait for Your Data?

One way to acquire multiple data points for one or more channels is
use the non-buffered methods described in the previous chapter in
repetitive manner. For example, you could compare this method to a
to the grocery store. You need to get 20 items from the store, but 
because you can’t carry all 20 items at once, you decide you must m
20 separate trips to the store. Grocery shopping in this manner woul
very inefficient and time consuming. The same applies for when you 
acquiring a single data point from one or more channels over and o
Also, with this method of acquisition, you do not have accurate cont
over the time between each sample or channel. Going back to the 
example of grocery shopping, it would be much more efficient to us
shopping bag to hold all 20 food items at once, so that you only hav
isition Basics Manual
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make one trip. In the same sense, you can use a data buffer in com
memory as your shopping bag with which you acquire data. 

With buffered I/O, LabVIEW transfers data taken at timed intervals 
from a DAQ device to a data buffer in memory. Figure 7-1 illustrate
how the data fills up the buffer only once, however the overall size 
the buffer is specified in your VI. In this illustration, think of N as the 
number of scans or updates the buffer can hold, and T as the trigger 
occurrence whether the trigger is because of our external signal or
start of the execution of your VI. Refer to Chapter 8, Controlling Your 
Acquisition with Triggers, for more descriptions on triggering your 
acquisition from another signal.

Figure 7-1.  How Buffers Work

In your VI, you must specify the number of samples to be taken and
number of channels from which LabVIEW will take the samples. Fro
this information, LabVIEW allocates a buffer in memory to hold a 
number of data points equal to the number of samples per channel
multiplied by the number of channels. As the data acquisition continu
the buffer fills with the data; however, the data may not actually be
accessible until LabVIEW acquires all the samples (N). Once the d
acquisition is complete, the data that is in the buffer can be analyze
stored to disk, or displayed to the screen by your VI.

Acquiring a Single Waveform
You can acquire a waveform from a single channel by using the AI
Acquire Waveform VI, shown in Figure 7-2. You can find this VI in 
Functions»DAQ»Analog Input. Because AI Acquire Waveform is an 
Easy Analog Input VI, it has the minimal number of inputs needed t
acquire a waveform from a single channel. These minimal inputs are
device, channel string, number of samples from the channel, and the 
sample rate. You can programmatically set the gain by setting the high 
limit  and the low limit . Using only the minimal set of inputs makes 
programming the VI easier, but the VI lacks more advanced 
capabilities, such as triggering. Built-in error handling is another use
feature of the Easy VIs. If an error occurs, the program stops runni
and notifies you with a dialog box explaining the error.

writing and reading

T

N
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Note: If you previously set up your channel in the DAQ Channel Wizard, you d
not need to enter the device or input limits. Instead, enter a channel nam
and the value returned will be relative to the physical units you specified
for that channel in the DAQ Channel Wizard. If input limits are specified,
they also are treated as being relative to the physical units of the chann
This principal applies throughout this manual.

Figure 7-2.  The AI Acquire Waveform VI

Acquiring Multiple Waveforms
You can acquire more than one waveform at a time with another of 
Easy Analog Input VIs, AI Acquire Waveforms, shown in Figure 7-3
This VI also has a minimal set of inputs, but it allows inputs of more
than one channel to read and returns data from all channels read. 

Figure 7-3.  The AI Acquire Waveforms VI

The channel input for this VI is a string where you can enter a list of
channels. Refer to Chapter 3, Basic LabVIEW Data Acquisition Concepts, 
for more information on channel specification in LabVIEW. LabVIEW
outputs a two-dimensional (2D) array in the waveforms output for this 
VI, where each channel has a different column and the samples ar
each row. Refer to Chapter 3, Basic LabVIEW Data Acquisition 
Concepts, for more information on how data is organized for analog 
applications. You can set the high limit  and low limit  inputs for all the 
channels to the same value. You cannot have different limit settings
different channels when you use this VI. For more information on ga
specifications, go to Chapter 3, Basic LabVIEW Data Acquisition 
© National Instruments Corporation 7-3 LabVIEW Data Acquisition Basics Manual
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Concepts. Like the other Easy VIs, you cannot use any advanced 
programming features with the AI Acquire Waveforms VI. The built-i
error checking of this VI alerts you to any errors that occur in the 
program.

You also can acquire multiple waveforms using the Intermediate VI
The Intermediate VIs provide more control over your data acquisitio
processes, like being able to read any part of the buffer. An examp
similar to Figure 7-4 is the Acquire N Scans VI, located in 
labview\examples\daq\anlogin\anlogin.llb . With these 
Intermediate Analog Input VIs, you must wire a taskID to identify the 
DAQ operation and the set of channels used in the acquisition and
make sure the VIs execute in the correct order.

Figure 7-4.  Using the Intermediate VIs to Acquire Multiple Waveforms

With these VIs, you not only have the ability to configure triggering
coupling, acquisition timing, retrieval, and additional hardware, but y
also can control when each step of the data acquisition process occurs. 
With the AI Config VI, you can configure the different parameters o
the acquisition such as the channels to be read and the size of the b
to use. In the AI Start VI, you specify parameters used in your progr
to start the acquisition, such as number of scans to acquire, the rat
which your VI takes the data, and the trigger settings. In the AI Rea
VI, you specify parameters to retrieve the data from the data acquisi
buffer. Then, your application calls the AI Clear VI, which deallocate
all buffers and other resources used for the acquisition by invalidat
the taskID. If an error occurs in any of these VIs, your program pass
the error through the remaining VIs to the Simple Error Handler VI,
which notifies you of the error.
LabVIEW Data Acquisition Basics Manual 7-4 © National Instruments Corporation
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For many DAQ devices, the same ADC samples many channels ins
of only one. The maximum sampling rate per channel is

. 

The scan rate input in all the VIs described above is the same as th
sampling rate per channel. To figure out your maximum scan rate, y
must divide the maximum sampling rate by the number of channels
Appendix A, Hardware Capabilities, in the LabVIEW Function and VI 
Reference Manual, maximum sampling rates are listed for each DAQ
device. You also can refer to the LabVIEW online help, available by
selecting Help»Online Reference….

Note: When using the NB-A2100 or the NB-A2150 boards, specifying an odd 
buffer size or an odd number of samples when acquiring data with one 
channel results in an –10089 badTotalCountErr. To avoid this error, 
specify an even number of samples and throw away the extra sample.

Simple-Buffered Analog Input Examples

Simple-Buffered Analog Input with Graphing
Figure 7-5 demonstrates how you can use the AI Acquire Waveform
VI to acquire two waveforms from channels 0 and 1 and then displa
the waveforms on separate graphs. This type of VI is useful in 
comparing two or more waveforms, or in analyzing how a signal loo
before and after going through a system. In this illustration, 1000 sc
of channels 0 and 1 are taken at the rate of 5000 scans per second
Actual Scan Period output displays in the actual timebase on the x-ax
of the graphs. Remember that each column of the 2D array contains
information for each channel.

maximum sampling rate
number of channels

-----------------------------------------------------------------
© National Instruments Corporation 7-5 LabVIEW Data Acquisition Basics Manual
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Figure 7-5.  Simple Buffered Analog Input Example

If you want to display the data on the same graph, look again at the
Acquire N Scans example VI, found in labview\examples\daq\

anlogin\anlogin.llb . Figure 7-6 shows a simple buffered input 
application that uses graphing.

Figure 7-6.  Simple Buffered Analog Input with Graphing

For a 2D array to be displayed on a waveform graph, each row of d
must represent a single plot. This is because waveform graphs are
row-major order. Because the channel data is in each column, you m
transpose the 2D array. Transposing the array can be done easily 
popping-up on the front panel of the graph and choosing Transpose 
Array . 
LabVIEW Data Acquisition Basics Manual 7-6 © National Instruments Corporation
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Simple-Buffered Analog Input with Multiple Starts
In some cases you may not want to acquire contiguous data, like in
oscilloscope application. In this case, you would only want to take a
specified number of samples as a snapshot of what the input looks 
periodically. For an example using the Intermediate VIs, open the 
Acquire N-Multi-Start VI found in labview\examples\daq\

anlogin\anlogin.llb . The Acquire N-Multi-Start VI, shown in 
Figure 7-7, is similar to the Acquire N Scans example, except the 
acquisition only occurs each time the start button on the front pane
pressed. 

Figure 7-7.  Taking a Specified Number of Samples with the Intermediate VIs

This example is similar to the standard simple buffered analog input 
but now both the AI Start and AI Read VIs are in a While Loop, whic
means the program takes a number of samples every time the Whi
Loop iterates.
© National Instruments Corporation 7-7 LabVIEW Data Acquisition Basics Manual
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Note: The AI Read VI returns 1000 samples, taken at 5000 samples per seco
every time the While Loop iterates; however, the duration of the iteration
of the While Loop can vary greatly. This means that, with this VI, you ca
control the rate at which samples are taken, but you may not be able to
designate exactly when your application starts acquiring each set of dat
If this start-up timing is important to your program, read Do You Need To 
Access Your Data during Acquisition? in this chapter to see how to control 
acquisition start-up times.

Simple-Buffered Analog Input with a Write to Spreadsheet File
If you want to write the acquired data to a file, there are many file 
formats in which you can store the data. The spreadsheet file forma
used most often because you can read it using most spreadsheet 
applications for later data graphing and analysis. In LabVIEW, you c
use VIs to send data to a file in spreadsheet format or read back da
from such a file. You can locate these VIs in Functions»File I/O. The 
VI used in this example is the Write to Spreadsheet File VI, shown 
Figure 7-8. In this exercise, the Intermediate analog input VIs acqu
an array of data, graph the data using the actual sample period for
x-axis timebase, and create a spreadsheet file containing the data.

Figure 7-8.  Writing to a Spreadsheet File after Acquisition

Triggered Analog Input
For information on starting your acquisition with triggers, go to 
Chapter 8, Controlling Your Acquisition with Triggers.
LabVIEW Data Acquisition Basics Manual 7-8 © National Instruments Corporation
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Do You Need To Access Your Data during Acquisition?

You can apply the simple buffering techniques in many DAQ 
applications, but there are some applications where these technique
not appropriate. If you need to acquire more data than your comput
memory can hold, or if you want to acquire data over long periods o
time, you should not use these simple-buffered techniques. For the
types of applications, you should set up a circular buffer to store 
acquired data in memory. In the previous section, buffered input wa
compared to shopping for groceries. You typically use a cart or bag
(your buffer) to hold as many groceries (your acquired data) as possi
so that you only have to make one trip to the store. In this case, imag
that you must prepare a meal and you are unable to go shopping—
periodically you need things from the store for your recipe. If you se
someone else to the store for you, you can continue to prepare din
while someone else retrieves the other items you need. You can 
compare this scenario to circular-buffered data acquisition, shown 
Figure 7-9. Using a circular buffer, you can set up your device to 
continuously acquire data in the background while LabVIEW retriev
the acquired data. 
© National Instruments Corporation 7-9 LabVIEW Data Acquisition Basics Manual
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Figure 7-9.  How a Circular Buffer Works

A circular buffer differs from a simple buffer only in how LabVIEW 
places the data into it, and retrieves data from it. A circular buffer is
filled with data, just as a simple buffer; however, when it gets to the e
of the buffer, it returns to the beginning and fills up the same buffer
again. This means data can read continuously into computer memo
but only a defined amount of memory can be used. Your VI must 
retrieve data in blocks, from one location in the buffer, while the da
enters the circular buffer at a different location, so that unread data
not overwritten by newer data. Because of the buffer maintenance, 
can only use the Intermediate or Advanced VIs with this type of dat
acquisition. 

While a circular buffer works well in many applications, there are tw
possible problems that can occur with this type of acquisition: your 
could try to retrieve data from the buffer faster than data is placed i
it, or your VI might not retrieve data from the buffer fast enough befo
LabVIEW overwrites the data into the buffer. When your VI tries to 
read data from the buffer that has not yet been collected, LabVIEW
waits for the data your VI requested to be acquired and then returns
LabVIEW Data Acquisition Basics Manual 7-10 © National Instruments Corporation
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data. If your VI does not read the data from the circular buffer fast 
enough, the VI sends back an error, advising you that the data that
retrieved from the buffer is overwritten data. 

Continuously Acquiring Data from Multiple Channels
You can acquire time-sampled data continuously from one or more
channels with the Intermediate VIs. An example using these VIs is 
Acquire & Process N Scans VI, found in labview\examples\daq\

anlogin\anlogin.llb . This example is shown in Figure 7-10. Ther
are inputs for setting the channels, size of the circular buffer, scan r
and the number of samples to retrieve from the circular buffer each
time. This VI defaults to a input buffer size of 2000 samples and 
1000number of scans to read at a time, which means the VI reads in 
half of the buffer’s data while the VI fills the second half of the buffe
with new data. 

Note: The number of scans to read can be any number less than the input  buffer 
size. 

If you do not retrieve data from the circular buffer fast enough, you
unread data will be overwritten by newer data. You can resolve this
problem in one of three ways: by adjusting the input buffer size, scan 
rate, or the number of scans to read at a time parameters. If your 
program overwrites data in the buffer, then data is coming into the 
buffer faster than your VI can read all of the previous buffer data, a
LabVIEW returns an error code –10846 overWriteError . You can 
increase the size of the buffer so that it takes longer to fill up, which
leaves your VI with more time to read data from it. If you slow down
the scan rate, you reduce the speed at which the buffer fills up, whic
also leaves more time for your program to retrieve data. You can a
increase the number of scans to read at a time, which will retrieve more 
data out of the buffer each time and effectively reduce the number 
times to access the buffer before it becomes full. Check the output scan 
© National Instruments Corporation 7-11 LabVIEW Data Acquisition Basics Manual
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Figure 7-10.  Continuously Acquiring Data with the Intermediate VIs

Because this uses Intermediate VIs, you also can control paramete
such as triggering, coupling, and additional hardware.

Asynchronous Continuous Acquisition using DAQ Occurrences
The main advantage of the last section is that you are free to manipu
your data between calls to AI Read.vi . One limitation, however, is that 
the acquisition is synchronous. This means that once you call 
AI Read.vi , you cannot perform any other tasks until AI Read.vi  
returns your acquired data. If your DAQ device is still busy collectin
data, you will have to sit idle until it finishes.

If you need the efficiency of not having to wait for AI Read.vi , then 
asynchronous acquisition is for you. You can acquire asynchronou
continuous data from multiple channels using the same intermediat
DAQ VIs by adding DAQ Occurrences. Figure 7-11 shows an exam
of how to do this. This is the diagram of the Cont Acq&Chart (Asyn
Occurrence) VI, located in labview\examples\daq\anlogin\

anlogin.llb . Notice that it is very similar to Figure 7-10.
LabVIEW Data Acquisition Basics Manual 7-12 © National Instruments Corporation
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The difference is that here you will use the DAQ Occurrence Config
and the Wait on Occurrence function to control the reads. The first 
DAQ Occurrence Config VI sets the DAQ Event. In this example th
DAQ Event is to set the occurrence every time a number of scans is
acquired equal to the value of general value A, where general value A 
is the number of scans to read at a time. Inside the while loop, the Wait 
on Occurrence function sleeps in the background until the chosen DAQ 
Event takes place. Notice that the timed out output from the Wait on
Occurrence function is wired to the selection terminal of the case 
structure that encloses the AI Read VI. This means that AI Read will 
be called until the number of scans to read at a time have been 
acquired. The result is that the while loop is effectively put to sleep
because you do not try to read the data until you know it has been 
acquired. This frees up processor time to do other tasks while you 
waiting for the DAQ Event. If the DAQ Occurrence times out, the time
out output value would be TRUE, and AI Read would never be calle
When your acquisition is complete, DAQ Occurrence is called again
clear all occurrences.

Figure 7-11.  Continuous Acq&Chart (Async Occurrence) VI
© National Instruments Corporation 7-13 LabVIEW Data Acquisition Basics Manual
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Circular-Buffered Analog Input Examples

The only differences between the simple-buffered applications and
circular-buffered applications in the block diagram is the number of 
scans to read input of the AI Start VI is set to 0, and now we must ca
the AI Read VI repeatedly to retrieve your data. These changes ca
applied to many of the examples in the previous section on simple 
buffered analog input, however we will review the basic 
circular-buffered analog input VI here, and describe some other 
example VIs that are included with LabVIEW. 

Basic Circular-Buffered Analog Input
Figure 7-12 shows an example VI that brings data from channel 0 a
rate of 1000 samples/s into a buffer that can hold 4000 samples. T
type of example might be handy if you wanted to watch the data from
channel over a long period of time, but you could not store all the d
in memory at once. The AI Config VI sets up the channel specificati
and buffer size, then the AI Start VI initiates the background data 
acquisition and specifies the rate. Inside the While Loop, the AI Re
VI repeatedly reads blocks of data from the buffer of a size equal to
either 1000 scans or the size of the scan backlog—whichever one is 
larger. The VI does this by using the Max & Min function to determin
the larger of the two values. You do not have to use the Max & Min
function in this way for the application to work, but the function help
control the size of the scan backlog, which is how many samples that 
are left over in the buffer. This VI continuously reads and displays t
data from channel 0 until an error occurs or until you press the Stop 
button.
LabVIEW Data Acquisition Basics Manual 7-14 © National Instruments Corporation
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Figure 7-12.  Basic Circular-Buffered Analog Input Using the Intermediate VIs

Other Circular-Buffered Analog Input Examples
There are many other circular-buffered analog input VIs that are 
included with your LabVIEW application. The following sections 
briefly explain some of these VIs. You can find the first two VIs in 
labview\examples\daq\anlogin\anlogin.llb  and the rest of the 
example VIs in labview\examples\daq\anlogin\strmdsk.llb . 
For information on how these examples work and how to modify the
open Windows»Show VI Information or open the Help window by 
choosing Help»Show Help.

Cont Acq&Chart (buffered).vi
The Cont Acq&Chart (buffered).vi  demonstrates 
circular-buffered analog input similarly to the previous example, bu
this VI includes other front panel inputs.

Cont Acq&Graph (buffered).vi
The Cont Acq & Graph (buffered).vi  is similar to Cont 

Acq&Chart (buffered).vi , except this VI displays data in a 
waveform graph.

Cont Acq to File (binary).vi
In the Cont Acq to File (binary).vi , your program acquires data
through circular-buffered analog input and stores it in a specified file
binary data. This process is more commonly called streaming to disk.
© National Instruments Corporation 7-15 LabVIEW Data Acquisition Basics Manual
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Cont Acq to File (scaled).vi
The Cont Acq to File (scaled).vi  is similar to the previous binary 
VI, with the exception that this VI writes the acquired data to a file a
scaled voltage readings rather than binary values.

Cont Acq to Spreadsheet File.vi
The Cont Acq to Spreadsheet File.vi  continuously reads data 
that LabVIEW acquires in the circular buffer, and stores this data to
specified file in spreadsheet format. You can view the data stored i
spreadsheet file by this VI in any spreadsheet application.

Simultaneous Buffered Waveform Acquisition and 
Waveform Generation

You might discover that along with your analog input acquisition, yo
also would like to output analog data. If so, see Chapter 14, 
Simultaneous Buffered Waveform Acquisition and Generation.
LabVIEW Data Acquisition Basics Manual 7-16 © National Instruments Corporation
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The single-point and waveform acquisitions described in the previo
sections start at random times relative to the data. But, there are ti
that you may need to be able to set your analog acquisition to start
certain time. An example of this would be if you wanted to measure 
temperature of an object after applying heat to it. An electrical 
thermometer sends a step voltage to your data acquisition (DAQ) de
after the heating process completes. If you have no way to begin 
measuring data immediately after your device receives the step volta
then you must acquire more points, some before the step voltage a
some after it in order to capture the data you need. As you can see,
solution is an inefficient use of computer memory and disk space, 
because you must allocate and use more than is necessary. Sometimes 
the data you need may be closer to the front of the buffer and other ti
it may be closer to the end of the buffer.

However, there is a way to start an acquisition based on the condit
or state of an analog or digital signal. This technique is commonly 
called triggering. Generally, a trigger is any event that causes or start
some form of data capture. There are two basic types of triggering—
hardware and software triggering. In LabVIEW, you can use softwa
triggering to start acquisitions or use it with an external device to 
perform hardware triggering.

Hardware Triggering

Hardware triggering lets you set the start time of an acquisition and
gather data at a known position in time relative to a trigger signal. 
External devices produce hardware trigger signals. In LabVIEW, yo
specify the triggering conditions that must be reached before 
acquisition begins. Once the conditions are met, the acquisition beg
immediately. You can also analyze the data before trigger.

There are two specific types of hardware triggers: digital and analog
the following two sections, you will learn about the necessary 
conditions to start an acquisition with a digital or an analog signal.
isition Basics Manual
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Digital Triggering
A digital trigger is usually a transistor-transistor logic (TTL) level 
signal having two discrete levels—a high and a low level. When mov
from high to low or low to high, a digital edge is created. There are t
types of edges: rising and falling. You can set your analog acquisit
to start as a result of the rising or falling edge of your digital trigger
signal.

In Figure 8-1, the acquisition begins after the falling edge of the digi
trigger signal. Usually digital trigger signals are connected to 
STARTTRIG*, EXTTRIG*, DTRIG, or PFI pins on your DAQ device.
If you want to know which pin your device has, look at your hardwa
manual, or at the AI Trigger Config VI description in Chapter 17, 
Advanced Analog Input VIs, of the LabVIEW Function and VI Reference
Manual. You also can refer to the LabVIEW online help, available b
selecting Help»Online Reference….The STARTTRIG* and 
EXTTRIG* pins, which have and asterisk after their names, regard 
falling edge signal as a trigger. Make sure you account for this situat
when specifying your triggering conditions.

Figure 8-1.  Diagram of a Digital Trigger

Figure 8-2 shows a timeline of how digital triggering works for 
post-triggered data acquisition. In this example, an external device
sends a trigger, or TTL signal, to your DAQ device. As soon as you

TTL Signal

Connect to STARTTRIG*, EXTTRIG*, 
or DTRIG Pins

Falling Edge of Signal
Data Capture Initiated
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DAQ device receives the signal, and your trigger conditions are met, 
your device begins acquiring data.

Figure 8-2.  Digital Triggering with Your DAQ Device

Digital Triggering Examples
A common example of digital triggering in LabVIEW is the Acquire N
Scans Digital Trig VI, found in labview\examples\daq\anlogin\

anlogin.llb . This VI, as shown Figure 8-3, uses the Intermediate V
to perform a buffered acquisition, where LabVIEW stores data in a 
memory buffer during acquisition. After the acquisition completes, t

External DAQ  Digital Trigger
Signal

Analog Data

DAQ Device waits for digital trigger conditions.
Then …

Device Device

DAQ  
Device

External 
Device
© National Instruments Corporation 8-3 LabVIEW Data Acquisition Basics Manual



Chapter 8 Controlling Your Acquisition with Triggers

g 

u 
can 

 

 

VI retrieves all the data from the memory buffer and displays it. 
Figure 8-3 shows the block diagram of this example VI.

Figure 8-3.  Block Diagram of the Acquire N Scans Digital Trig VI

For more information on buffered acquisitions, refer to Chapter 7, 
Buffering Your Way through Waveform Acquisition. 

You must tell your device the conditions on which it will start acquirin
data.

For this example, the choose trigger type Boolean should be set to 
START OR STOP TRIGGER. You should only use the START & STOP 

TRIGGER when you have two triggers: start and stop. In addition, if yo
use a DAQ device with PFI lines (e.g., E-series 5102 devices), you 
specify the trigger signal condition in the trigger channel string control 
in the analog chan & level cluster. For more information on valid trigger
channel names, refer to the AI Trigger Config VI description, in 
Chapter 17, Advanced Analog Input VIs, of the LabVIEW Function and VI 
Reference Manual, or to the LabVIEW online help, available by 
selecting Help»Online Reference…. This chapter only describes 
applications that use one digital trigger. For more information on 
two-triggered applications, look at the description for the AI Trigger
Config VI, found in Chapter 17, Advanced Analog Input VIs, in the 
LabVIEW Function and VI Reference Manual, or to the LabVIEW online 
help, available by selecting Help»Online Reference….
LabVIEW Data Acquisition Basics Manual 8-4 © National Instruments Corporation



Chapter 8 Controlling Your Acquisition with Triggers

er 

g 

ng 
e 
d 

er 

 

e 

he 

. 

r 
 
 the 
In LabVIEW, you can acquire data both before and after a digital trigg
signal. If the pretrigger scans is greater than 0, your device acquires 
data before the triggering conditions are met and subtract the pretrigger 
scans parameter value from the number of scans to acquire parameter 
value to determine the number of scans to collect after the triggerin
conditions are met. If pretrigger scans is 0, you acquire the number of 
scans to acquire after the triggering conditions are met.

Before you start acquiring data, you must specify in the trigger edge 
input whether the acquisition should be triggered on the rising or falli
edge of the digital trigger signal. You also can specify a value for th
time limit , the maximum amount of time the VI waits for the trigger an
requested data.

Digital Triggering Examples
The Acquire N Scans Digital Trig VI example holds the data in a 
memory buffer until your device completes the acquisition. The numb
of data points you need to acquire must be small enough to fit in 
memory. This VI only views and processes the information after the
acquisition. If you need to view and process information during the 
acquisition, use the Acquire & Proc N Scans-Trig VI, found in 
labview\examples\daq\anlogin\anlogin.llb . If you expect 
multiple digital trigger signals that will start multiple acquisitions, us
the example VI, Acquire N-Multi-Digital Trig, located in 
labview\examples\daq\anlogin\anlogin.llb .

Analog Triggering
You connect analog trigger signals to the analog input channels—t
same channels where you connect analog data. Your DAQ device 
monitors the analog trigger channel until trigger conditions are met
You configure the DAQ device to wait for a certain condition of the 
analog input signal, like the signal (or voltage) level or slope (eithe
rising or falling). Once the device identifies the trigger conditions, it
starts an acquisition. In Figure 8-4, the analog trigger is set to start
© National Instruments Corporation 8-5 LabVIEW Data Acquisition Basics Manual
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data acquisition on the rising slope of the signal, when the signal 
reaches 3.2 volts.

Figure 8-4.  Diagram of an Analog Trigger

Figure 8-5 explains analog triggering for post-triggered data acquisit
using a timeline. You configure your DAQ hardware in LabVIEW to
begin taking data when the incoming signal is on the rising slope a
when the amplitude reaches 3.2 volts. Your DAQ device begins 
capturing data when the specified analog trigger conditions are me

Volts

— — — — — — — — — — — — — — — — — — — — — 

Level and Slope of
Signal Initiates Data Capture

3.2

0
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Figure 8-5.  Analog Triggering with Your DAQ Device

Analog Triggering Examples
A common example of analog triggering in LabVIEW is the Acquire 
Scans Analog Hardware Trig VI, located in labview\examples\

daq\anlogin\anlogin.llb . This VI, as shown in Figure 8-6, uses th
Intermediate VIs to perform buffered acquisition, where data is stor
in a memory buffer during acquisition. After the acquisition complete
the VI retrieves all the data from the memory buffer and displays it.

Analog Trigger
Signal

Analog Data

DAQ Device waits until analog trigger
conditions are met. Then …

DAQ  
Device

External 
Device

DAQ  
Device

External 
Device
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Figure 8-6.  Block Diagram of the Acquire N Scans Analog Hardware Trig VI

For more information on buffered acquisition, read Chapter 7, Buffering 
Your Way through Waveform Acquisition.

You must tell your device the conditions on which to start acquiring
data.

In LabVIEW, you can acquire data both before and after an analog
trigger signal. If the pretrigger scans is greater than 0, your device 
acquires data before the triggering conditions and subtracts the 
pretrigger scans parameter value from the number of scans to acquire 
parameter value to determine the number of scans to collect after t
triggering conditions are met. If pretrigger scans is 0, then the number 
of scans to acquire will be acquired after the triggering conditions are
met.

Before you start acquiring data, you must specify in the trigger slope 
input if the acquisition is going to be triggered on the rising or fallin
edge of the analog trigger signal. Aside from specifying the slope, y
must enter the trigger channel where the analog triggering signal will 
be connected as well as the trigger level on the triggering signal needed
to begin acquisition. In other words, once you specify the channel of
triggering signal, LabVIEW will wait until the slope and trigger level
conditions are met before starting a buffered acquisition. If you use
LabVIEW Data Acquisition Basics Manual 8-8 © National Instruments Corporation
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channel names configured in the DAQ Channel Wizard, the trigger 
level is treated in the physical units specified for the channel in the DA
Channel Wizard. Otherwise, the trigger level is treated as volts.

The Acquire N Scans Analog Hardware Trig VI example, located in
labview\examples\daq\anlogin\anlogin.llb , holds the data in a 
memory buffer until the device completes data acquisition. The num
of data points you want to acquire must be small enough to fit in 
memory. This VI only views and processes the information after the
acquisition. If you need to view and process information during the 
acquisition, use the Acquire & Proc N Scans-Trig VI, located in 
labview\examples\daq\anlogin\anlogin.llb . If you expect 
multiple analog trigger signals that will start multiple acquisitions, u
the example Acquire N-Multi-Analog Hardware Trig VI, located in 
labview\examples\daq\anlogin\anlogin.llb .

Software Triggering

With software triggering, you can simulate an analog trigger using 
software. This form of triggering is often used in situations where 
hardware triggers are not available. Another name for software 
triggering signals, specifically analog signals, is conditional retrieval. 
With conditional retrieval, you set up your DAQ device to collect dat
but the device does not return any data to LabVIEW unless the dat
meets your retrieval conditions. LabVIEW scans the input data and
performs a comparison with the conditions, but does not store the d
until it meets your specifications. Figure 8-7 shows a timeline of eve
that typically occur when you perform conditional retrieval.

The read/search position pointer traverses the buffer until it finds th
scan location where the data has met the retrieval conditions. Offse
indicates the scan location from which the VI begins reading data 
relative to the read/search position. A negative offset indicates that 
need pretrigger data (data prior to the retrieval conditions). If offset
greater than 0, you need posttrigger data (data after retrieval 
conditions).
© National Instruments Corporation 8-9 LabVIEW Data Acquisition Basics Manual
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Figure 8-7.  Timeline of Conditional Retrieval

The conditional retrieval cluster of the AI Read VI specifies the analo
signal conditions of retrieval, as shown in Figure 8-8.
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Figure 8-8.  The AI Read VI Conditional Retrieval Cluster

Note: Remember that the actual data acquisition is started by running your VI
and that the conditional retrieval just controls the returning of data already
being acquired. 

If you use the channel names configured in the DAQ Channel Wiza
the level and hysteresis values are treated in the physical units spec
for the channel in the DAQ Channel Wizard. Otherwise, these valu
are treated as volts.

When acquiring data with conditional retrieval, you typically store th
data in a memory buffer, similar to hardware triggering applications
After you start running the VI, the data is placed in the buffer. Once 
retrieval conditions have been met, the AI Read VI searches the bu
for the desired information. As with hardware analog triggering, you
specify the analog channel of the triggering signal by specifying its
channel index, an index number corresponding to the relative order 
a single channel in a channel list. You also specify the slope (rising or 
falling) and the level of the trigger signal.

Note: The channel index might not be equal to the channel value.

The AI Read VI begins searching for the retrieval conditions in the 
buffer at the read/search position, another input of the AI Read VI. T
offset, a value of the conditional retrieval input cluster, is where you 
specify the scan locations from which the VI begins reading data 
relative to the read\search position. A negative offset indicates data 
prior to the retrieval condition pretrigger data, and a positive offset 
indicates data after the retrieval condition posttrigger data. The skip 
count parameter is where you specify the number of times the trigg
conditions are met. The hysteresis parameter is where you specify the
voltage range you will use to meet retrieval conditions. Once the slope 
and level conditions on channel index have been found, the read/searc
position indicates the location where the retrieval conditions were m
© National Instruments Corporation 8-11 LabVIEW Data Acquisition Basics Manual
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For more information on the conditional retrieval input cluster, look 
the AI Read VI description in Chapter 15, Intermediate Analog Input VIs, 
in the LabVIEW Function and VI Reference Manual, or the LabVIEW 
online help, available by selecting Help»Online Reference….

Conditional Retrieval Examples
The Acquire N Scans Analog Software Trig VI example, located in 
labview\examples\daq\anlogin\anlogin.llb , uses the 
Intermediate VIs, as shown in Figure 8-9.

Figure 8-9.  Block Diagram of the Acquire N Scans Analog Software Trig VI

The main difference between this software triggering example and 
hardware triggering is the use of the conditional retrieval input for the 
AI Read VI. You set up the trigger channel, trigger slope, and trigger 
level the same way for both triggering methods. The pretrigger scans 
value will be negated and connected to the offset value in the 
conditional retrieval cluster of the AI Read VI. When the trigger 
conditions are met, the VI will return the requested number of scan
LabVIEW Data Acquisition Basics Manual 8-12 © National Instruments Corporation



© National Instruments Corporation 9-1 LabVIEW Data Acqu
Chapter

9

Letting an Outside 
Source Control Your 
Acquisition Rate
 
to 
or 
se 
is 
trol 

he 
 10 
the 
ur 

 the 
es 
rate 

tem 
Typically, a data acquisition (DAQ) device uses internal counters to
determine the rate to acquire data, but sometimes you might need 
capture your data at the rate of particular signals in your system. F
example, you can also read temperature channels every time a pul
occurs which represents pressure rising above a certain level. In th
case, internal counters are inefficient for your needs. You must con
your acquisition rate by some other, external source.

You can compare a scan of your channels to taking a snapshot of t
voltages on your analog input channels. If you set your scan rate to
scans per second, you are taking 10 snapshots each second of all 
channels in your channel list. In this case, an internal clock within yo
device (the scan clock) sets the scan rate, which controls the time 
interval between scans. 

Also, remember that most DAQ devices (those that do not 
simultaneously sample) proceed from one channel to the next 
depending on the channel clock rate. Therefore, the channel clock is
clock controlling the time interval between individual channel sampl
within a scan, which means the channel clock proceeds at a faster 
than the scan clock. 

The faster the channel clock rate, the more closely in time your sys
samples the channels within each scan, as shown in Figure 9-1.

Note: For devices with both a scan and channel clock, lowering the scan rate 
does not change the channel clock rate. 

Figure 9-1.  Channel and Scan Intervals Using the Channel Clock
isition Basics Manual
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Some DAQ devices do not have scan clocks, but rather use round-robin 
scanning. Figure 9-2 shows an example of round-robin scanning.

Figure 9-2.  Round-Robin Scanning Using the Channel Clock

The devices that always perform round-robin scanning include, but 
not limited to, the following:

• NB-MIO-16

• PC-LPM-16

• PC-LPM-16PnP

• PC-516

• DAQCard-500

• DAQCard-516

• DAQCard-700

• Lab-NB, Lab-SE

• Lab-LC

With no scan clock, the channel clock is used to switch between ea
channel at an equal interval. The same delay exists between all cha
samples, as well as between the last channel of a scan and the firs
channel in the next scan. (For boards with scan and channel clocks
round-robin scanning occurs when you disable the scan clock by set
the scan rate to zero and using the interchannel delay of the AI Config 
VI to control your acquisition rate.)

Finally, remember that LabVIEW is scan-clock oriented. In other 
words, when you select a scan rate, LabVIEW automatically selects
channel clock rate for you. LabVIEW selects the fastest channel clo
rate that allows adequate settling time for the Analog-to-Digital 
Converter (ADC). 

LabVIEW adds an extra 10-µs to the interchannel delay to compensa
for any unaccounted factors. However, LabVIEW does not consider 
additional delay for purposes of warnings. If you have specified a sc
rate that is adequate for acquisition but too fast for LabVIEW to app
LabVIEW Data Acquisition Basics Manual 9-2 © National Instruments Corporation
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the 10-µs delay, it configures the acquisition but does not return a 
warning.

You can set your channel clock rate with the interchannel delay input 
of the AI Config VI, which calls the Advanced AI Clock Config VI to
actually configure the channel clock. The simplest method to select
interchannel delay is to gradually increase the delay, or clock perio
until the data appears consistent with data from the previous delay
setting.

Refer to your hardware manuals for the required settling time for yo
channel clock. You can also find the interchannel delay by running 
low-level AI Clock Config VI for the channel clock with no frequency
specified.

Externally Controlling your Channel Clock

There are times when you might need to control the channel clock 
externally. The channel clock rate is the same rate at which analog
conversions occur. For instance, suppose you need to know the str
value at an input, every time an infrared sensor sends a pulse. Mos
DAQ devices have an EXTCONV* pin or a PFI pin on the I/O 
connector for providing your own channel clock. This external signa
must be a TTL level signal. The asterisk on the signal name indicat
that the actual conversion occurs on the falling edge of the signal, 
shown in Figure 9-3. For devices with PFI lines, you can select eith
the rising edge of falling edge using LabVIEW. With devices that ha
a RTSI connector, you can get your channel clock from other Natio
Instruments DAQ devices.

Figure 9-3.  Example of a TTL Signal

TTL Signal

rising edge falling edge
© National Instruments Corporation 9-3 LabVIEW Data Acquisition Basics Manual
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Figure 9-4 shows you the Acquire N Scans-ExtChanClk VI, located
labview\examples\daq\anlogin\anlogin.llb . This example 
demonstrates how to set up your acquisition for an externally control
channel clock. The VI includes the AI Clock Config VI and the clock
source was connected to the I/O connector.

Figure 9-4.  Getting Started Analog Input Example VI

You can enable external conversions by calling the Advanced-level
Clock Config VI. Remember that the AI Clock Config VI, which is 
called by the AI Config VI, normally sets internal channel delay 
automatically or manually with the interchannel delay control. 
However, calling the AI Clock Config VI after the AI Config VI resets
the channel clock so that it comes from an external source for exte
conversion. Also, notice that the scan clock is set to 0 to disable it,
allowing the channel clock to control the acquisition rate.

Note: The 5102 devices do not support external channel clock pulses, becaus
there is no channel clock on the device.

On most devices, external conversions occur on the falling edge of
EXTCONV* line. Consult your hardware reference manual for timin
diagrams. On devices with PFI lines (e.g., E-series devices), you can
LabVIEW Data Acquisition Basics Manual 9-4 © National Instruments Corporation
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the Clock Source Code input of AI Clock Config VI to the PFI pin with 
either falling or rising edge or use the default PFI2/Convert* pin whe
the conversions occur on the falling edge, as shown in Figure 9-5.

Figure 9-5.  Setting the Clock Source Code for External Conversion Pulses 
for E Series Devices

Note: The AT-MIO-16, AT-MIO-16D, NB-MIO-16, and NB-MIO-16X cannot 
support both an external channel clock and a digital trigger signal at the
same time. You must choose one or the other. 

Because LabVIEW determines the length of time before the AI Read
times out based on the interchannel delay and scan clock rate, you may 
need to force a time limit for the AI Read VI, as shown previously in
Figure 9-4.

Note: On the Lab-PC+ and 1200 devices, the first clock pulse on the EXTCONV
pin configures the acquisition but does not cause a conversion. Howeve
all subsequent pulses cause conversions.

Externally Controlling your Scan Clock

External scan clock control may be more useful than external chan
clock control if you are sampling multiple channels, but may not be
obvious to find because it does not have the input on the I/O conne
labeled “ExtScanClock,” the way the EXTCONV* pin does. 

Note: Some MIO devices have an output on the I/O connector labeled SCANCLK. 
This cannot be used as an input.
© National Instruments Corporation 9-5 LabVIEW Data Acquisition Basics Manual



Chapter 9 Letting an Outside Source Control Your Acquisition Rate

 in 

ort 

the 
 

g 

s 
 

 

The appropriate pin to input your external scan clock can be found
the Table  9-1. 

Note: Some devices do not have internal scan clocks and therefore do not supp
external scan clocks. These devices include, but are not limited to the 
following: NB-MIO-16, PC-LPM-16, PC-LPM-16PnP, PC-516, 
DAQCard-500, DAQCard-516, DAQCard-700, Lab-NB, Lab-SE, 
and Lab-LC.

After connecting your external scan clock to the correct pin, set up 
external scan clock in software. In Figure 9-6, the example Acquire N
Scans - ExtScanClk VI located in labview\examples\daq\anlogin\

anlogin.llb  shows how to do this. Two advanced VIs, AI Clock Confi
and AI Control, are used in place of the intermediate AI Start VI. This 
allows access to the clock source input. This is necessary because it allow
access to the clock source string which is used to identify the PFI pin to be
used for the scan clock for E-series boards. The clock source also includes 
the clock source code (on the front panel) which is set to I/O connector.
The 0 wired to the Clock Config VI disables the internal clock.

Table 9-1.  External Scan Clock Input Pins

Device External Scan Clock Input Pin

AT-MIO-16
AT-MIO-16F-5
AT-MIO-16X
AT-MIO-16D
AT-MIO-64F-5

OUT2

All E Series Devices Any PFI Pin 

Lab-PC+
1200 devices

OUT B1
LabVIEW Data Acquisition Basics Manual 9-6 © National Instruments Corporation
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Figure 9-6.  Externally Controlling Your Scan Clock with the Getting Started 
Analog Input Example VI

The NB-MIO-16X cannot support external scan clocks as the other
devices can. The device layout does not allow you to directly provid
an external scan clock. Instead, you can offer a timebase to the inte
counter, counter 5, that generates the scan clock. Do this by sendi
timebase into the source 5 pin and calling the Advanced VIs used by
AI Clock Config VI. In addition, you need to wire the alternate clock 
rate specifications as shown below into the AI Clock Config VI. 
Remember that the which clock input of the AI Clock Config VI should 
be set to scan clock (1) .

Note: You must divide the timebase by some number between 2 and 65535 or 
will get a bad input value error.
© National Instruments Corporation 9-7 LabVIEW Data Acquisition Basics Manual
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Because LabVIEW determines the length of time before AI Read tim
out based on the interchannel delay and scan clock rate, you may n
to force a time limit into AI Read. In Figure 9-6, the time limit is 
5 seconds.

Externally Controlling the Scan and Channel Clocks

You can control the scan and channel clocks simultaneously by 
combining the two previous sections. However, make sure that you
follow the proper timing. Figure 9-7 demonstrates how you can set 
your application to control both clocks.

Figure 9-7.  Controlling the Scan and Channel Clock Simultaneously
LabVIEW Data Acquisition Basics Manual 9-8 © National Instruments Corporation
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This section contains basic information on generating data with 
LabVIEW, including generating a single point or multiple points.

Section Three, Making Waves with Analog Output, contains the 
following chapters:

• Chapter 10, Things You Should Know about Analog Output, explains 
how to use LabVIEW to produce all of the different types of analo
output signals.

• Chapter 11, One-Stop Single-Point Generation, shows you which 
VIs to use in LabVIEW to perform single-point updates.

• Chapter 12, Buffering Your Way through Waveform Generation, 
shows you which VIs to use in LabVIEW to perform buffered 
analog updates.

• Chapter 13, Letting an Outside Source Control Your Update Rate, 
shows you which VIs to use in LabVIEW to control your update
rate with an external source.

• Chapter 14, Simultaneous Buffered Waveform Acquisition and 
Generation, describes how to perform buffered waveform 
acquisition and generation simultaneously on the same DAQ 
device.
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Some measuring systems require that analog signals be generated
data acquisition (DAQ) device. Each of these analog signals can be
steady or slowly changing voltage, or a continuously changing 
waveform. The next few sections show you how to use LabVIEW to
produce all of these different types of signals. First, you should lea
about the various situations in which you might need to produce an
analog signal.

Single-Point Output

When the voltage level at the output is more important than the rate
which the output voltage changes, you need to generate a steady D
voltage. You can use the single-point analog output VIs to produce 
type of output. With single-point analog output, any time you want t
change the voltage on an analog output channel, you must call one
the VIs that produces a single update (a single voltage change). 
Therefore, you can change the output voltage only as fast as LabVI
calls the VIs. This technique is called software timing. You should use 
software timing if you do not need high speed generation or very 
accurate timing. Refer to Chapter 11, One-Stop Single-Point Generation, 
for more information on single-point output.

Buffered Analog Output

Sometimes in performing analog output, the rate that your updates
occur is just as important as the voltage level. This is called waveform 
generation, or buffered analog output. For example, you might want 
your DAQ device to act as a function generator. You can do this by
storing one cycle of sine wave voltage data in an array, and 
programming the DAQ device to generate the voltages continuously
the array one point at a time at a specified rate. This is known as 
single-buffered waveform generation. But what if you want to generate
a continually changing waveform? For example, you might have a la
file stored on disk that contains data you want to output. Because 
LabVIEW cannot store the entire waveform in a single buffer, you mu
isition Basics Manual
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continually load new data into the buffer during the generation. Thi
process requires the use of circular-buffered analog output in 
LabVIEW. To learn more about single or circular buffering, read 
Chapter 12, Buffering Your Way through Waveform Generation.
LabVIEW Data Acquisition Basics Manual 10-2 © National Instruments Corporation
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In the preceding chapter, you learned the appropriate time to use 
single-point updates. This chapter shows you which VIs to use in 
LabVIEW to perform these updates.

Single-Immediate Updates

The most basic way to program single-point updates in LabVIEW is
using the Easy Analog Output VI, AO Update Channels. Figure 11-
shows a diagram of a VI that writes voltages to one or more output
Channels on the output data acquisition (DAQ) Device.

Figure 11-1.   Single Immediate Update Using the AO Update Channels VI

Notice that an array of voltages is passed as an input to the VI. The 
element in the array corresponds to the first entry in the channel str
and the second array element corresponds to the second channel e
For more information on channel string syntax, refer to Chapter 3, Basic 
LabVIEW Data Acquisition Concepts. Remember that Easy VIs already
have built-in error handling.

While Figure 11-1 shows how to write voltages for multiple channe
Figure 11-2 shows the diagram of the Generate 1 Point on 1 Channe
isition Basics Manual
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located in labview\examples\daq\anlogout\anlogout.llb , 
which generates one voltage for one channel.

Figure 11-2.  Single Immediate Update Using the AO Update Channel VI

If you want more control over the limit settings for each channel, yo
also can program a single-point update using the Intermediate Ana
Output VI, AO Write One Update. Figure 11-3 shows an example o
using this VI.

Figure 11-3.   Single Immediate Update Using Intermediate VI

In this example, your program passes the error information to the 
Simple Error Handler VI. The iteration  input optimizes the execution 
of this VI if you want to place it in a loop. For more information, loo
at the next section. With Intermediate VIs, you gain more control ov
when you can check for errors.
LabVIEW Data Acquisition Basics Manual 11-2 © National Instruments Corporation
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Multiple-Immediate Updates

Figure 11-4 shows the block diagram of a VI that performs multiple
updates. The Write N Updates example VI, located in 
labview\examples\daq\anlogout\anlogout.llb , is similar to 
Figure 11-4. The diagram shown in Figure 11-4 resembles the one 
shown in Figure 11-3, except that the While Loop executes the sub
repeatedly until either the error status or the stop Boolean is TRUE. Y
can use the Easy Analog Output VI, AO Write One Update, in a loo
but this is inefficient because the Easy I/O VIs configure the device
every time they execute. The AO Write One Update VI configures t
device only when the value of the iteration  input is set to 0.

Figure 11-4.  Multiple Immediate Updates Using Intermediate VI

Figure 11-4 shows an immediate, software-timed analog output VI 
application. This means that software timing in a loop controls the 
update rate. One good reason to use immediate, software-timed ou
is that your application calculates or processes output values one a
time; however, remember that software timing is not as accurate as
hardware-timed analog output. For more information on 
hardware-timed analog output, refer to Chapter 12, Buffering Your Way 
through Waveform Generation.
© National Instruments Corporation 11-3 LabVIEW Data Acquisition Basics Manual
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In Chapter 10, Things You Should Know about Analog Output, you 
learned when to use buffered analog updates. This chapter shows 
which VIs to use in LabVIEW to perform these updates.

Buffered Analog Output

You can program single-buffered analog output in LabVIEW using 
Easy Analog Output VI, AO Generate Waveforms VI, as shown in 
Figure 12-1. This VI writes an array of output voltages to the analo
output channels at a rate specified by the update rate parameter. For 
example, if channels is 0,1  and the voltages two-dimensional array 
consists of two columns containing voltage data for the two channe
LabVIEW writes voltages from each column to the corresponding 
channels at every update interval. After LabVIEW writes all of the 
voltages in the two-dimensional array to the channels, the VI stops. 
voltage level on the output channels maintains the value of the fina
voltage row in the two-dimensional array until another voltage value
generated. Easy VIs contain error handling. If an error occurs in the 
Generate Waveforms VI, a dialog box appears displaying the error 
number and description, and the VI stops running.

Figure 12-1.  Waveform Generation Using the AO Generate Waveforms VI
isition Basics Manual
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As with single-point analog output, you can use the Analog Output 
Utility VI, AO Waveform Gen VI, for most of your programming needs
This VI has several inputs and outputs that the Easy I/O VI does no
have. You have the option of having the voltage array generated on
several times, or continuously through the generation count input. 
Figure 12-2 shows an example diagram of how to program this VI. 

Figure 12-2.  Waveform Generation Using the AO Waveform Gen VI

In this example, LabVIEW generates the voltages in the array two tim
before stopping.

The Generate N Updates example VI, located in labview\examples\

daq\anlogout\anlogout.llb , uses the AO Waveform Gen VI. 
Placing this VI in a loop and wiring the iteration terminal of the loop 
the iteration input on the VI optimizes the execution of this VI. Whe
iteration is 0, LabVIEW configures the analog output channels 
appropriately. If iteration is greater than 0, LabVIEW uses the existi
configuration, which improves performance. With the AO Waveform
Gen VI, you also can specify the limit settings input for each analog 
output channel. For more information on limit settings, refer to 
Chapter 3, Basic LabVIEW Data Acquisition Concepts.
LabVIEW Data Acquisition Basics Manual 12-2 © National Instruments Corporation
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If you want even more control over your analog output application, u
the set of Intermediate DAQ VIs, as shown in Figure 12-3.

Figure 12-3.  Waveform Generation Using Intermediate VIs

With these VIs, you can set up an alternate update clock source (suc
an external clock or a clock signal coming from another device) or 
return the update rate. The AO Config VI sets up the channels you
specify for analog output. The AO Write VI places the data in the 
buffer, the AO Start VI begins the actual generation at the update rate, 
and the AO Wait VI waits until the waveform generation completes.
Then, the AO Clear VI unconfigures the analog channels.

The Generate Continuous Sinewave VI, located in 
labview\examples\daq\anlogout\anlogout.llb , is similar in 
structure to Figure 12-3. This example VI continually outputs a sine
waveform through the channel you specify.

Changing the Waveform during Generation: 
Circular-BufferedOutput

When the waveform data is too large to fit in a memory buffer or is 
constantly changing, use a circular buffer to output the data. You also 
can use the Easy Analog Output VIs in a loop to create a 
circular-buffered output; but this sacrifices efficiency because Easy V
configure, allocate, and deallocate a buffer every time they execute
When you spend time configuring, allocating, and deallocating a buff
there are time gaps between the data output. Figures 12-4 and 12-
show two different ways to perform circular-buffered analog output 
using the Intermediate VIs in LabVIEW. Figure 12-4 shows the AO 
Continuous Gen VI, which is more efficient than the Easy Analog 
Output VIs in that it configures and allocates a buffer when its iteration  
© National Instruments Corporation 12-3 LabVIEW Data Acquisition Basics Manual
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input is 0 and deallocates the buffer when the clear generation input 
is TRUE.

Figure 12-4.  Circular Buffered Waveform Generation Using the AO Continuous Gen VI

With the AO Continuous Gen VI, you can configure the size of the d
buffer and the limit settings of each channel. For more information on
how to set limit settings, refer to Chapter 3, Basic LabVIEW Data 
Acquisition Concepts.

The Continuous Generation example VI, located in 
labview\examples\daq\anlogout\anlogout.llb , uses the AO 
Continuous Gen VI. In this example, the data completely fills the buf
on the first iteration. On subsequent iterations, new data is written i
one half of the buffer while the other half continues to output data.

To gain more control over your analog output application, use the 
Intermediate VIs shown in Figure 12-5. With these VIs, you can set
an alternate update clock source and you can monitor the update rat
VI actually uses. The AO Config VI sets up the channels you specif
for analog output. The AO Write VI places the data in a buffer. The A
Start VI begins the actual generation at the update rate. The AO Write 
VI in the while loop writes new data to the buffer until you press the
stop button. Then, the AO Clear VI unconfigures the analog channe
LabVIEW Data Acquisition Basics Manual 12-4 © National Instruments Corporation
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Figure 12-5.  Circular Buffered Waveform Generation Using Intermediate VIs

The Function Generator VI, located in labview\examples\daq\

anlogout\anlogout.llb , is a more advanced example than the on
shown in Figure 12-5. This VI changes the output waveform on-the-f
responding to changing signal types (sine or square), amplitude, off
update rate, and phase settings on the front panel.

Eliminating Errors from Your Circular-Buffered 
Application

If you get error number –10843 underFlowErr, while performing 
circular-buffered output, it means your program can not write data f
enough to the buffer to output the data at the update rate. To solve
problem, decrease the speed of the update rate. If adjusting the up
rate does not get rid of the error in your application, increase the bu
size.

Buffered Analog Output Examples

You can find the example VIs mentioned in this chapter—Generate
Updates, Generate Continuous Sinewave, Continuous Generation,
Function Generator—in labview\examples\daq\anlogout\

anlogout.llb . Another example VI in this library you might find 
helpful, Display and Output Acq’d File (scaled) VI, is shown in 
Figure 12-6.
© National Instruments Corporation 12-5 LabVIEW Data Acquisition Basics Manual
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Figure 12-6.  Display and Output Acq�d File (scaled) VI

You can use this VI in conjunction with the Cont Acq to File 
(scaled) VI, located in labview\examples\daq\anlogin\

anolgin.llb . The Display and Output Acq’d File (scaled) VI also is
described in Chapter 7, Buffering Your Way through Waveform 
Generation. After running the Cont Acq to File (scaled) VI and savin
your acquired data to disk, you can run the Display and Output Acq
File (scaled) VI to generate your data from the file you created. Thi
example uses circular buffered output. If you want to generate the d
at the same rate at which it was acquired, you must know the rate a
which your data was acquired, and use that as the update rate.
LabVIEW Data Acquisition Basics Manual 12-6 © National Instruments Corporation
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Data acquisition (DAQ) devices use internal counters and timers to
determine the rate of data generation. However, you might encoun
times when you need to generate data in synch with other signals in y
system. For example, you might need to output data to a test circu
every time that test circuit emits a pulse. In this case, internal 
counter/timers are inefficient for your needs. You need to control th
update rate with your own external source of pulses.

Externally Controlling Your Update Clock

Chapter 12, Letting an Outside Source Control Your Update Rate, 
mentions that for more control over your analog output applications
you can use the Intermediate DAQ VIs. This chapter explains how 
use these Intermediate VIs to generate data using an external upda
clock. 

The update clock controls the rate at which digital to analog 
conversions occur. To control your data generation externally, you m
supply this clock signal to the appropriate pin on the I/O connector 
your DAQ device. The clock source you supply must be a TTL sign
Figure 13-1 shows the Generate N Updates-ExtUpdateClk VI, locat
in labview\examples\daq\anlogout\anlogout.llb , which 
applies this process.
isition Basics Manual
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Figure 13-1.  Generate N Updates-ExtUpdateClk VI

To use an external update clock, you must set the clock source of the 
AO Start VI to I/O connector . When you connect your external clock
you find that different DAQ devices use different pins for this input.
However, if you select Show VI Info… in the Windows menu of the 
example VI, you find that all the I/O connections are explained for yo
These input pins also are described in Table 13-1.

Table 13-1.  External Update Clock Input Pins

Device Input External Update Clock Pin

All E Series Devices 
with analog output

PFI5/UPDATE*

Non-E Series MIO type devices OUT2

Lab-PC+
1200 devices
AT-AO-6/10

EXTUPDATE*
LabVIEW Data Acquisition Basics Manual 13-2 © National Instruments Corporation
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For waveform generation, you must supply an array of waveform da
The example VI in Figure 13-1 uses data created in the Compute 
Waveform VI. When you run the example VI, the data is output on 
channel 0 (the DAC0OUT pin) of your DAQ device.

Supplying an External Test Clock from Your DAQ Device

Suppose you want to use this external update clock approach, but 
do not have your external clock available. You can create an extern
test clock using outputs from a counter/timer on your DAQ device, a
then wire the output to your external update clock source.

If your DAQ device has an FOUT or FREQ_OUT pin, you can genera
a 50% duty cycle TTL pulse train using the Generate Pulse Train o
FOUT or FREQ_OUT VI, located in labview\examples\daq\

counter\counter.llb . The advantage of this VI is that it does not us
one of the available counters, which you might need for other reaso

You also can use the How to Generate Pulses and Pulse Trains VI
(for MIO devices) or the How to Generate a Pulse Train (8253) VI 
(for Lab/1200 type devices). These VIs also are located in 
labview\examples\daq\counter\counter.llb .
© National Instruments Corporation 13-3 LabVIEW Data Acquisition Basics Manual
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In Chapter 7, Buffering Your Way through Waveform Acquisition, you 
learned how to acquire multiple data points via an intermediate softw
buffer. In Chapter 12, Buffering Your Way through Waveform 
Generation, you learned how to generate multiple points of data by fir
writing them to a software buffer. This chapter describes how to 
perform buffered waveform acquisition and generation simultaneou
on the same DAQ device.

Using E-Series MIO Boards

E-series devices, such as the PCI-MIO-16E-1, have separate coun
dedicated to analog input and analog output timing. For this reason
they are the easiest choice for simultaneous input/output.

Software Triggered
Figure 14-1 shows the diagram of the Simul AI/AO Buffered 
(E-series MIO) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .
isition Basics Manual
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Figure 14-1.  Simultaneous Input/Output using the Simul AI/AO 
Buffered (E-series MIO) VI

This example VI uses familiar Intermediate DAQ VIs. This example V
uses the same VIs you used for analog input in Chapter 7—AI Con
AI Start, AI Read, and AI Clear—for waveform acquisition here. Th
example VI also uses the same VIs you used for analog output in 
Chapter 12—AO Config, AO Write, AO Start, and AO Clear—for 
waveform generation here. By following the error  cluster wire, which 
enters each DAQ VI on the bottom left and exits on the bottom righ
you can see that because of data dependency, the waveform gener
starts before the waveform acquisition, and each task is configured
run continuously. This example VI is considered software triggered
because it starts via software when you push the Run button.

Once you call the AO Start and AI Start VIs, the While Loop execute
Inside the While Loop, the AI Read VI returns acquired data from th
analog input buffer. There is not a call to the AO Write VI inside the
While Loop because it is not needed if the same data from the first 
Write VI is regenerated continuously. If you want to generate new d
each time the While Loop iterates, you could add an AO Write VI insi
the While Loop. The While Loop stops when an error occurs or you
LabVIEW Data Acquisition Basics Manual 14-2 © National Instruments Corporation



Chapter 14 Simultaneous Buffered Waveform Acquisition and Generation

is 

r 

ition 

I0 

re 
press the Stop button. Your DAQ device resources are cleared by 
calling the AI Clear and AO Clear VIs after the loop stops.

For a complete description, instructions, and I/O connections for th
VI, select Windows»Show VI Info… from the front panel of the VI.

Hardware Triggered
Figure 14-2 shows the diagram of the Simul AI/AO Buffered Trigge
(E-series MIO) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .

Figure 14-2.  Simultaneous Input/Output using the Simul AI/AO Buffered 
Trigger (E-series MIO) VI

Although this VI is similar to the example in Figure 14-1, it is more 
advanced because it uses a hardware trigger. The waveform acquis
trigger is set up with the trigger type input to the AI Start VI set to 
digital A  (start), and by default this trigger is expected on the PF
pin. Hardware triggering for waveform generation requires an 
additional VI. The AO Trigger and Gate Config VI is an advanced 
analog output VI for E-series boards only. The trigger parameters a
© National Instruments Corporation 14-3 LabVIEW Data Acquisition Basics Manual
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set using three inputs. The trigger or gate source is used to choose the
source of your trigger, such as a PFI pin or a RTSI pin. The trigger or 
gate source specification is used in conjunction with the trigger or gate 
source to choose which PFI or RTSI pin number to use, such as 
0 through 9 for a PFI pin. The trigger or gate condition is used to select 
a rising or falling trigger edge. The default analog output trigger for th
example is a rising edge on PFI0. Because this is the same pin as 
analog input trigger, the waveform acquisition and generation starts
simultaneously. However, they are not controlled by independent 
counter/timers, so you can run them at different rates.

For a complete description, instructions, and I/O connections for th
VI, select Windows»Show VI Info… from the front panel of the VI.

Using Legacy MIO Boards

Legacy MIO devices, such as the AT-MIO-16, have a total of five 
counters, of which two or more can be used for data acquisition an
generation. However, certain counters are dedicated to certain task
and you must be aware of this as you design your system.

Software Triggered
Figure 14-3 shows the diagram of the Simul AI/AO Buffered (legacy
MIO) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .
LabVIEW Data Acquisition Basics Manual 14-4 © National Instruments Corporation
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Figure 14-3.  Simultaneous Input/Output using the Simul AI/AO 
Buffered (legacy MIO) VI

Because legacy MIO-type boards have only one clock available for
signal acquisition (scan timing) and generation (update timing), the
same clock is used for both. The acquisition uses counter 2  by default. 
The generation is set up to use the I/O connector at the clock source 
input to the AO Start VI. Because the I/O connector scan clock input is 
the OUT2 pin, which already has the acquisition timing signal on it, 
external clock wiring is required. The result is that the waveform 
acquisition and generation start simultaneously and occur at the sa
rate using the same clock. Your waveform generation occurs at the s
rate as the scan rate you choose for waveform acquisition.

For a complete description, instructions, and I/O connections for th
VI, select Windows»Show VI Info… from the front panel of the VI.
© National Instruments Corporation 14-5 LabVIEW Data Acquisition Basics Manual



Chapter 14 Simultaneous Buffered Waveform Acquisition and Generation

r 

 a 

the 

is 
Hardware Triggered
Figure 14-4 shows the diagram of the Simul AI/AO Buffered Trigge
(legacy MIO) VI located in labview\examples\daq\anlog_io\

anlog_io.llb .

Figure 14-4.  Simultaneous Input/Output using the Simul AI/AO Buffered 
Trigger (legacy MIO) VI

The only difference between this example VI and the example in 
Figure 14-3 is the trigger type input to the AI Start VI is set to 
digital A  (start) trigger. This sets up the waveform acquisition for
digital trigger. Because the waveform generation uses the same 
counter/timer as the waveform acquisition, it also is dependent on 
digital trigger.

For a complete description, instructions, and I/O connections for th
VI, select Windows»Show VI Info… from the front panel of the VI.
LabVIEW Data Acquisition Basics Manual 14-6 © National Instruments Corporation
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Using Lab/1200 Boards

Lab/1200 boards, such as the Lab-PC-1200 or the DAQCard-1200, 
can perform simultaneous waveform acquisition and generation. Th
approach is very similar to the previous descriptions. Refer to the 
examples Simul AI/AO Buffered (Lab/1200) VI and Simul AI/AO 
Buffered Trigger (Lab/1200) VI located in labview\examples\

daq\anlog_io\anlog_io.llb  to see how this acquisition and 
generation is performed.
© National Instruments Corporation 14-7 LabVIEW Data Acquisition Basics Manual
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This section describes basic concepts about how to use digital sign
with data acquisition in LabVIEW, including immediate and 
handshaked digital I/O.

Section Four, Getting Square with Digital I/O, contains the following 
chapters:

• Chapter 15, Things You Should Know about Digital I/O, explains 
basic concepts on digital I/O.

• Chapter 16, When You Need It Now—Immediate Digital I/O, explains 
how to use digital lines to acquire and generate data immediate

• Chapter 17, Shaking Hands with a Digital Partner, shows you how 
you can synchronize digital data transfers between your DAQ 
devices and instruments.
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Digital I/O interfaces often are used to control processes, generate
patterns for testing, and communicate with peripheral equipment lik
heaters, motors, and lights. Digital I/O components on DAQ device
and SCXI modules consist of hardware parts that generate or acce
binary on/off signals. As shown in the diagram below, all digital line
are grouped into ports on DAQ devices and banks on SCXI module
The number of digital lines per port or bank is specific to the particu
device or module used, but most ports or banks consist of four or e
lines. Except for the TIO-10 and E Series devices, all lines within th
same port or bank must all be of the same direction (either input or
output), as shown in Figure 15-1. By writing to or reading from a po
you can set or retrieve simultaneously the states of multiple digital 
lines. Refer to Appendix A, Hardware Capabilities, of the LabVIEW 
Function and VI Reference Manual, your hardware user manual, or refe
to the LabVIEW online help, by selecting Help»Online Reference…, 
for port information on your device.

Figure 15-1.  Digital Ports and Lines

Data latches
and drivers

Data latches
and drivers

Device or Module

Output Port

Input Port

Output Lines

Input Lines
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Types of Digital Acquisition/Generation

There are two types of digital acquisition/generation—nonlatched (or 
immediate) and latched (or handshaked). With nonlatched or immediate 
digital I/O, your system updates the digital lines immediately. Latch
or handshaked digital I/O is when a device or module accepts or 
transfers data after a digital pulse has been received. There are tw
types of latched (handshaked) digital I/O: non-buffered and buffere
Not all the devices and modules support latched (handshaked) digi
I/O. Again, refer to the hardware tables in Appendix A, Hardware 
Capabilities, of the LabVIEW Function and VI Reference Manual, your 
hardware manual, or refer to the LabVIEW online help, by selecting
Help»Online Reference…, to see if your device or module supports i

For specific information about the Digital I/O VIs, refer to Chapter 1
Introduction to the LabVIEW Data Acquisition VIs, in the LabVIEW 
Function and VI Reference Manual, or refer to the LabVIEW online help, 
by selecting Help»Online Reference….
LabVIEW Data Acquisition Basics Manual 15-2 © National Instruments Corporation
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This chapter focuses on transferring data across a single port. The m
common way to use digital lines is with nonlatched (immediate) digi
I/O. All DAQ devices and SCXI modules with digital components 
support this mode. 

When your program calls a function in nonlatched digital I/O mode,
LabVIEW immediately updates the digital line or port output state o
returns the current digital value of an input line, depending on the 
digital line direction. LabVIEW inputs or outputs only one value on 
each digital line in this mode. You can completely configure port (a
sometimes line) direction in software, and you can switch direction
repeatedly in a program if necessary. 

A typical example of when you might use nonlatched (immediate) 
digital I/O is in controlling or monitoring relays. You can also use 
multiple ports or groups of ports to perform digital I/O functions, 
especially if you only have four lines in a port and need to transfer 
byte at a time. In order to group digital ports, you must use Intermed
or Advanced VIs in LabVIEW. You can read more about grouping 
multiple digital ports in the next chapter, Chapter 17, Shaking Hands 
with a Digital Partner.

You can use the Easy Digital VIs for nonlatched digital I/O. Figure 16
shows the Easy VIs and their various inputs and outputs. The four E
VIs can read data from or write data to a single digital line or to an en
port immediately. For an example of how to use the Easy Digital VI
refer to the Read 1 Point from Digital Line and Write 1 Point to Digit
Line VIs in labview\examples\daq\run_me.llb . Use the Easy 
isition Basics Manual
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Digital VIs for most digital testing purposes. All of the Easy Digital VI
have error reporting. 

Figure 16-1.  The Easy Digital VIs

The device input identifies the DAQ device you are using. The port 
number input specifies the port of digital lines that you will use durin
the digital operation. The line parameter is an individual port bit or line
in the port number . The pattern or line state is the value(s) you want 
to read from or write to a device. Pattern values can be displayed i
decimal (default), hexadecimal, octal, or binary form. Refer to 
Chapter 10, Numeric Controls and Indicators, in your LabVIEW User 
Manual for instructions on how to change the display of a numeric 
control or indicator. The iteration  input optimizes your digital 
operation. When iteration  is zero (the default value), LabVIEW calls 
the DIO Port Config VI (an Intermediate VI) to configure the port. If
iteration  is greater than zero, LabVIEW uses the existing configuratio
which improves performance. You can wire this input to an iteration
terminal of a loop. Every time iteration  is zero, you call the DIO Port 
Config VI, which resets the digital line values to their default values.
you want to use the same digital values from one loop iteration to 
another, only set iteration  to zero for the first iteration of the loop, then
change it to a value greater than zero.

Read from Digital Line VI Write to Digital Line VI

Read from Digital Port VI Write to Digital Port VI
LabVIEW Data Acquisition Basics Manual 16-2 © National Instruments Corporation
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If you are using an SCXI module for nonlatched digital I/O, refer to t
SCXI Channel Addressing section in Chapter 20, Special Programming 
Considerations for SCXI, of this manual for instructions on how to 
specify port numbers.
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You have just learned that in LabVIEW using non-latched (immedia
digital I/O, you can use digital lines to acquire and generate data. B
what if you want to pass a digital pattern after receiving a digital puls
In this case, you should use latched digital I/O, also called 
handshaking. For example, you want to acquire an image from a 
scanner. The scanner sends a pulse to your DAQ device after the im
has been scanned and it is ready to transfer the data. Then, your D
device reads a digital pattern, which can be 8, 16, or 32 bits in leng
The scanner sends out another pulse when it is ready to send anot
digital pattern. After your DAQ device receives this digital pulse, it 
reads the data. This process repeats until all the data is transferred
you can see, the ability to handshake gives you the ability to 
synchronize digital data transfer between your DAQ device and 
instrument.

The following list shows the DAQ devices that support digital 
handshaking.

• AT-MIO-16D

• AT-MIO-16DE-10

• 1200 Series devices

• DIO-24 (DAQCard, NB, and PC, including PnP)

• DIO-32F (NB and AT)

• DIO-32HS (AT and PCI)

• DIO-96 (PCI, NB, PCI, and PC, including PnP)

• Lab Series devices (NB, LC, and PC)

Another example of when you can use handshaking might be if you
wanted to test the durability of a product prototype. Each durability t
would be performed with a different piece of machinery for the sam
amount of time. For each test, you can turn the machinery on and of
with a specific variation of handshaked digital I/O, known as pattern 
generation. Internal counters would serve to generate the handshak
signal that initiates a digital transfer. Counters output digital pulses a
steady frequency. Thus, you can generate and retrieve patterns at 
isition Basics Manual
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constant rate because the handshaking signal would be produced a
constant rate. However, you can use this rate only if the instrumen
external hardware does not work with or require communication sign
for its data transfers. Only the DIO-32 Series devices support patte
generation.

If you have an external signal controlling your digital I/O operation,
you should connect the outside signal to the I/O connector or the R
connector. For more information on these connectors, refer to your
hardware manual for your device. The names and functions of 
handshaking signals vary. For the DIO-32 Series devices, there are
handshaking lines—the REQ (request) line and the ACK 
(acknowledge) line. Use the REQ line as the handshaking line to trig
digital input. You can use the ACK line as the handshaking line to 
trigger digital output. 

For all other 8255-based DAQ devices that perform handshaking, th
are four handshaking signals: Strobe Input (STB), Input Buffer Full 
(IBF), Output Buffer Full (OBF), and Acknowledge Input (ACK). You
use the STB and IBF signals for digital input operations and the OB
and ACK signals for digital output operations. When the STB line is
low, LabVIEW loads data into the DAQ device. After the data has be
loaded, IBF is high, which tells the external device that the data ha
been read. For digital output, OBF is low while LabVIEW sends the
data to an external device. After the external device receives the da
sends a low pulse back on the ACK line. Check your DAQ device 
hardware manual for information on which digital port(s) can be 
configured for handshaking signals.

For all the DAQ devices that support handshaking, there are separ
handshaking lines for each digital port.

Sending Out Multiple Digital Values

You can group multiple ports together so you can send more digita
values out at a time. The order of grouped ports affects which 
handshaking lines you use. If you want to group ports 0 and 1 and 
list the ports in the order of 0:1 , then you should use the handshakin
lines associated with port 1. In other words, always use the handsha
lines associated with the last port in the list. So, if the ports are liste
1:0 , then you should use the handshaking lines associated with po
LabVIEW Data Acquisition Basics Manual 17-2 © National Instruments Corporation
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For 8255-based devices that perform handshaking, you must conne
the STB lines together if you are using more than one port or group
ports for digital input, as shown in Figure 17-1. Connect only the IB
line of the last port in the port list to the other device. No connection
needed for the IBF signals for the other ports in the port list. 

Figure 17-1.  Connecting Signal Lines for Digital Input

If you are using more than one port or grouping ports for digital outp
on DAQ devices other than the DIO-32 Series devices, connect only
handshaking signals of the last port in the port list, as shown in the
Figure 17-2.

Port x 1

STB*

IBF

External Device

(last port in portList)

Port x n

STB*

IBF

Port x 2

STB*

IBF
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Figure 17-2.  Connecting Digital Signal Lines for Digital Output

There are two types of digital handshaking: non-buffered and buffer
Non-buffered handshaking is similar to nonlatched digital I/O becau
LabVIEW updates the digital lines immediately after every digital or
handshaked pulse.

Note: For the DIO-32HS devices, LabVIEW returns immediately after storing 
data in its FIFO.

With buffered handshaking, LabVIEW stores digital values in memo
to be transferred after every handshaked pulse. Both non-buffered 
buffered handshaking transfer only one digital value after each 
handshaked pulse. For basic digital applications, use non-buffered
handshaking. Use buffered handshaking when your application requ
multiple handshaking pulses to be created. By using a buffer with 
multiple handshaking pulses, the software spends less time readin
writing data, leaving more time for other operations.   

Note: On the DIO-32 Series devices with non-buffered handshaking, you can 
group 1, 2, or 4 ports together. For buffered handshaking on the DIO-32
Series devices, you can group only 2 or 4 ports together.

Port x 1

ACK*

External Device

(last port in portList)

Port x n

Port x 2

ACK*

ACK*

OBF*

OBF*

OBF*
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You can use only Intermediate or Advanced Digital VIs for digital 
handshaking in LabVIEW. The Intermediate VIs work for most all 
non-buffered and buffered digital handshaking applications. Howev
for some DAQ devices, you may need to use a combination of 
Intermediate and Advanced VIs.

Non-Buffered Handshaking

Non-buffered handshaking takes place when your program transfer
one digital value after receiving a digital pulse on the handshaking 
lines. LabVIEW does not store these digital values in computer 
memory. You should only use non-buffered handshaking when you
expect only a few digital handshaking pulses. For multiple-pulsed 
applications, you should use buffered handshaking, which you can le
about in the next section of this chapter, Buffered Handshaking. 
Figure 17-3 shows an example of non-buffered handshaking using 
Intermediate VI, DIO Single Read/Write. In this example, LabVIEW
reads the data from the digital port(s).

Figure 17-3.  Non-buffered Handshaking Using the DIO Single Read/Write VI

Typically, you want to put the DIO Single Read/Write VI inside a loo
You can use the iteration  input (the terminal where the loop iteration is
connected) to optimize your digital operation. When iteration  is 0 
(default), LabVIEW calls the Advanced VI, DIO Group Config, to 
configure the port(s). If iteration  is greater than zero, LabVIEW uses 
the existing configuration, which improves performance. Every time
your program calls the DIO Group Config VI, the digital line values a
reset to their default values. If you want to set the digital line value
once and keep the same values from one loop iteration to the next,
© National Instruments Corporation 17-5 LabVIEW Data Acquisition Basics Manual
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iteration  to 0 on the first iteration of the loop, then set iteration  to 1. 
When group direction is equal to 1 (default), all the ports listed in port 
list are treated as inputs. The number of elements in the data read 
parameter will be the same as the product of the number of ports in
group and the number to read parameter. 

Figure 17-4 shows how you can use non-buffered handshaking to w
data. The programming flow resembles the read operation above. T
updates to write array must contain as many elements as the numbe
ports multiplied by the number of values to write. 

Figure 17-4.  Non-buffered Handshaking Using the DIO Single Read/Write VI

Buffered Handshaking

Buffered handshaking allows you to store multiple points in comput
memory. Use this technique if multiple pulses are expected on the 
handshaking lines. Buffered handshaking comes in two forms: simp
and circular. You can use simple-buffered handshaking on all DAQ
devices that support handshaking; but you can perform 
circular-buffered handshaking only on the AT-DIO-32F and DIO-32H
devices. You can think of a simple buffer as a storage place in comp
memory, where buffer size equals the number of updates multiplied b
the number of ports. A circular buffer differs from a simple buffer on
in the way your program places the data into it and retrieves data fr
it. A circular buffer fills with data the same as a simple buffer, but wh
it gets to the end of the buffer LabVIEW returns to the beginning of t
buffer and fills up the same buffer again. You should use 
LabVIEW Data Acquisition Basics Manual 17-6 © National Instruments Corporation
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simple-buffered handshaking when you have a predetermined num
of values to acquire or generate. Use circular-buffered handshaking
when you want to acquire or generate data continuously.

Simple Buffered Examples
The block diagram in Figure 17-5 uses the Intermediate VIs to perfo
pattern generation using the DIO-32 Series devices. An example V
included with LabVIEW similar to the diagram below is the Digital 
Buffered Handshaking VI, found in labview\examples\daq\

digital\digio.llb . Notice the port list contains more than one port
number, which means the ports are grouped together. 

Figure 17-5.  Pattern Generation Using the DIO-32 Series Devices

The For Loop generates the digital data to output. The amount of d
generated equals the number of ports in the port list  multiplied by the 
number of updates. The direction input specifies whether the ports are
configured for input or output. The DIO Wait VI waits until the digita
buffered input or output operation completes before returning to the
main VI. The DIO Clear VI halts any transfers and clears the group p
configuration. If you want an external source to supply the handshak
signals, you can specify the handshake source to be an external signal 
entering through the I/O connector (handshake source=2 which is the 
default value) or the RTSI connector (handshake source=3). You only 
need to use the clock frequency if you are performing pattern generation
(having an internal handshake source).
© National Instruments Corporation 17-7 LabVIEW Data Acquisition Basics Manual



Chapter 17 Shaking Hands with a Digital Partner

e a 
ce 

e 
al 

al 

g 
ing. 
 the 
For DAQ devices other than the DIO-32 Series devices, you can us
VI similar to the one above to output digital data. The main differen
is that you use an Advanced Digital VI, like DIO Buffer Control, 
instead of the DIO Start VI, as shown in Figure 17-6. You should us
the DIO Buffer Control VI is because the DIO Start VI contains Digit
Clock Config and Digital Mode Config, VIs that work only with the 
DIO-32 Series devices. You do not need to use the Handshake source 
and clock frequency inputs, because of the external handshaking sign
source.

Figure 17-6.  Pattern Generation Using DAQ Devices (Other 
Than DIO-32 Series Devices)

Reading information is similar to writing data when using digital 
handshaking. In the example shown in Figure 17-7, the VI is readin
data into the DIO-32 Series devices while using external handshak
For the DIO-32 Series devices, the DIO Config VI can set or change
handshaking mode, for instance whether you trigger digital 
communication on an edge or at a certain level.
LabVIEW Data Acquisition Basics Manual 17-8 © National Instruments Corporation
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Figure 17-7.  Reading Data with the Digital VIs Using Digital Handshaking 
(DIO-32 Series Devices)

For the other devices that support digital handshaking, the example
would be the same as above except the handshaking mode input would 
be deleted from the DIO Config VI and the DIO Start VI would be 
replaced with the DIO Buffer Control VI. Also, you do not need the 
handshake source and clock frequency inputs for most devices, because
of the external handshaking signal source. Figure 17-8 shows the V
used for all DAQ devices other than the DIO-32 Series.

Figure 17-8.  Reading Data with the Digital VIs Using Digital Handshaking

Circular-Buffered Examples
Circular-buffered handshaking is similar to simple-buffered 
handshaking in that both types of handshaking place data in a buff
however, a circular buffer application returns to the beginning of th
buffer when it reaches the end, and fills the same buffer again. 

Note: Remember that circular-buffered handshaking works only on the 
AT-DIO-32F and DIO-32HS devices. 
© National Instruments Corporation 17-9 LabVIEW Data Acquisition Basics Manual
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Figure 17-9 shows an example of a circular-buffered application. In t
example, you are reading or writing digital values continually until yo
stop the VI or an error occurs. In order to create a circular buffer, y
must create a buffer that is at least twice as large as the number of
scans/updates you want to read at a time. You can have an interna
external handshake source. If your handshake source is internal, 
remember to specify the rate at which you read values with the clock 
frequency. Scan backlog specifies how many values are left in the 
buffer after you read. The number read parameter indicates the total 
number of values that have been read from the buffer because the
started executing. 

Figure 17-9.  Digital Handshaking Using a Circular Buffer

Digital handshaking, whether non-buffered or buffered, inputs or 
outputs digital patterns only after your computer receives a digital 
pulse. Not all DAQ devices support digital handshaking. The DIO-3
Series devices have internal as well as external handshaking signals
support circular-buffered I/O. Other DAQ devices that support 
handshaking accept only external handshaking signals. You should
digital handshaking when you need to generate or retrieve a digital
pattern after a digital event, or pulse, is detected. 
LabVIEW Data Acquisition Basics Manual 17-10 © National Instruments Corporation
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This section contains basic information on setting up and using SC
modules with your data acquisition application, special programmin
considerations, common SCXI applications, and calibration 
information.

Section Five, SCXI—Getting Your Signals in Great Condition, contains 
the following chapters:

• Chapter 18, Things You Should Know about SCXI, includes basic 
concepts on how to use SCXI modules with LabVIEW for data 
acquisition.

• Chapter 19, Hardware and Software Setup for Your SCXI System, 
explains how to set up your SCXI hardware to work with data 
acquisition in LabVIEW.

• Chapter 20, Special Programming Considerations for SCXI, 
describes special programming considerations for SCXI in 
LabVIEW which include channel addressing, gains (limit settings
and settling time.

• Chapter 21, Common SCXI Applications, cover example VIs for 
analog input, analog output, and digital SCXI module.

• Chapter 22, SCXI Calibration—Increasing Signal Measurement 
Precision, teaches you how to calibrate SCXI modules and show
you where LabVIEW stores your calibration constants.
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Signal Conditioning eXtensions for Instrumentation (SCXI) is a 
highly-expandable signal conditioning system. The next few chapte
describe the basic concepts of signal conditioning, the setup proced
for SCXI hardware, the hardware operating modes, the procedure f
software installation and configuration, the special programming 
considerations for SCXI in LabVIEW, and some common SCXI 
applications. 

What is Signal Conditioning?

Electrical signals can be generated by transducers to measure phy
phenomena, such as temperature, force, sound, or light. Table 18-1
some common transducers. 

Table 18-1.  Phenomena and Transducers

Phenomena Transducer

Temperature Thermocouples
Resistance temperature detectors (RTDs)
Thermistors
Integrated circuit sensor

Light Vacuum tube photosensors
Photoconductive cells

Sound Microphone

Force and pressure Strain gauges
Piezoelectric transducers
Load cells

Position 
(displacement)

Potentiometers
Linear voltage differential transformer 
(LVDT)
Optical encoder
isition Basics Manual
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In order to measure signals from transducers, you must convert the
into a form that a data acquisition (DAQ) device can accept. For 
example, the output voltage of most thermocouples is very small an
susceptible to noise. Therefore, you may need to amplify and/or filt
the thermocouple output before digitizing it. The manipulation of 
signals to prepare them for digitizing is called signal conditioning. The 
following are some common types of signal conditioning.

• Amplification

• Isolation

• Filtering

• Transducer excitation

• Linearization

Figure 18-1 shows some common types of transducers/signals and
required signal conditioning for each.

Fluid flow Head meters
Rotational flowmeters
Ultrasonic flowmeters

pH pH electrodes

Table 18-1.  Phenomena and Transducers (Continued)

Phenomena Transducer
LabVIEW Data Acquisition Basics Manual 18-2 © National Instruments Corporation
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Figure 18-1.  Common Types of Transducers/Signals and Signal Conditioning

Amplification

The most common type of signal conditioning is amplification. The two 
advantages to amplifying electrical signals are that it improves the 
accuracy of the resulting digitized signal and that it reduces noise.

For the highest possible accuracy, the signal should be amplified so
the maximum voltage swing equals the maximum input range of the
analog-to-digital converter (ADC) (otherwise known as a digitizer). 
Your system should amplify low-level signals at the DAQ device or 
the SCXI module located nearest to the signal source, as shown in
Figure 18-2.
© National Instruments Corporation 18-3 LabVIEW Data Acquisition Basics Manual
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Figure 18-2.  Amplifying Signals Near the Source to Increase Signal-to-Noise Ratio

Note: You can minimize noise that lead wires pick up by using shielded cables
a twisted pair of cables, and by minimizing wire length. Also, keeping 
signal wires away from AC power cables and monitors will help reduce 
50 Hz or 60 Hz noise. 

If you amplify the signal at the DAQ device, the signal is measured a
digitized with noise that may have entered the lead wires. However
you amplify the signal close to the signal source with an SCXI modu
noise has a less destructive effect on the signal. In other words, th
digitized representation is a better reflection of the original low-leve
signal. For more information, consult Application Note 025, Field Wiring 
and Noise Considerations for Analog Signals. You can access this note on
the NI Fax-on-Demand system as well as the BBS, World Wide We
or FTP site, the numbers for which are located in the front of this 
manual. 

Isolation

Another common way to use SCXI is to isolate the transducer sign
from the computer for safety purposes. When the signal being 
monitored contains large voltage spikes that could damage the 
computer or harm the operator, you should not directly connect the
signal to a DAQ device without some type of isolation. Another reas
for isolation is to make sure that the measurements from the DAQ 
device are not affected by differences in ground potentials. When t
DAQ device and the signal are not referenced to the same ground 
potential, a ground loop may occur. Ground loops can cause an 
inaccurate representation of the measured signal. If the potential 
difference between the signal ground and the DAQ device ground i
large, then damage may even occur to the measuring system. Usin

+
- ADC

DAQ Board

Instrumentaion
Amplifier

MUX

Low-Level Signal
External
Amplifier

Lead Wires

Noise
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isolated SCXI modules will eliminate the ground loop and ensure th
the signals are accurately measured. 

Filtering

Signal conditioning systems can filter unwanted signals or noise fro
the signal you are trying to measure. You can use a noise filter on 
low-rate (or slowly-changing) signals, like temperature, to eliminate
higher-frequency signals that can reduce the accuracy of the digitiz
signal. A common use of a filter is to eliminate the noise from a 60 
AC power line. A lowpass filter of 4 Hz, which exists on several SCX
modules, is suitable for removing the 60 Hz AC noise from signals 
sampled at low rates. A lowpass filter eliminates all signal frequenc
components above the cutoff frequency. The SCXI-1141 module ha
lowpass filters that have software-selectable cutoff frequencies from
Hz to 25 kHz. 

Transducer Excitation

Signal conditioning systems can generate excitation for some 
transducers. Strain gauges and RTDs require external voltage and
currents, respectively, to excite their circuitry into measuring physic
phenomena. This type of excitation is similar to a radio which need
power to receive and decode audio signals. Some plug-in DAQ devi
and SCXI modules, including the SCXI-1121 and SCXI-1122 module
provide the necessary excitation for transducers.

Linearization

Many transducers, such as thermocouples, have a nonlinear respon
changes in the physical phenomena being measured. LabVIEW ca
linearize the voltage levels from transducers, so the voltages can b
scaled to the measured phenomena. LabVIEW provides simple sca
functions to convert voltages from strain gauges, RTDs, thermocoup
and thermistors. 

For specific information about the VIs you can use with your SCXI 
module in LabVIEW, refer to Chapter 28, Calibration and 
Configuration VIs, in the LabVIEW Function and VI Reference Manual, or 
refer to the LabVIEW online help, by selecting Help»Online 
Reference….
© National Instruments Corporation 18-5 LabVIEW Data Acquisition Basics Manual



© National Instruments Corporation 19-1 LabVIEW Data Acqu
Chapter

19
Hardware and Software 
Setup for Your SCXI System
rce 
 

l 

ed 
cted 
r’s 
00 

end 
SCXI hardware provides signal conditioning close to the signal sou
and increases the number of analog and digital signals that can be
analyzed by a data acquisition (DAQ) device. With PC compatible 
computers, SCXI can be configured in two ways—a front-end signa
conditioning system for plug-in DAQ devices or an external data 
acquisition and control system. Furthermore, when SCXI is configur
as an external data acquisition and control system, it can be conne
to the computer’s parallel port using an SCXI-1200, or the compute
serial port using either an SCXI-2000 remote chassis or an SCXI-24
remote communications module in an SCXI-100x chassis. For 
Macintosh computers, SCXI hardware can only be used as a front-
signal conditioning system for plug-in DAQ devices. Figure 19-1 
demonstrates these configurations.
isition Basics Manual
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Figure 19-1.  SCXI System

Figure 19-2 shows the components of an SCXI system. An SCXI 
system consists of an SCXI chassis that houses signal conditioning
modules, terminal blocks that plug directly into the front of the 
modules, and a cable assembly that connects the SCXI system to a
plug-in DAQ device or the parallel or serial port of a computer. If yo
are using SCXI as an external DAQ system where there are no plu
DAQ devices, you can use the SCXI-1200 module, which is a 
multifunction analog, digital, and timing I/O (counters) module. The
SCXI-1200 can control several SCXI signal conditioning modules 
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installed in the same chassis. The functionality of the SCXI-1200 
module is similar to the plug-in 1200 series devices.

Figure 19-2.  Components of an SCXI System

Refer to the SCXI tables in Appendix A, Hardware Capabilities, of the 
LabVIEW Function and VI Reference Manual, for tables containing 
specifications for all the SCXI modules, or refer to the LabVIEW onlin
help, by selecting Help»Online Reference…. This appendix also 
includes a list of all the SCXI modules and the compatible terminal
blocks.

How do you connect the transducers to the SCXI modules? How do 
set the jumpers on the SCXI modules before they are placed in the
chassis? For information on how to set up each module and transdu
consult your hardware user manuals and the Getting Started with SCXI 
manual. 

How do you transfer data from the SCXI chassis to the DAQ device
parallel or serial port? Figure 19-3 shows a diagram of an SCXI chas
When you use SCXI as a front-end signal conditioning system, the
analog and digital bus backplane, also known as the SCXIbus, trans
analog and/or digital data to the DAQ device. Some of the analog a
digital lines on the DAQ device are reserved for SCXI chassis 
communication. To find out which lines are reserved on your device
refer to the tables in Appendix A, Hardware Capabilities, in the 
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LabVIEW Function and VI Reference Manual, or refer to the LabVIEW 
online help, by selecting Help»Online Reference….

Figure 19-3.  SCXI Chassis

When you use SCXI as an external DAQ system, only some of the 
digital I/O lines of the DAQ device are reserved for SCXI chassis 
communication, when other modules are present. The DAQ device
digitizes any analog input data and transfers it back to the compute
through the parallel or serial port.

Note: When using Remote SCXI, be aware of the sampling rate limitations due 
the fact that the data is sent over the serial port. To reduce delays in ser
port communication, National Instruments recommends that you use the
fastest baud rate possible for your computer’s serial port. If you have a 
16550 or compatible universal asynchronous receiver-transceiver (UART
you can use baud rates up to 57,600 baud. If you have an 8250 or 
compatible UART, you can only use up to 19,200 baud.

SCXI-1000

SCXI
MAINFRAME

Unconditioned Signals
from Transducers

Analog and Digital
Bus Backplane

Conditioned Signals to
DAQ Board or 
Parallel Port
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SCXI Operating Modes

The SCXI operating mode determines the way that DAQ devices acc
signals. There are two basic operating modes for SCXI modules—
multiplexed and parallel. You designate the mode in the operating 
mode parameter in the configuration utility. Also, you may have to s
up jumpers on the module for the correct operating mode. Check y
SCXI module user manual for more information.

Note: National Instruments recommends that you use the multiplexed mode fo
most purposes.

Multiplexed Mode for Analog Input Modules
When an analog input module operates in multiplexed mode, all of 
input channels are multiplexed to one module output. When you ca
a DAQ device to a multiplexed analog input module, the DAQ devic
has access to that module's multiplexed output, as well as all other
modules in the chassis through the SCXIbus. The analog input VIs ro
the multiplexed analog signals on the SCXIbus for you transparent
So, if you operate all modules in the chassis in multiplexed mode, y
only need to cable one of the modules directly to the DAQ device.

Note: MIO/AI devices, and Lab-PC+ and 1200 devices support multiple-chann
and multiple-scan acquisitions in multiplexed mode. The Lab-NB and 
Lab-LC, LPM devices, and DAQCard-700 support only single-channel o
single-scan acquisitions in multiplexed mode. 

When you cable a DAQ device to a multiplexed module, the 
multiplexed output of the module (and all other multiplexed modules
the chassis) appears at analog input channel 0 of the DAQ device 
default. 

(Windows) Multiplexed Mode for the SCXI-1200
In multiplexed mode, the SCXI-1200 can access the analog signals on
the SCXI bus. The DAQ VIs can multiplex the channels of analog inp
modules and send them on the SCXI bus.This means that if you 
configure the SCXI-1200 for multiplexed mode, you can read the 
multiplexed output from other SCXI analog input modules in the 
chassis.

Note: The SCXI-1200 only reads analog input module channels configured in 
multiplexed mode, not in parallel mode.
© National Instruments Corporation 19-5 LabVIEW Data Acquisition Basics Manual
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Make sure that you change the jumper in the SCXI-1200 to the grou
position to connect the SCXI-1200 and SCXIbus grounds together.
Refer to the SCXI-1200 User Manual for more details.

Multiplexed Mode for Analog Output Modules
Because LabVIEW communicates with the multiplexed modules ov
the SCXIbus backplane, you must only cable one multiplexed modu
in each chassis to a DAQ device to communicate with any multiplex
modules in the chassis.

Multiplexed Mode for Digital and Relay Modules
Multiplexed mode is referred to as serial mode in the digital and relay 
module hardware manuals. When you operate your digital or relay 
module in multiplexed mode, LabVIEW communicates the module 
channel states serially over the SCXIbus backplane. 

Parallel Mode for Analog Input Modules
When an analog input module operates in parallel mode, the modu
sends each of its channels directly to a separate analog input chann
the DAQ device cabled to the module. You cannot multiplex parallel 
outputs of a module on the SCXIbus. You must cable a DAQ devic
directly to a module in parallel mode to access its input channels. In 
configuration, the number of channels available on the DAQ device
limits the total number of analog input channels. In some cases, 
however, you can cable more than one DAQ device to separate mod
in an SCXI chassis. For example, you can use two NB-MIO-16X or
AT-MIO-16E-2 devices operating in parallel mode and cable each o
to a separate SCXI-1120 module in the chassis. For more informat
on how to configure the cabled device, refer to the NI-DAQ 
Configuration Utility Online Help file in Windows, or the Installing and 
Configuring Your SCXI Chassis section in Chapter 2, Installing and 
Configuring Your Data Acquisition Hardware for the Macintosh.

By default, when a module operates in parallel mode, the module se
its channel 0 output to differential analog input channel 0 of the DA
device, the channel 1 output to analog input channel 1 of the DAQ 
device, and so on. 

Note: The SCXI-1200 only reads channels from another analog input module i
multiplexed mode, not in parallel mode. 
LabVIEW Data Acquisition Basics Manual 19-6 © National Instruments Corporation
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When you use the analog input VIs, specify the correct onboard chan
for each parallel SCXI channel. If you are using a range of SCXI 
channels, LabVIEW assumes the onboard channel numbers match
SCXI channel numbers. Refer to the SCXI Channel Addressing section 
in Chapter 20, Special Programming Considerations for SCXI, for the 
proper SCXI channel syntax.

(Windows) Parallel Mode for the SCXI-1200
In parallel mode, the SCXI-1200 reads only its own analog input 
channels. The SCXI-1200 does not have access to the analog bus o
SCXI backplane in parallel mode. You should use parallel mode if y
are not using other SCXI analog input modules in the chassis with 
SCXI-1200. 

Parallel Mode for Digital Modules
When you operate a digital module in parallel mode, the digital lines
your DAQ device directly drive the individual digital channels on you
SCXI module. You must cable a DAQ device directly to every modu
operated in parallel mode. 

You may want to use parallel mode instead of multiplexed mode fo
faster updating or reading of the SCXI digital channels. For the fast
performance in parallel mode, you can use the appropriate onboard 
numbers instead of the SCXI channel string syntax in the digital VI
Refer to the hardware tables in Appendix A, Hardware Capabilities, in 
the LabVIEW Function and VI Reference Manual for the digital ports 
used in parallel mode on each DAQ device, or refer to the LabVIEW
online help, by selecting Help»Online Reference….

Note: If you are using a DIO-96, an AT-MIO-16D, or an AT-MIO-16DE-10 
device, you can also operate a digital module in parallel mode using the
digital ports on the second half of the NB5 or R1005050 ribbon cable 
(lines 51-100). Therefore, the DIO-96 can operate two digital modules in
parallel mode, one module using the first half of the ribbon cable (lines 
1-50), and another module using the second half of the ribbon cable (line
51-100). 
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SCXI Software Installation and Configuration

After you assemble your SCXI system, you must run the configurati
utility to enter your SCXI configuration. LabVIEW needs the 
configuration information to program your SCXI system correctly. 
Refer to Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware.
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When you want LabVIEW to acquire data from SCXI analog input 
channels, you use the analog input VIs in the same way that you acq
data from onboard channels. You also read and write to your SCXI
relays and digital channels using the digital VIs in the same way th
you read and write to onboard digital channels. You can write voltag
to your SCXI analog output channels using the analog output VIs. T
following sections describe special programming considerations for
SCXI in LabVIEW which include channel addressing, gains (limit 
settings), and settling time. 

Note: (Windows) This chapter does not apply if you use the DAQ Channel Wizar
to configure your analog input channels. If you use the DAQ Channel 
Wizard, you address SCXI channels the same way you address on-boa
channels—by specifying the channel name(s). LabVIEW configures you
hardware to measure your channel properly by selecting the best input 
limits and gain for the named channel based on the channel configuration
For more information about using the DAQ Channel Wizard to configure
your channels, refer to the Configuring Your Channels in Windows section 
of Chapter 2, Installing and Configuring Your Data Acquisition Hardware. 
For more information about using channel names, refer to the (Windows) 
Channel Name Addressing section of Chapter 3, Basic LabVIEW Data 
Acquisition Concepts.

SCXI Channel Addressing

If you operate a module in parallel mode, you can specify an SCXI 
channel either by specifying the corresponding onboard channels o
using the SCXI channel syntax described in this section. If you oper
the modules in multiplexed mode, you must use the SCXI channel 
syntax. 

An SCXI channel number has four parts: the onboard channel 
(optional), the chassis ID, the module slot, and the module channe
isition Basics Manual
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In the following table of examples, x  is any chassis ID, y  is any module 
slot, a is any module channel, and b is any module channel greater 
thana. 

The channel input for DAQ VIs is either a string (with the Easy I/O VIs
or an array of strings. Each string value can only list the channels f
one module. With the array structure for channel values, you can list
channels for several modules. In other words for one scanning 
operation, you can scan several modules. You can scan an arbitrar
number of channels for each module, but the channels of each mod
must be scanned in consecutive, ascending order. 

Note: You do not need the SCXI channel string syntax to access channels on t
SCXI-1200 module. Use 0 for channel 0, 1 for channel 1, and so on. The 
SCXI-1200 module is identified by its logical device number.

Note: When you connect any type of SCXI module to a DAQ device, certain 
digital lines are reserved. Refer to Appendix A, Hardware Capabilities, in 
the LabVIEW Function and VI Reference Manual for more information, or 
refer to the LabVIEW online help, by selecting Help»Online Reference….

For the fastest performance in parallel mode on digital modules, yo
can use the appropriate onboard port numbers instead of the SCXI
channel string syntax in the digital VIs.

SCXI Gains

SCXI modules provide higher analog input gains than those availab
on most DAQ plug-in devices.

Before reading this section, you should have already read the Limit 
Settings section in Chapter 3, Basic LabVIEW Data Acquisition Concepts. 

Channel List Element Channel Specified

OB0!SCx!MDy!a Channel a on the module in slot y  of the 
chassis with ID x is multiplexed into 
onboard channel 0. 

OB0!SCx!MDy!a:b Channels a through b inclusive on the 
module in slot y of the chassis with ID x  
are multiplexed into onboard channel 0. 
LabVIEW Data Acquisition Basics Manual 20-2 © National Instruments Corporation
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Note: It is important to follow the basic rules for setting SCXI gains. If your 
module has jumper-selectable gains, enter those gains in the NI-DAQ 
Configuration utility. If your module has programmable gains, LabVIEW 
selects a gain for you when you use the input limits  parameter to the analog 
input VIs. If you do not use the input limits parameter, LabVIEW uses the 
gain setting in the configuration utility as the default.

Enter the gain jumper settings in the NI-DAQ Configuration utility fo
each channel on each module with jumpered gains. LabVIEW store
these gain settings and uses them to scale the input data to voltage
When you use the input limits  parameter of the analog input VIs, 
LabVIEW chooses onboard gains that complement the jumpered SC
gains to achieve the given input limits as closely as possible.

For analog input modules with programmable gains, LabVIEW uses 
gain setting you enter in the NI-DAQ Configuration utility for each 
module as the default gain for that module. LabVIEW uses the defaul
gain for the module whenever you leave the input limits  terminal to the 
analog input VIs unwired, or if you enter 0 volts for your upper and 
lower input limits.

You can experiment with the default gain setting by using the origin
Getting Started Analog Input VI found in labview\examples\daq\

run_me.llb . This VI does not use input limits. After you execute th
VI, you can open the NI-DAQ Configuration utility while LabVIEW is
open and change the default gain setting there. Be sure to save yo
changes by choosing File»Save (for the Macintosh, save changes by 
closing the utility) before switching back to LabVIEW to run the VI 
again. Remember that the larger the gain setting, the more precise 
measurements will be as long as the signal is within the resulting ra
of the channel.

When you use the input limits  to specify non-zero voltage limits for a 
module with programmable gains, LabVIEW chooses the most 
appropriate SCXI gain for the given limits. LabVIEW selects the 
highest SCXI gain possible for the given limits, and then selects 
additional DAQ device gain if necessary.

If your module has programmable gains and only one gain for all 
channels and you are using an MIO/AI DAQ device, you can specif
different input limits for channels on the same module by splitting u
your channel range over multiple elements of the channel array, an
using a different set of input limits for each element. LabVIEW selec
one module gain suitable for all of the input limits for that module, th
© National Instruments Corporation 20-3 LabVIEW Data Acquisition Basics Manual
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chooses different MIO/AI gains to achieve the different input limits.
The last three examples in Table 20-1 illustrates this method. The l
example shows a channel list with two modules.

You can open the advanced VI, AI Hardware Config, to see the gai
selection. After running this VI, the group channel settings cluster array 
at the right side of the panel shows the settings for each channel. T 
gain indicator displays the total gain for the channel, which is the 
product of the SCXI gain and the DAQ device gain, and the actual lim
settings. The group channel settings cluster array also shows the inpu
limits for each channel.

LabVIEW always scales the input data as you specified, unless you
select binary data only. Therefore, the gains are transparent to the

Table 20-1.  SCXI-1100 Channel Arrays, Input Limits Arrays, and Gains

Array
Index

SCXI-1100
channel list 

Array
input limits

Array

LabVIEW 
Selected SCXI 

Gain

LabVIEW 
Selected 

MIO/AI Gain

0 ob0!sc1!md1!0:7 –0.01 to 0.01 1000 1

0 ob0!sc1!md1!0:7 –0.001 to 0.001 2000 51

0 sc1!md1!0:7 –0.001 to 0.001 2000 1

0
1

ob0!sc1!md1!0:3
ob0!sc1!md1!4:15

–0.1 to 0.1
–0.01 to 0.01

100
100

1
10

0
1

ob0!sc1!md1!0:15
ob0!sc1!md1!16:31

–0.01 to 0.01
–1.0 to 1.0

10
10

1002

1

0
1
2

ob0!sc1!md1!0:3
ob0!sc1!md1!4:15
ob0!sc1!md2!0:7

–1.0 to 1.0
–0.1 to 0.1
–0.01 to 0.01

10
10

1000

1
10
1

1 Applies if the MIO/AI device supports a gain of 5 (some MIO/AI devices do not).

2 This case forces a smaller gain at the SCXI module than at the MIO/AI device, because the input limits for the next c
range on the module require a small SCXI gain. This type of gain distribution is not recommended because it defea
purpose of providing amplification for small signals at the SCXI module. The small input signals are only amplified b
factor of 10 before they are sent over the ribbon cable, where they are very susceptible to noise. To use the optimu
distribution for each set of input signals, do not mix very small input signals with larger input signals on the same SCXI 
module, unless you are sampling them at different times.
LabVIEW Data Acquisition Basics Manual 20-4 © National Instruments Corporation
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application. You can specify the input signal limits and let LabVIEW
do the rest. 

SCXI Settling Time
The filter and gain settings of your SCXI modules affect the settling
time of the SCXI amplifiers and multiplexers. You should always ent
your jumpered filter settings and your jumpered gain settings (if 
applicable) in the configuration utility. LabVIEW uses the gain and 
filter settings to determine a safe interchannel delay that allows the
SCXI amplifiers and multiplexers to settle between channel switchi
before sampling the next channel.

LabVIEW calculates the delay for you. If you set a scan rate that is 
fast to allow for the default interchannel delay, LabVIEW shrinks th
interchannel delay and returns a warning from the AI Start or AI 
Control VIs. You can refer to your hardware manuals for SCXI settlin
times.

You can open the advanced-level AI Clock Config VI to retrieve the
channel clock selection. Set the which clock control to channel clock 1, 
and set the clock frequency to –1.00  (no change). Now run the VI. The
actual clock rate specification cluster is on the right side of the panel.
© National Instruments Corporation 20-5 LabVIEW Data Acquisition Basics Manual
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Now that you have your SCXI system set up and you are aware of 
special SCXI programming considerations, you should learn about 
some common SCXI applications. This section will cover example V
for analog input, analog output, and digital modules. For analog inp
you will learn how to measure temperature (with thermocouples an
RTDs) and strain (with strain gauges) using the SCXI-1100, 
SCXI-1102, SCXI-112x, and SCXI-1141 modules. If you are not 
measuring temperature or pressure, you can still gain basic concep
information on how to measure voltages with an analog input modu
Read these sections and then apply the information to measuring y
transducer.

Another analog input module, the SCXI-1140, is a simultaneous 
sampling module. All the channels acquire voltages at the same tim
which means you can preserve interchannel phase relationships. A
all channel voltages are sampled by going into hold mode, the softw
will read one channel at a time. When a scan of channels is done, 
SCXI-1140 module returns to track mode until the next scan period
Both of these operations are performed by the analog input VIs. Yo
can use any of the data acquisition (DAQ) VIs, located in the 
labview\examples\daq\anlogin\anlogin.llb,  or the Getting 
Started Analog Input VI, found in labview\examples\daq\

run_me.llb , to acquire data from the SCXI-1140 module. 

For analog output, you will learn how to output voltage or current 
values using the SCXI-1124 module. For digital I/O, you will learn ho
to input values on the SCXI-1162/1162HV modules and output valu
on the SCXI-1160, SCXI-1161, and SCXI-1163/1163R modules.

Besides looking at the following sections, other sources of informati
are the following application notes and support documents.

•  SCXI Hardware Specific Common Questions

• Common Questions about Transducers

• Common Questions about Signal Issues 
isition Basics Manual
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All of these notes can be accessed on the NI Fax-on-Demand system or 
by accessing the BBS, World Wide Web, or FTP site, the numbers for 
which are located in the front of this manual. 

Analog Input Applications for Measuring 
Temperature and Pressure

If  you use the DAQ Channel Wizard to configure your analog input 
channels, you can simplif y the programming needed to measure your 
channels. This section describes methods of measuring data using 
named channels configured in the DAQ Channel Wizard and using the 
conventional method.

Note: (Windows)  For more information about using the DAQ Channel Wizard to 
confi gure your channels, refer to the Configuring Your Channels in Windows 
section of Chapter 2, Installing and Configuring Your Data Acquisition 
Hardware. For more information about using channel names, refer to the 
(Windows) Channel Name Addressing section of Chapter 3, Basic LabVIEW 
Data Acquisition Concepts.

Two common transducers for measuring temperature are thermocouples 
and RTDs. A common transducer for measuring pressure is strain 
gauges. Read the foll owing sections on special measuring 
considerations needed for each transducer.

Measuring Temperature with Thermocouples
In this section, you wil l learn how to use analog input SCXI modules 
with thermocouples to measure temperature. If you want to measure the 
temperature of the environment, you can use the temperature sensors in 
the terminal blocks. But if you want to measure the temperature of an 
object away from the SCXI chassis, you must use a transducer, li ke a 
thermocouple. A thermocouple is a junction of two dissimil ar metals 
that gives varying voltages based on the temperature. However, when 
using thermocouples, you need to compensate for the thermocouple 
voltages produced at the screw terminal because the junction with the 
screw terminals itself forms another thermocouple. You can use the 
resulti ng voltage f rom the temperature sensor on the terminal block for 
cold-junction compensation. The cold-junction compensation voltage is 
used when li nearizing voltage readings from thermocouples into 
temperature values.
LabVIEW Data Acquisition Basics Manual 21-2 © National Instruments Corporation
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The SCXI modules that will be used to measure temperature in this
section are SCXI-1100, SCXI-1102, SCXI-1120, SCXI-1120D, 
SCXI-1121, SCXI-1122, and SCXI-1141. All of the terminal blocks 
used with these modules have temperature sensors which can be us
cold-junction compensation. In addition, the SCXI-1100, SCXI-1141
and SCXI-1122 offer a way for you to ground the module amplifier 
inputs so you can read the amplifier offset. You can subtract the 
amplifier offset value to determine the actual voltages. 

For more information on temperature sensors and amplifier offsets lo
at the following two sections. You can also refer to Application Note 
005, Thermocouples and Temperature Measurements, for more 
information on measuring temperature with thermocouples. You ca
access this note on the NI Fax-on-Demand system as well as the B
World Wide Web, or ftp site, the numbers for which are located in t
front of this manual. 

Temperature Sensors for Cold-Junction 
Compensation
The temperature sensors in the terminal blocks for the analog inpu
modules can be used for cold-junction compensation. If you are 
operating your SCXI modules in multiplexed mode as recommende
you should leave the cold-junction sensor jumper on the terminal blo
in the mtemp (factory default) position. If you are using parallel mode
you can use the dtemp  jumper setting.

Note: The SCXI-1102 only uses the cjtemp  string in multiplexed mode.

To read the temperature sensor, use the standard SCXI string synt
the channels array with mtemp substituted for the channel number like
the one shown in the following table.

Channel List Element Channel Specified

ob0!scx!mdy!mtemp The temperature sensor configured in 
mtemp mode on the multiplexed module 
in slot y  of the chassis with ID x . 

ob0!scx!mdy!cjtemp The temperature sensor configured in 
cjtemp  mode on the multiplexed module 
of the SCXI-1102 in slot y  of the chassis 
with ID x .
© National Instruments Corporation 21-3 LabVIEW Data Acquisition Basics Manual
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If you want to read the cold-junction temperature sensor in dtemp  
mode, you can read the following DAQ device’s onboard channels 
these modules. 

For example, you can run the Getting Started Analog Input VI, found
labview\examples\daq\run_me.llb , with the channel string 
ob0!sc1!md1!mtemp  to read the temperature sensor on the termina
block that is connected to the module in slot 1 of SCXI chassis 1. 

SCXI terminal blocks have two different kinds of sensors: either an
Integrated Circuit (IC) sensor or a thermistor. For terminal blocks th
have IC sensors, such as the SCXI-1300 and the SCXI-1320, multi
by 100 to get the ambient temperature in degrees Centigrade at the
terminal block. For terminal blocks that have thermistors, such as t
SCXI-1303, SCXI-1322, SCXI-1327, and SCXI-1328, use the 
Thermistor Conversion VI from Functions»Data Acquisition»Signal 
Conditioning to convert the raw voltage data into units of temperatu

You cannot sample other SCXI channels from the same module wh
you are sampling the mtemp sensor. However, if you are in parallel 
mode, you can sample the dtemp  sensor along with other channels on
the same module at the same time because you are not performing
multiplexing on the SCXI module. You can also sample the cjtemp  
sensor along with other channels on the SCXI-1102, but cjtemp  must 
be the first channel in the channel list.

For greater accuracy, you should take several readings from the 
temperature sensor and average those readings to yield one value. I
do not want to average several readings, you can take a single rea
using the Easy Analog Input VI, AI Sample Channel.

You should look at the SCXI Thermocouple example VIs, found in 
labview\examples\daq\scxi\scxi_ai.llb . The VIs use the 

Modules Channel

SCXI-1100 1

SCXI-1120/SCXI-1120 15 (use referenced single-ended mode)

SCXI-1121 4

SCXI-1122 1
LabVIEW Data Acquisition Basics Manual 21-4 © National Instruments Corporation
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mtemp string to read the temperature sensor and use the reading fo
thermocouple cold junction compensation.

Amplifier Offset
The SCXI-1100, SCXI-1122, and SCXI-1141 have a special calibrat
feature that enables LabVIEW to ground the module amplifier inputs
that you can read the amplifier offset. For the other SCXI analog inp
modules, you must physically wire your terminals to ground. The 
measured amplifier offset is for the entire signal path including the 
SCXI module and the DAQ device.

To read the grounded amplifier on the SCXI-1100 or SCXI-1122, us
the standard SCXI string syntax in the channels array with calgnd  
substituted for the channel number. Refer to the following table for 
example of this.

For example, you can run the Getting Started Analog Input VI, found
the labview\examples\daq\run_me.llb , with the channel string 
ob0!sc1!md1!calgnd  to read the grounded amplifier of the module
in slot 1 of SCXI chassis 1. The voltage reading should be very clos
very close to 0 V. The AI Start VI grounds the amplifier before startin
the acquisition, and the AI Clear VI removes the grounds from the 
amplifier after the acquisition completes.

The SCXI-1141 has a separate amplifier for each channel, so you m
specify the channel number when you ground the amplifier. To spec
the channel number, attach the channel number to the end of the s
calgnd . For example, calgnd2  grounds the amplifier inputs for 
channel 2 and reads the offset. You can also specify a range of chan
The string calgnd0:7  grounds the amplifier inputs for channels 
0 through 7 and reads the offset for each amplifier.

Use the Scaling Constant Tuner VI from Functions»Data 
Acquisition»Signal Conditioning to modify the scaling constants so 
that LabVIEW automatically compensates for the amplifier offset wh
scaling binary data to voltage. The SCXI-1100 Voltage example, fou

Channel List Element Channel Specified

ob0!scx!mdy!calgnd (SCXI-1100 and SCXI-1122 only) The 
grounded amplifier of the module in 
slot y of the chassis with ID x. 
© National Instruments Corporation 21-5 LabVIEW Data Acquisition Basics Manual
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in labview\examples\daq\scxi\scxi_ai.llb , shows you a way to 
use the Scaling Constant Tuner VI.

VI Examples
If you use the DAQ Channel Wizard to configure your channels, yo
can simplify the programming needed to measure your signal. 
LabVIEW configures the hardware with the appropriate input limits a
gain, and performs cold-junction compensation, amplifier offsets, a
scaling for you. To measure a channel using a channel name, you 
use the Easy VIs or the example Thermocouple VI located in 
labview\examples\daq\solution\transduc.llb\Continuous 

Transducer Measurement.vi , as shown in Figure 21-1. Enter the 
name of your configured channel in the channels input parameter. The 
acquired data is in the physical units you specified in the DAQ Chan
Wizard.

Figure 21-1.  Continuous Transducer Measurement VI 

The remainder of this section describes how to measure temperatu
with the SCXI-1100 and SCXI-112x modules using thermocouples 
when you do not use the DAQ Channel Wizard. The temperature 
examples below use both cold-junction measurements and amplifie
offsets. In SCXI analog input examples, you cannot set the scaling
constants with the Easy VIs (determined by the amplifier offset). W
the Intermediate VIs, you can change the scaling constants before 
acquisition begins, while the Advanced VIs include functions that a
not necessary to accurately measure temperature with SCXI modu
The examples described in this section use Intermediate VIs along w
transducer-specific VIs. 

First, you should learn how to measure temperature using the 
SCXI-1100 with thermocouples. You can use the example SCXI-11
LabVIEW Data Acquisition Basics Manual 21-6 © National Instruments Corporation
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Thermocouple VI located in labview\examples\daq\

scxi\scxi_ai.llb . Open the VI and continue reading this section.

In order to reduce the noise on the slowly varying signals produced
thermocouples, you can average the data and then linearize it. For
greater accuracy, you can measure the amplifier offset, which help
scale the data and lets you eliminate the offset error from your 
measurement. The diagram below shows how you can program the
Acquire and Average VI to measure the amplifier offset. You can
find this VI in vi.lib\daq\zdaqutil.llb . This VI acquires 
100 measurements from the amplifier offset, designated in the offset 
channel input by calgnd , and then averages the measurements. Wh
you determine the amplifier offset, you must always use the same in
limits and clock rates that you will be using in the acquisition. The 
Acquire and Average VI can measure the amplifier offset of many 
modules at once, but in Figure 21-2, it only measures one module.

Figure 21-2.  Measuring a Single Module with the Acquire and Average VI

After measuring the amplifier offset, measure the temperature sens
for cold-junction compensation. Both the amplifier offset and 
cold-junction measurements should be taken before any thermocou
measurements are taken. To measure temperature sensors, you us
Acquire and Average VI. The main differences between the amplifi
offset measurement and temperature sensor measurement are the
channel string and the input limits. If have set the temperature senso
mtemp mode (the most common mode), you access the temperature
using mtemp. If you have set the temperature sensor in dtemp  mode, 
then you would read the corresponding DAQ device onboard chann
Make sure you use the temperature sensor input limits which are 
different from your acquisition input limits. To read from a temperatu
© National Instruments Corporation 21-7 LabVIEW Data Acquisition Basics Manual
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sensor based on an IC sensor or a thermistor, set the input limit ra
from +2 to –2 V.

Figure 21-3.  Measuring Temperature Sensors Using the Acquire and Average VI

After determining the average amplifier offset and cold-junction 
compensation, you can acquire data using the Intermediate VIs as 
shown in Figure 21-4. This example continually acquires data until 
error occurs or the user stops the execution of the VI. In order to 
perform continuous, hardware-timed acquisition, you need to set up
buffer. In this case, the buffer is 10 times the number of points acqui
for each channel. Before you initiate the acquisition with the AI Start 
VI, you need to set up the binary-to-voltage scaling constants by us
the Scaling Constant Tuner VI. This VI, which you can find in 
Functions»Data Acquisition»Signal Conditioning, passes the amplifier 
offset to the DAQ driver so that LabVIEW accounts for the amplifie
offset as the AI Read VI retrieves the data. After the compensated 
voltage data from the AI Read VI is averaged, the voltage values a
converted to temperature and linearized by using the Convert 
Thermocouple Reading VI in Functions»Data Acquisition»Signal 
Conditioning. After completing the acquisition, remember to always
clear the acquisition by using the AI Clear VI.
LabVIEW Data Acquisition Basics Manual 21-8 © National Instruments Corporation
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Figure 21-4.  Continuously Acquiring Data Using Intermediate VIs

Another temperature acquisition example using the SCXI-1100 mod
is SCXI Temperature Monitor VI located in labview\examples\daq\

scxi\scxi_ai.llb . This VI continually acquires thermocouple 
readings and sets an alarm if the temperature readings go above a
user-defined limit.

You can use the SCXI-1100 examples with the SCXI-1122 module.
Both modules have the capability to programmatically measure the
amplifier offsets and both modules need the cold-junction 
compensation to linearize thermocouple measurements. The main 
differences between the two modules include the type of temperatu
sensors available on their terminal blocks and the way module chan
are multiplexed. The SCXI-1100 uses a CMOS multiplexer, which is 
capable of fast-channel multiplexing, whereas the SCXI-1122 uses
electromechanical relay to switch one of its 16 channels. Because 
SCXI-1122 uses a relay, this module imposes a minimum interchan
delay of 10 ms. However, scanning multiple SCXI-1122 channels ma
different times, can quickly wear out the relay. To avoid this, acquir
data from the SCXI-1122 module a single channel at a time. For furt
information, refer to the SCXI-1122 User Manual, or the SCXI-1122 
© National Instruments Corporation 21-9 LabVIEW Data Acquisition Basics Manual
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Voltage example VI in labview\examples\daq\scxi\

scxi_ai.llb\scxi-1122 voltage.vi .

If you are measuring temperature with the SCXI-1120 and the 
SCXI-1121 modules, then you can refer to the example VI, 
SCXI-1120/1121 Thermocouple, located in labview\examples\

daq\scxi\scxi_ai.llb . This VI is similar to the VI used to measure
temperature on the SCXI-1100. Both VIs average and linearize 
temperature data using the Intermediate analog input VIs. The two m
differences between the VIs are that the SCXI-1120/1121 VI does n
measure the amplifier offset, and the input limits for the module and 
temperature sensor are different from the input limits for the 
SCXI-1100. The SCXI-1120 and SCXI-1121 modules do not have t
internal switch used to programmatically ground the amplifiers as in 
SCXI-1100 for the amplifier offset measurement. If you want to 
determine the amplifier offset, you have to manually wire the amplifi
terminals to ground and use a separate VI to read the offset voltage.
can also manually calibrate the SCXI-1120 and SCXI-1121 to remo
any amplifier offset on a channel-by-channel basis. Refer to the 
SCXI-1120 or SCXI-1121 user manuals for specific instructions.

Measuring Temperature with RTDs
Resistance-Temperature Detectors (RTDs) are temperature-sensin
devices whose resistance increase with temperature. They are kno
for their accuracy over a wide temperature range. RTDs require cur
excitation to produce a measurable voltage. RTDs are available in 
2-wire, 3-wire, or 4-wire configuration. The lead wires in the 4-wire 
configuration are resistance-matched. If you use a 2-wire or 3-wire
RTD, they are unmatched. Resistance in the lead wires that conne
your RTD to the measuring system will add error to your readings. 
you are using lead lengths greater than 10-feet, you will need to 
compensate for this lead resistance. RTDs are also classified by the
of metal they use. The most common metal is platinum. 

For more information on how the lead wires affect RTD measureme
as well as general RTD information, look at the Measuring Temperature 
with RTDs application note. You can find this note on the NI 
Fax-on-Demand system or by accessing the BBS, World Wide Web
FTP site, the numbers for which are in the front of this manual.

Signal conditioning is needed to interface an RTD to a DAQ device
an SCXI-1200 module. Signal conditioning required for RTDs includ
current excitation for the RTD, amplification of the measured signa
LabVIEW Data Acquisition Basics Manual 21-10 © National Instruments Corporation
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filtering of the signal to remove unwanted noise, and isolation of th
RTD and monitored system from the host computer. Typically, you 
would use the SCXI-1121 module with RTDs because it easily perfor
all the signal conditioning listed previously. You must set up the 
excitation level, gain, and filter settings on the SCXI-1121 module w
jumpers as well as in your system’s configuration utility. For 
information on how to connect and configure the RTD with the 
SCXI-1121 module, look at the Getting Started with SCXI manual or the 
RTD application note mentioned previously. 

The SC-2042 RTD device is a signal conditioning device designed 
specifically for RTD measurement. This device can be used as an 
alternative to SCXI modules. For more information, look at the 
National Instruments catalog.

You do not have to worry about cold-junction compensation with RTD
as you do when measuring thermocouples. To build an application 
LabVIEW, you can use the Easy I/O analog input VIs. If you are 
measuring multiple transducers on several different channels, you 
need to scan the necessary channels with little overhead. Because
Easy I/O VIs reconfigure your SCXI module every time your 
application performs an acquisition, it is recommended that you use
Intermediate analog input VIs.

If you use the DAQ Channel Wizard to configure your channels, yo
can simplify the programming needed to measure your signal, as sh
in Figure 21-5. LabVIEW configures the hardware with the appropria
input limits and gain, measures the RTD, and scales the measurem
for you. Enter the name of your configured channel in the channels 
input parameter. The acquired data is in the physical units you speci
in the DAQ Channel Wizard.
© National Instruments Corporation 21-11 LabVIEW Data Acquisition Basics Manual
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Figure 21-5.  Measuring Temperature Using Information from the DAQ Channel Wizard

Figure 21-5 continually acquires data until an error occurs or you s
the VI from executing. To perform continuous hardware-timed 
acquisition, you must set up a buffer. In this case, the buffer is 10 tim
the number of points acquired for each channel. For each acquisitio
your device averages the temperature data. After completing the 
acquisition, always clear the acquisition by using the AI Clear VI.

If you are not using the DAQ Channel Wizard, you must use the RT
Conversion VI in addition to specifying additional input parameters, 
shown in Figure 21-6. The Convert RTD Reading VI, in 
Functions»Data Acquisition»Signal Conditioning, converts the voltage 
read from the RTD to a temperature representation. 

Note: You should only use the RTD conversion function in LabVIEW for 
platinum RTDs. If you do not have a platinum RTD, the 
voltage-temperature relation will be different, so the LabVIEW conversio
function cannot be used.
LabVIEW Data Acquisition Basics Manual 21-12 © National Instruments Corporation
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Figure 21-6.  Measuring Temperature Using the Convert RTD Reading VI

Figure 21-6 continually acquires data until an error occurs or you s
the VI from executing. In order to perform continuous hardware-tim
acquisition, you need to set up a buffer. In this case, the buffer is 1
times the number of points acquired for each channel. After your dev
averages the voltage data from the AI Read VI, it converts the volta
values to temperature. After completing the acquisition, remember 
always clear the acquisition by using the AI Clear VI.

Measuring Pressure with Strain Gauges
Strain gauges give varying voltages in response to stress or vibrati
in materials. Strain gauges are thin conductors attached to the mat
to be stressed. Resistance changes in parts of the strain gauge to ind
deformation of the material. Strain gauges require excitation (gener
voltage excitation) and linearization of their voltage measurements
Depending on the strain gauge configuration, another requirement 
using strain gauges with SCXI is a configuration of resistors. As sho
in Figure 19-4, the resistance from the strain gauges combined with
SCXI hardware form a diamond-shaped configuration of resistors, 
© National Instruments Corporation 21-13 LabVIEW Data Acquisition Basics Manual
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know as a Wheatstone bridge. When you apply a voltage to the bridge
the differential voltage (Vm) varies as the resistor values in the brid
change. The strain gauge usually supplies the resistors that chang
value with strain. 

Figure 21-7.  Half-Bridge Strain Gauge

Strain gauges come in full-bridge, half-bridge, and quarter-bridge 
configurations. For a full-bridge strain gauge, the four resistors of t
Wheatstone bridge are physically located on the strain gauge itself.
a half-bridge strain gauge, the strain gauge supplies two resistors fo
Wheatstone bridge while the SCXI module supplies the other two 
resistors, as shown above. For a quarter-bridge strain gauge, the s
gauge only supplies one of the four resistors for a Wheatstone brid
For more information on how to connect your strain gauge to SCXI
refer to the Getting Started with SCXI manual.

The SCXI-1121 and the SCXI-1122 modules are commonly used w
strain gauges because they include voltage or current excitation an
internal Wheatstone bridge completion circuits. You can also use th
signal conditioning device SC-2043SG as an alternative to SCXI 
modules. The device is designed specifically for strain gauge 
measurements. For more information on this device, look in your 
National Instruments catalog.

You can set up your SCXI module to amplify strain gauge signals o
filter noise from signals. In order to set up the excitation level, gain, a
filter settings, you must consult your Getting Started with SCXI manual 
for the necessary hardware configuration and Chapter 2, Installing and 
Configuring Your Data Acquisition Hardware, for software 
configuration.

- +

RgR1

R2

Physical strain gauge   
      is value at rest

      = 

Supplied by signal
conditioning hardware

DC Voltage
Excitation

V
m

R1 R2

Rg

Rg
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To build a strain gauge application in LabVIEW, you can use the Ea
I/O analog input VIs. If you are measuring multiple transducers on 
several different channels, you will need to scan the necessary chan
as quickly as possible. Because the Easy I/O VIs reconfigure your SC
module every time the VI is called, you should use the Intermediate
analog input VIs as well as the strain gauge conversion VI, as show
the following example. The Convert Strain Gauge Reading VI, locat
in Functions»DAQ»DAQ Utilities, converts the voltage read by the 
strain gauge to units of strain.

If you use the DAQ Channel Wizard to configure your channels, yo
can simplify the programming required to measure your signal, as 
shown in Figure 21-8. LabVIEW configures the hardware with the 
appropriate input limits and gain, measures the strain gauge, and sc
the measurement for you. Enter the name of your configured channe
the channels input parameter. You do not need to wire the device or 
input limits  input parameters. The acquired data is in the physical un
you specified in the DAQ Channel Wizard.

Figure 21-8.  Measuring Pressure Using Information from the DAQ Channel Wizard

Figure 21-8 continually acquires data until an error occurs or you s
the VI from executing. In order to perform continuous acquisition, yo
need to set up a buffer. In this case, the buffer is 10 times the numbe
© National Instruments Corporation 21-15 LabVIEW Data Acquisition Basics Manual
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points acquired for each channel. After your device averages the 
voltage data from the AI Read VI, it converts the voltage values to str
values. After completing the acquisition, remember to always clear 
acquisition by using the AI Clear VI.

When measuring strain gauge data, there are some parameters on
Convert Strain Gauge Reading VI, shown in Figure 21-9, you shoul
know.

Figure 21-9.  Convert Strain Gauge Reading VI

Vsg, the strain gauge value, is the only parameter wired in the previ
VI diagram. The other parameters for this VI have default values bu
those values may not be correct for your strain gauge. You should ch
the following parameters: Vinit , the voltage across the strain gauge 
before strain is applied (always measure at the beginning of the VI
Bridge Configuration ; Vex, the excitation voltage; Rl, the lead 
resistance; and Rg, the resistance of the strain gauge before strain is
applied. Usually you can ignore the lead resistance, Rl, for strain gauges 
unless the leads are several feet. For more information on any of th
parameters for this VI, refer to Chapter 14, Data Acquisition Utility VIs, 
in the LabVIEW Function and VI Reference Manual., or refer to the 
LabVIEW online help, by selecting Help»Online Reference….

Analog Output Application Example

With the SCXI analog output module, SCXI-1124, you can output 
voltages or currents. Refer to the example analog output VI, SCXI-11
Update Channels VI, located in labview\examples\daq\

scxi\scxi_ao.llb . This VI uses the analog output Advanced VIs 
because the output mode (whether you have voltage or current dat
must be accessible in order to change the value, as shown in 
Figure 21-10. The program calls the AO Group Config VI to specify t
device and output channels. The AO Hardware Config VI specifies 
output mode and the output voltage range, or limit settings, for all t
LabVIEW Data Acquisition Basics Manual 21-16 © National Instruments Corporation
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channels specified in the channels string. This advanced-level VI is
only place where you can specify a voltage or current output mode
you are going to output voltages only, you may want to use the AO
Config VI (an Intermediate VI), instead of the AO Group Config and
AO Hardware Config VIs. You can program individual output channe
of the SCXI-1124 for different output ranges by using the arrays for
channels, output mode, and limit settings. The AO Single Update V
initiates the update of the SCXI-1124 output channels. To help deb
your VIs, it is always helpful to display any errors, in this case using 
Simple Error Handler VI.

Figure 21-10.  SCXI-1124 Update Channels VI

Digital Input Application Example

To input digital signals through an SCXI chassis, you can use the 
SCXI-1162 and SCXI-1162HV modules and the Easy Digital VI, Rea
from Digital Port, as shown in Figure 21-11.

Figure 21-11.  Inputting Digital Signals through an SCXI Chassis Using Easy Digital VIs
© National Instruments Corporation 21-17 LabVIEW Data Acquisition Basics Manual



Chapter 21 Common SCXI Applications

 
 
. 

 

first 
e 

se 

ich 
al 

he 
s. 
p 

 

e 

g 
The port number is a string expressed in the SCx!MDy!0  format, where 
you are trying to input from the digital input module on slot y  of chassis 
x . The last identifier is always port 0, because the whole module is
considered one port. The port width  should be the number of lines in a
port on your SCXI module if you are operating in multiplexed mode
For the SCXI-1162 and SCXI-1162HV, the port width  is 32 lines. If 
you are operating in parallel mode, the port width  should be the number 
of lines on your DAQ device. The DIO-32F device can access all 32
lines of the SCXI modules at once by using the SCXI-1348 cable 
assembly. The DIO-24 and the DIO-96 devices can only access the 
24 lines of these modules when configured in parallel mode. For th
fastest performance in parallel mode, you can use the appropriate 
onboard port numbers instead of the SCXI channel string syntax. U
the iteration input to optimize your digital operation. When iteration  
is 0 (default), LabVIEW calls the DIO Port Config VI (an Advanced 
VI) to configure the port. If iteration  is greater than zero, LabVIEW 
bypasses reconfiguration and remembers the last configuration, wh
improves performance. You can wire this input to an iteration termin
of a loop. With the DIO-24 and DIO-96 devices, every time you call t
DIO Port Config VI, the digital line values are reset to default value
If you want to maintain the integrity of the digital values from one loo
iteration to another, do not set iteration  to 0 except for the first iteration 
of the loop.

For an example on SCXI digital input, refer to SCXI-1162/1162HV 
Digital Input VI located in labview\examples\daq\scxi\

scxi_dig.llb . Even though this VI uses Advanced VIs, it is 
functionally equivalent to the Easy I/O Digital VI, Read from Digital
Port.

Note: The DIO Port Config VI resets output lines on adjacent ports on the sam
8255 chip for DIO-24, DIO-96, AT-MIO-16D, AT-MIO-16DE, and Lab 
and 1200 Series devices.

Note: If you are also using SCXI analog input modules, make sure your cablin
DAQ device is cabled to one of them.
LabVIEW Data Acquisition Basics Manual 21-18 © National Instruments Corporation
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Digital Output Application Example

To output digital signals through an SCXI chassis, you can use the
SCXI-1160, SCXI-1161, SCXI-1163, and SCXI-1163R modules and
the digital Easy Digital VI, Write to Digital Port, as shown in 
Figure 21-12.

Figure 21-12.  Outputting Digital Signals through an SCXI Chassis 
Using Easy Digital VIs

The port number is a string expressed in the scx!mdy!0  format, where 
you are trying to output from the digital output module on slot y  of 
chassis x . The last identifier is always port 0, because the whole mod
is considered one port. The port width should be the number of lines on
your SCXI module if you are operating in multiplexed mode. The 
SCXI-1160 has 16 relays, the SCXI-1161 has 8 relays, and the 
SCXI-1163/1163R have 32 relays. You can do not use the SCXI-11
or SCXI-1161 in parallel mode. For the SCXI-1163/1163R the port 
width  in parallel mode should be the number of lines on your DAQ 
device or SCXI-1200 module. The DIO-32F device can access all 3
lines of the SCXI-1163/1163R modules at once by using the SCXI-13
cable assembly. The DIO-24 and the DIO-96 devices can only acce
the first 24 lines of the SCXI-1163/1163R when configured in paral
mode. For the fastest performance in parallel mode, you can use th
appropriate onboard port numbers instead of the SCXI channel stri
syntax. Use the iteration  input to optimize your digital operation. When
iteration  is 0 (default), LabVIEW calls the DIO Port Config VI (an 
Advanced VI) to configure the port. If iteration  is greater than zero, 
LabVIEW bypasses reconfiguration and remembers the last 
configuration, which improves performance. You can wire this input 
© National Instruments Corporation 21-19 LabVIEW Data Acquisition Basics Manual



Chapter 21 Common SCXI Applications

ig 

 
op.

to 

g 

han 
ust 

h 
port. 

r 

r 
mas, 

on 
 

ial 
 
f 2, 
an iteration terminal of a loop. Every time you call the DIO Port Conf
VI the digital line values are reset to default values. If you want to 
maintain the integrity of the digital values from one loop iteration to
another, do not set iteration to 0 except for the first iteration of the lo

For an example on SCXI digital output, refer to SCXI-116x Digital 
Output VI located in labview\examples\daq\scxi\scxi_dig.llb . 
Even though this VI uses Advanced VIs, it is functionally equivalent 
the Easy Digital VI, Write to Digital Port. 

Note: If you are also using SCXI analog input modules, make sure your cablin
DAQ device is cabled to one of them.

Multi-Chassis Applications

Multiple SCXI-1000, SCXI-1000DC, or SCXI-1001 chasses can be 
daisy-chained together using the SCXI-1350 or SCXI-1346 
multichassis cable adapters and an MIO Series DAQ device other t
the DAQPad-MIO-16XE-50. Every module in each of the chassis m
be in multiplexed mode. Only one of the chassis will be connected 
directly to the DAQ device. Also, if you are using Remote SCXI wit
RS-485, you can daisy chain up to 31 chasses on a single RS-485 
Because you can only configure up to 16 devices on the NI-DAQ 
Configuration utility, you can only have up to 16 SCXI-1200s in you
system.

If you use the DAQ Channel Wizard to configure your analog input 
channels, you simply address channels in multiple chasses by thei
channel names. Channel names can be combined, separated by com
to measure data from multiple modules in a daisy-chain configurati
at the same time. For example, if you have a named channel called
temperature  on one module in the daisy-chain and pressure  on 
another module in the same daisy-chain, your channels array could be 
temperature, pressure . You must enter the chasses in a sequent
order in the NI-DAQ Configuration Utility, assigning the first chassis
in the chain an ID number of 1, the second chassis an ID number o
and so forth.
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If you are not using the DAQ Channel Wizard, or if you are address
non-analog input channels, there are special considerations for 
addressing the channels.

When you daisy-chain multiple chasses to a single DAQ device 
(non-Remote SCXI), each chassis multiplexes all of its analog inpu
channels into a separate onboard analog input channel. The first ch
in the chain uses onboard channel 0, the second chassis in the chain
onboard channel 1, and so on. Therefore, to access channels in the
second chassis, you must select the correct onboard channel as w
the correct chassis ID. The string ob1!sc2!md1!0  means channel 0 on 
the module in slot 1 of SCXI chassis 2, multiplexed into onboard 
channel 1. Remember to use the correct chassis ID number from th
configuration utility and to put the jumpers from the power supply 
module in the correct position for each chassis. 

When an MIO/AI Series device is cabled by a ribbon cable or shield
cable to multiple chasses, the number of reserved analog input chan
depends on the number of chasses. Refer to Table B-14, Reserved DAQ 
Device Analog Input Channels, in Appendix A, Hardware Capabilities, of 
the LabVIEW Function and VI Reference Manual for more channel 
information, or refer to the LabVIEW online help, by selecting 
Help»Online Reference….

When you access digital SCXI modules, you do not use onboard 
channels. Therefore, if you have multiple chassis, you only have to
choose the correct SCXI chassis ID and module slot.

When you use Remote SCXI to address analog input channels, spe
the device number of the SCXI-1200 that is located in the same cha
containing the analog input module from which you take samples.

You can perform DAQ operations on channels in multiple SCXI chas
at the same time. For example, the first element of your channels array 
could be ob0!sc1!md1!0:31 , and the second element of the channels 
array could be ob1!sc2!md1!0:31 . Then, LabVIEW would scan 32 
channels on module 1 of SCXI chassis 1, using onboard channel 0, 
the 32 channels on module 1 in SCXI chassis 2, using onboard cha
1. Remember that the scan rate you specify is how many scans per 
second LabVIEW performs. For each scan, LabVIEW reads every 
channel in the channels array. One restriction is that the channel list fo
each module must be consecutive.
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You can practice reading channels from different chassis by using 
channel strings explained above in the Getting Started Analog Input
found in labview\examples\daq\run_me.llb .

Note: Lab Series devices, LPM devices, DAQCard-500, 516 devices, 
DAQCard-700, 1200 Series (other than SCXI-1200), and DIO-24 device
do not support multi-chassis applications.
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Your SCXI module ships to you pre-calibrated for the specified 
accuracy at the factory. You only need to recalibrate the module if 
precision of your signal measurement is not acceptable because of s
in environmental conditions.

Before learning about how to calibrate, you should understand whe
LabVIEW stores your calibration constants.

Note: This chapter does not apply to the SCXI-1200. For calibration on the 
SCXI-1200, you should use the 1200 Calibrate VI, which you can find in
Functions»Data Acquisition»Calibration and Configuration. 
If you are using an SCXI-1200 in a Remote SCXI configuration, Nationa
Instruments recommends that you connect directly to your parallel port t
perform calibration, because it works much faster.

EEPROM�Your System�s Holding Tank for 
Calibration Constants

When you calibrate your SCXI module in LabVIEW, the calibration 
constants can be stored in Electronically Erasable Programmable 
Read-Only Memory (EEPROM). EEPROM could be compared to a 
holding tank for calibration constant information in your module’s 
memory. There are 3 parts to this holding tank: the factory area, the 
default load area, and the user area, shown in the following diagram.

Note: Only the SCXI-1122, SCXI-1124, SCXI-1102, and SCXI-1141 have 
EEPROMs. All other SCXI modules do not store calibration constants.
isition Basics Manual
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• The factory area has a set of factory calibration constants alrea
stored in it when you receive your SCXI module. You cannot wri
into the factory area, but you can read from it, so you can alwa
access and use these factory constants if they are appropriate 
your application.

• The default load area is where LabVIEW automatically looks to
load calibration constants the first time you access the module. 
When the module is shipped, the default load area contains a c
of the factory calibration constants. 

Note: You may overwrite the constants stored in the default load area of 
EEPROM with a new set of constants using the SCXI Cal Constants VI. T
learn more about this VI, refer to Chapter 28, Calibration and Configuration 
VIs, in the LabVIEW Function and VI Reference Manual, or refer to the 
LabVIEW online help, by selecting Help»Online Reference….

• The user area is an area for you to store your own calibration 
constants that you calculate using the SCXI Cal Constants VI. Y
can also put a copy of your own constants in the default load a
if you want LabVIEW to automatically load your constants for 
subsequent operations. You can read and write to the user are

Electronically Erasable Programmable Read-Only Memory
(EEPROM)

Factory
Area

Default Load
Area

User
Area
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Note: You should use the user area in EEPROM to store any calibration 
constants that you may need to use later. This safeguards you from 
accidentally overwriting your constants in the default load area, becaus
you will have two copies of your new constants and you can revert to the 
factory constants by copying the factory area to the default load area 
without wiping out your new constants entirely.

The following sections explain how to calibrate your SCXI modules 
achieve the levels of accuracy that you desire.

Calibrating SCXI Modules

The SCXI Cal Constants VI in LabVIEW automatically calculates th
calibration constants for your module with the precision you need f
your particular application. You can find this VI in 
Functions»DAQ»Calibration and Configuration. Refer to Chapter 28, 
Calibration and Configuration VIs, in the LabVIEW Function and VI 
Reference Manual for more specifics on the SCXI Cal Constants VI an
each of its parameters, or refer to the LabVIEW online help, by 
selecting Help»Online Reference…. 

By default, calibration constants for the SCXI-1102, SCXI-1122, an
SCXI-1141 are loaded from the module EEPROM. The SCXI-1141 h
only gain adjust constants in the EEPROM; it does not have the bin
zero offset. All other analog input modules (excluding the SCXI-110
SCXI-1122, and SCXI-1141) do not have calibration constants by 
default and do not assume any binary offset and ideal gain settings. 
means you must use one of the procedures described in the SCXI 
Calibration Methods for Signal Acquisition section below to store 
calibration constants for your module if it is not an SCXI-1102, 
SCXI-1122, or SCXI-1141.

You can determine calibration constants based specifically on your
application setup, which includes your type of DAQ device, your DA
device settings, and your cable assembly—all combined with your 
SCXI module and its configuration settings.

Note: If your SCXI module has independent gains on each channel, the 
calibration constants for each channel are stored at each gain setting.
© National Instruments Corporation 22-3 LabVIEW Data Acquisition Basics Manual
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SCXI Calibration Methods for Signal Acquisition
There are two ways you can calibrate your SCXI module—through 
one-point calibration or two-point calibration. The following 
illustration explains why you may need to calibrate your SCXI modu

In this picture, you can see the difference between the ideal reading
the actual reading. This difference is called Vos, or the binary offset, 
before the two readings intersect. The difference in slope between 
actual and ideal readings is called the gain error . 

One-point calibration removes the Vos (binary offset) by measuring a 0 
volt signal and comparing the actual reading to it. Two-point calibrati
removes the Vos (binary offset) and corrects gain error by first 
performing a one-point calibration. Then you measure a voltage at x 
volts and compare it to the actual reading. The x must be as close as 
possible to the full-scale range. The following sections explain how
perform a one-point and two-point calibration.

Binary Reading

Binary Offset

Gain Error

Vos

Actual Voltage
in Binary Representation

Actual Reading

Ideal Reading
LabVIEW Data Acquisition Basics Manual 22-4 © National Instruments Corporation



Chapter 22 SCXI Calibration�Increasing Signal Measurement Precision

 
 to 
 the 

our 
, 
r 
s 

 AI 
els 

 
o 

e 
 
e 

 

Is, 
ral 
One-Point Calibration
These steps show you how to perform a one-point calibration 
calculation in LabVIEW. You should use one-point calibration when
you only need to adjust the binary offset in your module. If you need
adjust both the binary offset and the gain error of your module, read
Two-Point Calibration section later in this chapter. 

Note: If you are using an AT-MIO-16F-5, AT-MIO-64F-5, AT-MIO-16X device 
or an E series device, you should calibrate your DAQ device first using 
either the MIO Calibrate VI or E-Series Calibrate VI.

1. Make sure you set the SCXI gain to the gain you want to use in y
application. If your modules have gain jumpers or DIP switches
they must be set appropriately. Refer to your SCXI module use
manual for jumper or switch setting information. If your module
have software-programmable gain, use the input limits  parameter 
in the AI Config VI to set gain. 

2. Program the module for a single-channel operation by using the
Config VI with the channel that you are calibrating as the chann
parameter in the VI.

3. Ground your SCXI input channel to determine the binary zero 
offset. You should ground inputs because offset can vary at 
different voltage levels due to gain error. If you are using an 
SCXI-1100 or SCXI-1122, you can ground your input channels 
without external hookups by substituting the channel string with
calgnd as the channel number. For other modules, you need t
wire the positive and negative channel inputs together at the 
terminal block and wire them to the chassis ground.

4. Use the AI Single Scan VI to take several readings and averag
them for greater accuracy. Set the DAQ device gain settings to
match the settings you plan to use in your application. If you ar
using an AT-MIO-16F-5, AT-MIO-64F-5, or AT-MIO-16X, you 
can use the MIO Configure VI to enable dithering, which makes
your averaged data more accurate. The dither mode is always 
enabled on E series devices. By using the AI Start and AI Read V
instead of the AI Single Scan VI, you can average over an integ
number of 60 Hz or 50 Hz power line cycles (sine waves) to 
eliminate line noise. You now have your first volt/binary 
measurement: volt = 0.0 or the applied voltage at your input 
channel, and binary is your binary reading or binary average.
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5. Use the SCXI Cal Constants VI with your volt/binary measureme
from step 4 as the Volt/Amp 1 and Binary 1 inputs in your VI, 
respectively. (These input names may vary depending on your 
application setup.) For example, if your volt/binary measureme
from step 4 was 0.00 volts and 2, then you would enter the valu
into your front panel controls as shown in the following illustratio

Two-Point Calibration
These steps show you how to perform a two-point calibration 
calculation in LabVIEW. You should use two-point calibration when
you need to correct both the binary offset and the gain error in you
SCXI module. 

Note: If you are using an AT-MIO-16F-5, AT-MIO-64F-5, or AT-MIO-16X 
device or an E series device, you should calibrate your DAQ device firs
using either the MIO Calibrate VI or E-Series Calibrate VI.

Follow steps 1 through 5 in the previous section, One-Point 
Calibration.

6. Now apply a known, stable, non-zero voltage to your input chan
at the terminal block. This input voltage should be close to the 
upper limit of your input voltage range for the given gain setting
For example, if your input voltage range is –5 to 5V, you would
want to apply an input voltage that is as close to 5 volts as possi
but not exceeding 5 volts. 

7. Take another binary reading or average of readings. If your bin
reading is the maximum binary reading for your DAQ device, yo
should try a smaller input voltage. This is your second volt/bina
measurement.

8. Use the SCXI Cal Constants VI with the first volt/binary 
measurement from step 4 as Volt/Amp 1 and Binary 1 inputs, and 
the second measurement from step 7 as Volt/Amp 2 and Binary 2 
inputs of the VI. The following illustration shows how you shoul
enter the values into these inputs in LabVIEW if your volt/binar
LabVIEW Data Acquisition Basics Manual 22-6 © National Instruments Corporation
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measurements are 0V/0 and 5V/2045. Keep in mind that your in
names may vary depending on your application setup.

9. If you are using SCXI-1102 or SCXI-1122 inputs, you can save t
constants in the module user area in EEPROM. Store constant
the user area as you are calibrating, and then use SCXI Cal 
Constants VI again at the end of your calibration sequence to c
the calibration table in the user area to the default load area in 
EEPROM. Remember that constants that are stored in the defa
load area can be overwritten. If you want to use a set of consta
later, you should keep a copy of the constants stored in the user 
in EEPROM.

Note: If you are storing calibration constants in the SCXI-1102 or SCXI-1122 
EEPROM, your binary offset and gain adjust factors must not exceed th
ranges given in the respective module user manuals.

For other analog input modules, you must store the constants in th
memory. Unfortunately, calibration constants stored in the memory 
lost at the end of a program session. You can solve this problem b
creating a file and saving the calibration constants to this file. You c
load them again in subsequent application runs by passing them into
SCXI Cal Constants or the Scale Constant Tuner VIs.

Repeat the above procedure for any additional channel or gain sett
you want to calibrate.

Calibrating SCXI Modules for Signal Generation
When you output a voltage or current value to your SCXI analog out
module, LabVIEW uses the calibration constants loaded for the giv
module, channel, and output range to scale the voltage or current v
to the appropriate binary value to write to the output channel. By 
default, calibration constants for the SCXI-1124 will be loaded into t
memory from the EEPROM default load area.

You can recalibrate your SCXI analog output module by following 
these steps.
© National Instruments Corporation 22-7 LabVIEW Data Acquisition Basics Manual
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1. Use the AO Single Update VI to output a binary value. If you ar
calibrating a voltage output range, enter 0 in the binary array input 
of the VI. If you are calibrating current range, enter 255  into the 
binary array  input of the VI. 

2. Measure the output voltage or current at the output channel wit
voltmeter or ammeter. This is your first volt/binary measuremen
Binary 1 = 0, and Volt/Amp 1 is the voltage or current you 
measured at the output. 

3. Use the AO Single Update VI to output a binary value of 4,095.

4. Measure the output voltage or current at the output channel. Th
your second volt/binary measurement: Binary 2 should be 4,095  
and Volt/Amp 2 is the voltage or current you measured at the 
output.

5. Use SCXI Cal Constants VI with the first voltage/binary 
measurement from step 2 as the Volt/Amp 1 and Binary 1 inputs 
and the second measurement from step 4 as the Volt/Amp 2 and 
Binary 2 inputs of the VI. 

You can save the constants on the module in the user area in EEPR
Use the user area as you are calibrating, and then use SCXI Cal 
Constants VI again at the end of your calibration sequence to copy
calibration table in the user area to the default load area in EEPRO
Remember that constants that are stored in the default load area ca
overwritten. If you want to use the constants later, you should store
backup copy of the constants in the user area in EEPROM.

Repeat the procedure above for each channel and range you want
calibrate. Subsequent analog outputs will use your new constants t
scale voltage or current to the correct binary value.

For more information on the SCXI Cal Constants VI, refer to 
Chapter 28, Calibration and Configuration VIs, in the LabVIEW Function 
and VI Reference Manual, or refer to the LabVIEW online help, by 
selecting Help»Online Reference….
LabVIEW Data Acquisition Basics Manual 22-8 © National Instruments Corporation
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This section describes the different ways you can use counters wit
your data acquisition application, including generating a pulse or 
pulses; measuring pulse width, frequency, and period; counting eve
and dividing frequencies for precision timing.

Section Six, Counting Your Way to High Precision Timing, contains the 
following chapters:

• Chapter 23, Things You Should Know about Counters, shows you 
how to add high-precision timing to your data acquisition (DAQ
system by using counters and explains basic counter concepts

• Chapter 24, Generating a Square Pulse or Pulse Trains, describes the 
ways you can generate a square pulse or multiple pulses (calle
pulse trains) using the counters available on your data acquisitio
(DAQ) device with the Easy and Intermediate Counter VIs in 
LabVIEW.

• Chapter 25, Measuring Pulse Width, describes how you can use a 
counter to measure pulse width.

• Chapter 26, Measuring Frequency and Period, describes the various
ways you can measure frequencies and periods using the coun
on your data acquisition (DAQ) device.

• Chapter 27, Counting Signal Highs and Lows, teaches you how to 
use counters to count external events or elapsed time.

• Chapter 28, Dividing Frequencies, shows you how to divide the 
available device frequencies to get the frequency you need for y
data acquisition application.
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Counters add counting or high-precision timing to your data acquisit
(DAQ) system. Counters respond to and output Transistor-Transist
Logic (TTL) signals—square-pulse signals that are 0V (low) or 5V 
(high) in value. The following diagram shows a TTL signal.

Even though counters just count the signal transitions (edges) of a T
source signal, you can use this counting capability in many ways.

• You can generate square TTL pulses for clock signals and trigg
for other DAQ applications.

• You can measure the pulse width of TTL signals.

• You can measure the pulse frequency and period of TTL signa

• You can count TTL signal transitions (edges) or elapsed time.

• You can divide the frequency of TTL signals.

The counter chapters that follow this chapter describe each one of th
counter functions.

Signal Transitions
or Edges

+5 V

0 V
isition Basics Manual
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Knowing the Parts of Your Counter

The following illustration shows a basic model of a counter. 

A counter consists of a SOURCE input pin, a GATE input pin, an OU
output pin, and a count register. In plug-in device diagrams and in 
LabVIEW Function and VI Reference Manual, these counter parts are 
called SOURCE n, GATE n, and OUT n, where n is the number of the 
counter.

Typically, a counter counts the signal transitions at the SOURCE inpu
You can configure the counter to count either the low-to-high or the
high-to-low transition of the SOURCE input. These signal transition
are sometimes referred to as edges. For each counted edge, the counte
increments or decrements the internal count register. The count reg
value always reflects the current count of the signal edges. Reading
count register does not change its value. 

The GATE input can control when counting in your application occu
You can enable and disable counting according to GATE signal 
transitions or levels. There are four basic different gating modes: 
rising-edge, falling-edge, high-level, and low-level. The following 
diagram illustrates the four gating modes. The numbers represent h
many low-to-high transitions (rising edges) occur at the SOURCE inp
after the counter has been gated. You also can count the high-to-lo
transitions (falling edges) on the SOURCE input, but it is not shown
the diagram below.

Note: The gating levels shown below are not available with devices that use t
DAQ-STC chip.

GATE

SOURCE

OUT

Counter Register
LabVIEW Data Acquisition Basics Manual 23-2 © National Instruments Corporation
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By default, counters count up in value, but you can change your cou
to count down in value. You can use the count direction input on the 
Advanced VI, CTR Mode Config, to configure a counter to count up 
down in value. For more information, refer to the description of the 
CTR Mode Config VI in Chapter 27, Advanced Counter VIs, in the 
LabVIEW Function and VI Reference Manual, or the LabVIEW online 
help, available by selecting Help»Online Reference….

Note: If a GATE  edge or level change occurs after the specified transition or 
edge on the SOURCE input, then the counter does not begin counting until
the next SOURCE transition or edge. 

You can also use a counter with no gating, allowing the software to
initiate the counting operation.

Use the OUT signal of a counter to generate various TTL pulse 
waveforms. If you are incrementing the count register value, you ca

1

GATE

Counter Value 2

SOURCE

43 5 76 8 count rising SOURCE edge

Falling Edge Gating

1

GATE

Counter Value 2

SOURCE

43 5 76 8 109 count rising SOURCE edge

Rising Edge Gating

1

GATE

Counter Value 2

SOURCE

43 5 6 count rising SOURCE edge

High-Level Gating

1

GATE

Counter Value 2

SOURCE

43 5 6 count rising SOURCE edge

Low-Level Gating
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configure the OUT signal to either toggle signal states or pulse when
counter register reaches a certain value. The highest value of a cou
is called the terminal count (TC). (If you are decrementing, the counte
register value will be 0). If you chose to have pulsed output, then th
counter outputs a high pulse that is equal in time to one cycle of th
counter’s SOURCE signal, which can be either an internal or extern
signal. If you chose to have a toggled output, the state of the outpu
signal changes from high to low or low to high. If you want more 
control over the length of high and low outputs, then you should us
toggled output. Refer to Chapter 24, Generating a Square Pulse or Pulse
Trains, for more information.

Multiple counters can be concatenated for a greater counting range
most devices. For more information on how to concatenate counter
refer to Chapter 27, Counting Signal Highs and Lows.

Knowing Your Counter Chip

Most National Instruments DAQ devices contain one of three differe
counter chips: the Am9513, the DAQ-STC, or the 8253/8254 chip. 
find out which counter chip your device uses, refer to your hardwar
manual, Chapter 27, Advanced Counter VIs, in the LabVIEW Function 
and VI Reference Manual, or the LabVIEW online help, available by 
selecting Help»Online Reference….

Note: All counter information described in this manual refers to the Am9513 
chip (a 16-bit counter with a counting range of 0 to 65,535) and the 
DAQ-STC chip (a 24-bit counter with a counting range of 0 to 224 – 1). For 
information on the 8253/8254 chip, refer to the ICTRControl VI in 
Chapter 27, Advanced Counter VIs, of the LabVIEW Function and VI 
Reference Manual, or the LabVIEW online help, available by selecting 
Help»Online Reference….

If you have the DAQ-STC chip, LabVIEW provides a buffer to perfor
counter operations. Typically, you should use buffered-counter 
operations when you have a GATE signal that may trigger the coun
to count several times, or if you want to save data from different 
counters count several times. If you have the DAQ-STC chip and w
to perform buffered-counter operations, you can alter any of the coun
examples that ship with LabVIEW. For information on 
buffered-counter operations or how to alter the examples, refer to t
CTR Mode Config VI in Chapter 27, Advanced Counter VIs, of the 
LabVIEW Data Acquisition Basics Manual 23-4 © National Instruments Corporation
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LabVIEW Function and VI Reference Manual, or the LabVIEW online 
help, available by selecting Help»Online Reference….

Counting Operations When All Your Counters Are Used

MIO series devices feature an FOUT output and E Series devices 
feature a FREQ_OUT output, where your device can generate a sq
wave without using any of the available counters. The CTR Control V
found in Functions»Data Acquisition»Counters»Advanced Counters, 
enables and disables the FOUT signal and sets the square wave 
frequency. The square wave frequency is defined by FOUT timeba
signal/FOUT divisor. The front panel and block diagram below show 
FOUT output configured to generate a 25,000 Hz square wave. 

Figure 23-1.  CTR Control VI Front Panel and Block Diagram

You also can refer to the Generate Pulse Train on FOUT or FREQ_O
VI located in example\daq\counter\counter.llb  which 
generates a pulse train on these outputs.

Now that you have read about the basic operations of a counter, go
the chapter that describes your particular counter application.

For specific information about the Counter VIs in LabVIEW, refer to
Chapter 13, Introduction to the LabVIEW Data Acquisition VIs, in the 
LabVIEW Function and VI Reference Manual, or the LabVIEW online 
help, available by selecting Help»Online Reference….
© National Instruments Corporation 23-5 LabVIEW Data Acquisition Basics Manual
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This chapter describes the ways you can generate a square pulse 
multiple pulses (called pulse trains) using the counters available on 
your data acquisition (DAQ) device with the Easy and Intermediate
Counter VIs in LabVIEW.

Generating a Square Pulse

There are many times that you may need to generate TTL pulses. T
pulses can be used as clock signals, gates, and triggers. You can als
a generated pulse with a known timebase to determine an unknown 
signal frequency, or use a square pulse to trigger an analog acquisi

There are two basic types of counter signal generation—toggled and 
pulsed. When a counter reaches a certain value, a counter configured
a toggled output changes the state of the output signal from high to 
or from low to high, while a counter configured for a pulsed output 
outputs a pulse. The width of the pulse is equal to one cycle of the 
counter’s SOURCE signal. When generating a pulse or pulse train, 
must define the polarity of the signal as positive or negative. In the
following illustration, you can see that for a signal with a positive 
polarity the initial state is low, while for a signal with a negative 
polarity the initial state is high.

Each counter-generated pulse consists of two parts—phase 1 and 
phase 2. If the counter is configured to output a signal with positive
polarity and toggled output, as shown in the following diagram, the
period of time from when the counter starts counting to the first risi
edge is called phase 1. The time between the rising and the followi
falling edge is called phase 2. If you configure the counter to gener

Positive Polarity Negative Polarity
isition Basics Manual
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a continuous pulse train, the counter repeats this process many tim
shown on the bottom line of Figure 24-1. 

Figure 24-1.  Pulse Created with Positive Polarity and Toggled Output

The following is a list of terms you should know before outputting a
pulse or pulse train using LabVIEW.

• Phase 1 refers to the first phase or delay to the pulse.

• Phase 2 refers to the second phase or the pulse itself.

• Period is the sum of Phase 1 and Phase 2.

• Frequency is the reciprocal of the Period (1/Period).

• In LabVIEW, you can adjust and control the times of phase 1 a
phase 2 in your counting operation. You do this by specifying a
duty cycle. The duty cycle equals: 

Examples of various duty cycles are shown in Figure 24-2. The first l
shows a duty cycle of 0.5 . In this case, phase 1 and phase 2 are the sa
duration. A signal with a 0.5 duty cycle acts as a SOURCE for coun
operations. The second line shows a duty cycle of 0.1 . In this case, 
phase 1 has been increased and phase 2 has been decreased. The

counter starts

phase 1 phase 2

phase 1 phase 2phase 1 phase 2

Single Pulse

Pulse Train

Phase2
Period
------------------- where, Period Phase= 1 Phase+ 2
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line shows a large duty cycle of 0.9 . In this example, phase 1 is very 
short and the phase 2 duration is longer.

Figure 24-2.  Pulse Duty Cycles

Note: A high duty cycle denotes a long pulse phase relative to the delay phas

Now that you know the terms involving generating a single square pu
or a pulse train, you can learn about the LabVIEW VIs, and the phys
connections needed to implement your application.

Generating a Single Square Pulse

When do you need to generate a single square pulse? A single pul
could be used to trigger analog acquisition or to gate a counter 
operation, especially if you are triggering off an edge of the pulse. Re
to the How to Generate Pulses and Pulse Trains VI, located in 
labview\examples\daq\counter\counter.llb  as you read 
this section.

Figure 24-3 illustrates how to connect your counter and device to 
generate a square pulse. The edges of the internal SOURCE signa
counted to generate the output signal. You get the pulse signal for y
external device from the counter’s OUT pin, and you can optionally
gate the operation with the signal connected to the GATE. Instead 
using an internal timebase as your SOURCE, you could connect an
external signal. 

counter starts

phase 1 phase 2

Duty Cycle = 0.5

Duty Cycle = 0.1

Duty Cycle = 0.9
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Figure 24-3.  Physical Connections for Generating a Square Pulse

The Generate Delayed Pulse VI, found in Functions»Data 
Acquisition»Counter, tells your device to generate a single delayed 
pulse. This VI is self-contained and checks for errors automatically
With the Generate Delayed Pulse VI, you must connect the pulse delay 
(phase 1) and pulse width (phase 2) controls to define the output pulse
as shown in Figure 24-4. Sometimes the actual pulse delay and pulse 
width  are not the same as you specified.

Figure 24-4.  Using the Generate Delayed Pulse VI

If you need more control over when the counter actually begins 
generating a single square pulse, use Intermediate VIs instead of t
Easy VIs. Figure 24-5 shows how to generate a single pulse using 
intermediate-level VIs. The Delayed Pulse Generator Config VI 
configures the counter and the Counter Start VI generates the TTL
signal. An example of this is if you wanted to generate a pulse as a re
of meeting certain conditions. If you used the Easy Counter VI, the 
would configure and then immediately start the pulse generation. W
the Intermediate VIs, you can configure the counter long before the
actual pulse generation begins. As soon as you want a pulse to be
generated, the counter can immediately begin without having to 
configure the counter. In this situation, using Intermediate VIs woul
improve performance.

Basic Connection Optional Connection

OUT

DAQ DeviceCounter Register Counter Register

SOURCE OUT

Your 
Device

DAQ 
Device

GATE
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Figure 24-5.  Generating a Single Delayed Pulse Using Intermediate VIs

You must stop the counter if you want to use it for other purposes. 
more information on stopping counters, refer to the Stopping Counter 
Generations section at the end of this chapter.

Generating a Pulse Train

There are two types of pulse trains: continuous and finite. You may use 
a continuous pulse train as the SOURCE of another counter or as t
clock for analog acquisition (or generation). You may use a finite pu
train as the high-level gate signal for another counter.

For a LabVIEW example on generating continuous and finite pulse
trains, look at the How to Generate Pulses and Pulse Trains VI, loca
in labview\examples\daq\counter\counter.llb .

Generating a Continuous Pulse Train
Figure 24-6 describes how to connect your counter and device to 
generate a continuous pulse train. The edges of the internal source
signal are counted to generate the output signal. You obtain the 
continuous pulse train for your external device from the counter’s OU
pin. You can optionally gate the operation with a signal connected to
GATE input pin. Instead of having an internal timebase as your 
SOURCE, you can connect an external signal.

Figure 24-6.  Physical Connections for Generating a Continuous Pulse Train

counter

your
device

your
devicegate

source
out
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Besides generating continuous pulse trains, the How to Generate Pu
and Pulse Trains example VI configures counters to generate 
retriggerable pulse trains, which behave like one-shots.

Figure 24-7 shows how to generate a continuous pulse train using 
Easy Counter VI, Generate Pulse Train. This VI requires you to spec
the frequency and the duty cycle inputs. The number of pulses 
parameter defaults to 0 for the generation of a continuous pulse train

Figure 24-7.  Generating a Continuous Pulse Train with the Generate Pulse Train VI

If you are generating a pulse train and you want more control over w
the counter actually begins the operation, use the Intermediate VIs
instead of the Easy VIs. Figure 24-8 demonstrates how to generate
simple pulse train using Intermediate-level VIs. 

Figure 24-8.  Generating a Continuous Pulse Train Using Intermediate VIs

The Continuous Pulse Generator Config VI configures the counter 
the operation and the Counter Start VI controls the initiation of the 
pulse train. An example of this if you want to generate a continuous
pulse train as a result of meeting certain conditions. If you used the E
VI, the VI would configure and then immediately start the pulse trai
generation. With the Intermediate VIs, you can configure the count
long before the conditions are met. Then, as soon as the conditions
met, you can begin pulse train generation. In this situation, using 
Intermediate VIs would improve performance.
LabVIEW Data Acquisition Basics Manual 24-6 © National Instruments Corporation
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If the duty cycle is 0.0  or 1.0 , the closest achievable duty cycle is use
to generate a train of positive or negative pulses.

You must stop the counter if you want to use it for other purposes. 
more information on stopping counters, refer to the Stopping Counter 
Generations section at the end of this chapter. 

Generating a Finite Pulse Train
You can set the Easy I/O VI, Generate Pulse Train, or a stream of 
Intermediate VIs to generate a finite pulse train. With either techniq
you must use two counters as shown in the connection diagram in 
Figure 24-9. Refer to Chapter 27, Counting Signal Highs and Lows, for 
more information on how to determine counter-1 and how to use the 
adjacent counter VI. The maximum number of pulses in the pulse tr
is 216 – 1, for Am9513 devices and 224 – 1 for DAQ-STC devices.

Figure 24-9 shows how you can produce a finite pulse train on the O
pin of a counter. counter generates the finite pulse train with high-leve
gating. counter-1 provides counter with a long enough gate pulse to 
output the number of desired pulses.

Figure 24-9.  Physical Connections for Generating a Finite Pulse Train

A gated pulse train using the Easy Counter VI, Generate Pulse Train
shown in Figure 24-7, requires the frequency, duty cycle, and number 
of pulses controls to be set. Instead of setting the number of pulses to 0, 
as you would for a continuous pulse train, set the number of pulses to a 
value greater than 0. 

your
devicegate

countercounter-1

your
device gate

source
out

source
out
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Figure 24-10 describes how to create a finite pulse train using the 
Intermediate VIs. 

Figure 24-10.  Creating a Finite Pulse Train Using the Intermediate VIs

In this operation, you use counter to generate a continuous pulse train
with level gating while using counter-1 to generate a minimum delayed
pulse to gate the counter long enough to generate the desired numb
pulses. The Continuous Pulse Generator Config VI configures counter 
to generate a continuous pulse train. Then, the Delayed Pulse Gene
Config VI configures counter-1 to generate a single delayed pulse. Th
first Counter Start VI in the flow begins the continuous pulse generat
and the next Counter Start VI generates a pulse after a specified ti
The gate mode must be specified as level-gating on the Continuou
Pulse Generator Config VI in order for the counter to wait for the ga
signal from counter-1. The gate mode for the Delayed Pulse Generat
Config VI can be set to a single or multiple edges. In other words, y
could produce one finite pulse train or multiple pulse trains. The GAT
signal for counter-1 can be from an external device or from another 
counter on your DAQ device.

Knowing the Accuracy of Your Counters

When you generate a waveform, there can be an uncertainty of up to
timebase period between the start signal and the first counted edge
the timebase. This is due to the uncertainty in the exact relation of 
LabVIEW Data Acquisition Basics Manual 24-8 © National Instruments Corporation
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start signal, which the software call or the gate signal supplies to th
first edge of the timebase as shown in Figure 24-11.

Figure 24-11.  Uncertainty of One Timebase Period

Stopping Counter Generations

You can stop the counting operation in several ways, such as start
the counter again after it has generated a pulse, reconfiguring the 
counter to do something else, or calling the Wait (ms) VI and Coun
Stop function as shown in Figure 24-12. (You can find the Wait (ms) 
in Functions»Time & Dialog.) The previous methods can be used so
that the counter can be used for another operation without resetting
entire board.

Figure 24-12.  Using the Generate Delayed Pulse and Stopping the Counting Operation

phase 1 phase 2

uncertainty of
1 timebase period

output

timebase

starting
signal

1 timebase period
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To stop a generated pulse train, another Generate Pulse Train VI ca
concatenated to the diagram and have the Number of Pulses input set 
to –1, as shown in Figure 24-13.

Figure 24-13.  Stopping a Generated Pulse Train
LabVIEW Data Acquisition Basics Manual 24-10 © National Instruments Corporation
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This chapter describes how you can use a counter to measure puls
width. There are several times you may need to determine pulse wi
For example, if you wanted to determine the duration of an event, y
would want your application to measure the width of a pulse that occ
during that event. Another example would be if you wanted to 
determine the interval between two events. In this case, you would
measure the pulse width between the two events. An example of w
you might use this type of application is if you wanted to determine t
time interval between two boxes on a conveyor belt or the time it ta
one box to be processed through an operation. The event would be
edge every time a box goes by a point, which prompts a digital signa
change in value.

Measuring a Pulse Width

You can measure pulse width by determining the number of pulses
known frequency that are generated during the period to be measu
As illustrated in Figure 25-1, connect the pulse you want to measure
the GATE input pin and a signal of a known frequency to the SOURC
input pin. Your counter must be configured for high-level mode gatin
which means the counter starts counting when the gated signal goe
high and stops counting at the end of the pulse. Figure 25-1 descri
how a pulse of an unknown width (Tpw) gates a counter configured to
count a timebase clock of a known period (Ts). The pulse width equals 
the timebase period times the count, or: .Tpw Ts count×=
isition Basics Manual
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Figure 25-1.  Counting Input Signals to Determine Pulse Width

The SOURCE input can be an external or internal signal. An intern
signal or clock is based upon the type of counter chip on your devic
With Am9513 devices, you can choose frequencies or timebases o
1 MHz, 100 kHz, 10 kHz, 1 kHz, and 100 Hz. DAQ-STC devices ha
internal timebases of 20 MHz and 100 kHz. Figure 25-2 shows how
physically connect the counter on your device to measure pulse wi

Figure 25-2.  Physical Connections for Determining Pulse Width

Determining Pulse Width

You can measure the pulse width using the Measure Pulse Width o
Period VI, located in Functions»Data Acquisition»Counter. This VI 
automatically notifies you with a dialog box if an error occurs. 
Figure 25-3 shows how to program your counters to determine the pu
width using this Easy Counter VI.

GATE

SOURCE

OUT

Count Register

Ts

Tpw

frequency
source

counter

your
device gate

source
out
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Figure 25-3.  Determining Pulse Width Using the Pulse Width or Period VI

The Measure Pulse Width or Period VI counts the number of cycles
the specified internal timebase between the starting and ending ev
that you designate in the type of measurement input. You can measure 
the pulse width from rising to falling edge or from falling to rising edg
The valid? parameter indicates whether the frequency measured th
data without overflow. Overflow occurs when the counter reaches i
highest value, or terminal count (TC). You only need to check the 
valid? parameter if you are using an Am9513 chip. The DAQ-STC do
not use the valid? parameter to set the overflow, so you do not need
check this parameter with this chip. Refer to the Measure Pulse Wi
or Period VI description in Chapter 25, Easy Counter VIs, of the 
LabVIEW Function and VI Reference Manual or the LabVIEW online 
help, available by selecting Help»Online Reference… for further 
information regarding the input parameters.

Controlling Your Pulse Width Measurement

Figure 25-4 describes how to measure pulse width using the follow
Intermediate Counter VIs: Pulse Width or Period Meas Config, Coun
Start, Counter Read, and Counter Stop. Use this set of VIs to contr
when the measurement of the pulse width begins and ends. The Pu
Width or Period Meas Config VI configures a counter to count the 
number of cycles of a known internal frequency or timebase. The 
Counter Start VI begins the measurement. The Counter Read VI 
determines if the measurement is complete and displays the count va
With Am9513 devices, the Counter Read VI also alerts you if an 
overflow occurs (when the counter reaches terminal count (TC)). 
Overflows do not occur in continuous counter operations. Once you
© National Instruments Corporation 25-3 LabVIEW Data Acquisition Basics Manual
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press the stop button, the Counter Stop VI stops the counter opera
And finally, the Simple Error Handler VI notifies you of any errors.

Figure 25-4.  Measuring Pulse Width Using Intermediate VIs

When measuring pulse width, make sure you start the counter befo
your device measures the first pulse. Otherwise, LabVIEW returns 
error or an incorrect measurement.

Increasing Your Measurable Width Range

The maximum value for counters determines the internal timebases
can use to measure the pulse width of a signal. Remember the inte
timebase acts as the SOURCE. When measuring the pulse width o
signal, you count the number of SOURCE edges that occur during 
measured pulse. The counted number of SOURCE edges cannot ex
the counting range of the counter. Slower internal timebases allow 
a greater range in possible pulse widths, because it takes a longer p
of time to reach the maximum counter value. Because the Am9513
counters are 16-bit count registers, the maximum count value is 65,
(216 – 1). For example, if you use a 1 µs internal timebase, the coun
has a pulse width range of 65 ms or 655 s at 100 Hz. The DAQ-ST
counter has a pulse width range of about 840 ms at 20 MHz and 16
at 100 kHz. Therefore, if you produce an overflow error, decrease t
timebase frequency to increase your range of measurable width.

Instead of using an internal timebase, you can set up an additional
counter for pulse train generation and use the output of that counte
the source of the counter measuring pulse-width. You can also use
FOUT or FREQ_OUT for this purpose. Refer to the Generate Pulse
Train on FOUT or FREQ_OUT VI for an example of this application
LabVIEW Data Acquisition Basics Manual 25-4 © National Instruments Corporation
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This chapter describes the various ways you can measure frequen
and periods using the counters on your data acquisition (DAQ) dev
The period of a signal is equal to one cycle of the signal. Frequenc
the inverse of period. An example of when you would want to know t
frequency of a signal is when you have a signal that controls how of
a meter takes measurements—like a flow meter measuring flow rate
a thermometer measuring temperature. 

Knowing How and When to Measure 
Frequency and Period

A common way to measure the frequency of a signal is to measure
number of pulses that occur during a known time period. For examp
Figure 26-1 illustrates the measurement of a waveform of an unkno
frequency (fs) by a pulse of a known pulse width (TG ). The frequency 
of the waveform equals the count divided by the period of known pu
width (frequency=count/TG). The period is always the reciprocal of the
measured frequency (period=1/fs).

Figure 26-1.  Measuring Square Wave Frequency 

For period measurement, you count the number of pulses of a know
frequency (fs) during one period of the signal to be measured. As sho
in Figure 26-2, the signal of a known frequency is connected to the

GATE

SOURCE

OUT

Count Register

TG

input of unknown
frequency, fs

pulse of known width
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SOURCE and the signal to be measured is connected to the GATE.
period is the count-divided by the known frequency (count/fs).

Figure 26-2.  Measuring a Square Wave Period 

You typically would use frequency measurement for high frequency
signals because the signal to be measured is faster than most avai
internal timebases. Period measurement is commonly used with low
frequency signals because the signal to be measured is slower than
internal timebases. For the Am9513 chip, the possible internal 
timebases are 1 MHz, 100 kHz, 10 kHz, 1 kHz, and 100 Hz. For the
DAQ-STC chip, the possible internal timebases are 20 MHz and 
100 kHz. Remember that whether you use the frequency or period 
measurement, you can always obtain the other measurement by ta
the inverse of the current one as shown in the following equations.

Connecting Counters to Measure Frequency and Period

For low frequency signals, your counting range should not exceed 
range of one counter (65,535 for the Am9513 chip and more than 
4 billion for the DAQ-STC chip). If the counting range does exceed o
counter, pick a slower timebase. 

Connect your device and counter as indicated in Figure 26-3 to mea
low frequency signals. To measure pulse period and frequency, yo

GATE

SOURCE

OUT

Count Register

TG

input of known
frequency, fs

period measurement 
1

frequency measurement
------------------------------------------------------------=

frequency measurement
1

period measurement
---------------------------------------------------=
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should wire the signal to be measured to the GATE input pin and a
timebase of known frequency to the SOURCE input pin.

Figure 26-3.  Physical Connections for Period Measurement of Low Frequency Signals

For high frequency signals, you have a greater potential for a large
counting range. Counters are cascaded together to increase the cou
range, as shown in Figure 26-4. Here counter-1 creates a gating puls
an even counter (counter) and for increased resolution you can 
concatenate an additional counter (counter+1). 

Figure 26-4.  Physical Connections for Period Measurement of High Frequency Signals

Note: You cannot cascade counters together with devices that use the DAQ-S
chip.

Refer to Chapter 27, Counting Signal Highs and Lows, for further 
information regarding adjacent counters.

A LabVIEW example that measures the frequency and period of hig
and low frequency signals is the How to Measure Frequency and Pe
VI, located in labview\examples\daq\counter\counter.llb . 
Refer to this example as you read the following sections.

counter

your
device gate

source
out

gate

counter

your
device gate

source

gate
out

source
out

source
out

counter-1 counter+1
(32-bit)
© National Instruments Corporation 26-3 LabVIEW Data Acquisition Basics Manual



Chapter 26 Measuring Frequency and Period

r 

e 
 
 
 

 

t 
 
r 

th 
ter 
 

 

Measuring the Frequency and Period 
of Low Frequency Signals

For low-frequency signals, you can use the Measure Pulse Width o
Period VI, located in Functions»Data Acquisition»Counter, as shown 
below in Figure 26-5. Set the type of measurement parameter to a 
period or pulse measurement. The frequency is the reciprocal of th
period value returned. The valid? parameter indicates if the frequency
was measured without overflow. Overflow occurs when the counter
reaches its highest value, or terminal count (TC). You only need to
check the valid? parameter if you are using an Am9513 chip. The 
DAQ-STC does not use the valid? parameter to set the overflow, so you
do not need to check this parameter with this chip.

Figure 26-5.  Measuring Low-Frequency Signals with the Measure 
Pulse Width or Period VI

If you need more control over when frequency/period measuremen
begins and ends, use the Intermediate VIs instead of the Easy VIs.
Figure 26-6 shows you how to measure the period and frequency fo
low-frequency signals. 

The Intermediate VIs described in Figure 26-6 include the Pulse Wid
or Period Meas Config, Counter Start, Counter Read, and the Coun
Stop VIs. The Pulse Width or Period Meas Config VI configures the
counter for period measurement. The Counter Start VI begins the 
counting operation. Counter Read returns the count value from the
LabVIEW Data Acquisition Basics Manual 26-4 © National Instruments Corporation
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counter, which is used to determine the frequency and period 
measurement. Counter Stop stops the counter operation.

Figure 26-6.  Measuring Low-Frequency Signals Using Intermediate VIs

A third method to determine frequency involves timing how long it 
takes a number of cycles of the TTL signal connected to the SOUR
input to occur. Refer to the How to Measure Frequency and Period
(Case 4) for a detailed description of the block diagram. 

It is a good idea to know what type of signal you are measuring, so 
can use the best approach for measuring the frequency signal.

Measuring the Frequency and Period 
of High Frequency Signals

For high-frequency signals, you can use the Easy VI, Measure 
Frequency, to determine the frequency, as shown in Figure 26-7. Y
can find the Measure Frequency VI in Functions»Data 
Acquisition»Counter. This VI initiates the counter to count the numbe
of rising edges of a TTL signal at the counter’s SOURCE input duri
a gate period of a specific duration (T seconds). Set the gate width (T) 
to the pulse width of the gated signal. The measured frequency equals 
count/gate width. The valid? parameter indicates if the frequency wa
measured without overflow. Overflow occurs when the counter reac
its highest value, or terminal count (TC). You only need to check th
valid? parameter if you are using an Am9513 chip. The DAQ-STC do
© National Instruments Corporation 26-5 LabVIEW Data Acquisition Basics Manual
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not use the valid? parameter to set the overflow, so you do not need
check this parameter with this chip.

Figure 26-7.  Measure Frequency VI

If you need more control over when frequency/period measuremen
begins and ends, use the Intermediate VIs instead of the Easy VIs.
Figure 26-8 shows you how to measure the period and frequency fo
high-frequency signals. 

The Intermediate VIs described in Figure 26-8 include the Delayed
Pulse Generator Config, Event or Time Counter Config, Counter Sta
CTR Control, Counter Read, and the Counter Stop VIs. The Delaye
Pulse Generator Config VI configures counter-1 to generate the ga
signal. The Event or Time Counter Config VI configures the counter
count the number of pulses while it is gated. The Counter Start VI 
begins the counting operation for counter first, then counter-1. The
Counter Read VI returns the count value from counter, which is used
determine the frequency and period measurement. The Counter Sto
stops the counter operation.

Figure 26-8.  Measuring High-Frequency Signals Using Intermediate VIs
LabVIEW Data Acquisition Basics Manual 26-6 © National Instruments Corporation
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A third method to determine frequency involves timing how long it 
takes a number of cycles of the TTL signal connected to the SOUR
input to occur. Refer to the How to Measure Frequency and Period
(Case 4) for a detailed description of the block diagram. 

It is a good idea to know what type of signal you are measuring, so 
can use the best approach for measuring the frequency signal.
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Counters can count external events (like the rising and falling edges
the SOURCE input pin), or elapsed time (like the rising and falling 
edges of an internal timebase). When might you need to count exte
events or elapsed time? One case is if you are in charge of figuring
the throughput of a production line. You have a bar code reader wh
reads the serial number of every product. The bar code reader outp
digital pulse every time it reads a serial number. You could use a 
counter, counter A, to count the number of digital pulses, or events
from the barcode reader. If you only needed to count the digital pul
for a certain amount of time, you can gate the operation of the coun
In order to produce the gate signal for the counter, you can use ano
counter, counter B, to count the pulses of an internal clock for the 
amount of time needed to count the number of products. So, counte
would measure elapsed time and the output pulse(s) of counter B wo
turn counter A on and off. As you can see, time- or event-based 
counting can be very useful with data acquisition.

Figure 27-1 shows how to connect the counter on your device to 
measure events (left diagram) and elapsed time (right diagram). Th
GATE signal can be produced by your device or another counter (l
in the example mentioned above).

Figure 27-1.  Connecting Counters to Your Device to Count Events or Time

Note: (Am9513 chips only) Make sure to use counters that are not being used
any other data acquisition (DAQ) applications. If you try to use a counte
that is already being used by another DAQ application, LabVIEW returns
error number –10009. Refer to Appendix A, Hardware Capabilities, in the 

counter
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gate
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source
out

counter+1
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counter

your
device gate

source
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source
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required
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LabVIEW Function and VI Reference Manual, or the LabVIEW online help, 
available by selecting Help»Online Reference…, for information on which 
counters are already used for analog and digital applications.

As shown in Figure 27-1, you can extend the counting range of a 
counter chip by connecting to the next higher counter (called 
counter+1). This is called cascading counters. By cascading counters,
you can increase your counting range from 65,535 (the maximum 
number for a 16-bit counter) to almost 4.3 billion (the maximum 
number for a 32-bit counter) on the Am9513 chip. The Am9513 chi
has a set of five counters (numbered 1 – 5) that can be connected 
circular fashion. For example, the next higher counter to counter 1 
counter 2 (called counter+1) and the next lower counter is counter 
(called counter-1). The TIO-10 device contains two Am9513 chips, 
the device has 10 counters, two sets of five counters which can be
accessed in a circular fashion. Table 27-1 identifies the adjacent 
counters for the Am9513 (one and two chips).

Note: You cannot cascade counters with devices that have the DAQ-STC chip

Table 27-1.  Adjacent Counters for Counter Chips

Next Lower Counter
Counter

Next Higher
Counter

5 1 2

1 2 3

2 3 4

3 4 5

4 5 1

10 6 7

6 7 8

7 8 9

8 9 10

9 10 6
LabVIEW Data Acquisition Basics Manual 27-2 © National Instruments Corporation
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For more information on adjacent counters, refer to the Adjacent 
Counters VI description in Chapter 26, Intermediate Counter VIs, of the 
LabVIEW Function and VI Reference Manual, or the LabVIEW online 
help, available by selecting Help»Online Reference…. 

Counting Events or Elapsed Time

In order to count events or elapsed time, you can use Easy I/O and
Intermediate VIs. You should only use the Advanced VIs if the Eas
I/O and Intermediate VIs do not satisfy your needs. One example in
LabVIEW that uses the Advanced VIs is the How To Count VI, foun
in labview\examples\daq\counter\counter.llb . In the 
description below, the use of the Easy and Intermediate VIs will be
described. You can refer to the Getting Started Counters VI as wel
the How To Count VI for examples on how to use Easy I/O and 
Intermediate VIs to count events or elapsed time. You can find the 
Getting Started Counters VI in labview\examples\daq\

run_me.llb .

The Easy VI that counts events or time, the Count Events or Time 
is located in Functions»Data Acquisition»Counter. Figure 27-2 shows 
how you would use the VI to count external events. This VI displays
dialog box if an error occurs.

Figure 27-2.  Using the Count Events or Time VI to Count External Events

In Figure 27-2, the counter begins counting the rising edges at the 
SOURCE input on the first iteration of the while loop. Pressing the st
button will stop the counter and output the present count to the fron
© National Instruments Corporation 27-3 LabVIEW Data Acquisition Basics Manual
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panel of the VI. The counter size input is a menu ring where you have
the choice to use a single 16-bit Am9513 counter or a 24-bit DAQ-S
counter, or cascade two Am9513 counters as a 32-bit counter. By 
default, this VI counts the rising edges of the SOURCE signal. You c
change the value of the source edge input, so it will count the fallin
edges of the SOURCE signal. In order to figure out where the inputs 
outputs are located on this VI, remember to use the Help window.

Figure 27-3 shows how to use the Easy Counter VI, Count Events o
Time VI, to measure elapsed time.

Figure 27-3.  Using the Count Events or Time VI to Measure Elapsed Time

The only difference between measuring events or time is the type o
source signal. When measuring events, you have an external signa
connected to the SOURCE input. When measuring time, you use a
internal timebase signal produced by the counter chip. With the 
Am9513 chip, you can choose from the timebases of 1 MHz, 100 kH
10 kHz, 1 kHz, and 100 Hz. With the DAQ-STC chip, you can choo
from the timebases of 20 MHz and 100 kHz. How do you know whi
timebase frequency to use? Suppose you want to count the rising e
of the internal signal for 1 minute. The maximum counted value for
16-bit counter is 65,535. If you use the 100 Hz signal, your counter
would count 100 edges in a minute. If you use the 100 kHz signal, th
the counter counts 100,000 edges in a minute. This means you wo
need to cascade two counters in order to count the necessary edge
using the 100 kHz signal. You should use a higher frequency for sma
time measurements and use a slower frequency for longer time 
measurements. If you do not choose one of the above frequencies, 
LabVIEW Data Acquisition Basics Manual 27-4 © National Instruments Corporation
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the counter will give you error -10403, which informs you that the 
specified device does not support your requested action. If you nee
use a frequency that is not listed above, then refer to Chapter 28, 
Dividing Frequencies, for more information.

Gaining More Control over Your Counting Operations

If you want more control over counting events or time, use the 
Intermediate VIs. These VIs allow you to trigger or gate the countin
operation. Figure 27-4 shows how to count external events using 
Intermediate Counter VIs: Event or Time Counter Config, Counter 
Start, Counter Read, and Counter Stop.

Figure 27-4.  Using the Intermediate VIs to Count External Events

This VI tells the counter to count the number of rising edges on the
SOURCE input until the stop button is pressed.

The Event or Time Counter Config VI configures one or two counte
to count the edges of the signal at the SOURCE input. The counter size 
input is a menu ring similar to the Easy I/O examples. You have the
choice to use a single, 16-bit Am9513 counter or a 24-bit DAQ-STC
counter, or cascade two Am9513 counters as a 32-bit counter. The event 
source/timebase input is set to count the edges of the SOURCE sign
by default (greater than or equal to a 0.0  default value). The source 
edge input is set to count on a rising edge by default. In order to figu
out the location of the event source/timebase input as well as any other 
parameters on any VI, use the Help window. The Counter Start VI 
initiates the counter to begin counting the edges of the SOURCE inp
The Counter Read VI reads the latest edge count from the counter 
© National Instruments Corporation 27-5 LabVIEW Data Acquisition Basics Manual
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register and displays the value on the front panel. Once the stop bu
has been pressed, the Counter Stop VI stops the counter operation

It is a good idea to always check for errors at the end of an operatio
see if the operation was successful.

If you want to trigger TTL event counting, then set up your gate mode 
input on the Event or Time Counter Config VI. With this VI, you can
perform level or edge triggering. Refer to the Event or Time Counte
Config VI description in Chapter 26, Intermediate Counter VIs, of the 
LabVIEW Function and VI Reference Manual, or the LabVIEW online 
help, available by selecting Help»Online Reference…, for more 
information. 

When you use Easy I/O VIs to measure external events or elapsed t
the only difference between the two block diagrams is the counting
source. The same is true when you use Intermediate VIs. For the E
or Time Counter Config VI, the default event source/timebase input is 
the signal connected to the SOURCE input (a value of 0). If you wa
to use an internal timebase as your source, then you need to enter
internal frequency available on your DAQ device. Figure 27-5 show
how to measure elapsed time using Intermediate VIs.

Figure 27-5.  Using the Intermediate VIs to Measure Elapsed Time

Counters enable you to count the edges of TTL signals whether the
signals are external or internal to the DAQ device. Counting extern
signals is called counting events; whereas, counting internal signal
called elapsed time. Since counters count events or time, you can 
combine these two capabilities in order to count events for a certai
period of time. The basic capability of counting TTL signals allows yo
to perform many complex functions. 
LabVIEW Data Acquisition Basics Manual 27-6 © National Instruments Corporation
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When would you need to divide the frequency of a TTL signal? 
Sometimes you may need to use an internal signal at a certain 
frequency, but this frequency is not available on your data acquisiti
(DAQ) device. In order to get the frequency you need, you can divi
the available device frequencies. You can also divide the frequency
an external signal. Frequency division is outputting a pulse or pulse
train from a counter every N cycles of an internal or external source
Counters can only decrease (or divide-down) the frequency of the 
source signal. The resulting divided-down frequency is equal to the
input frequency/N (timebase divisor). N ( timebase divisor) can only be
an integer number, not a real number, and must also be greater tha
Performing frequency division on a internal signal is called a down 
counter; whereas, frequency division on an external signal is called
signal divider. Figure 28-1 shows how to wire counters to perform 
frequency division.

Figure 28-1.  Wiring Your Counters for Frequency Division

In order to divide down frequencies, you must use Intermediate VIs
instead of Easy VIs. For a LabVIEW example on frequency division
refer to How to Generate Pulses and Pulse Trains VI, (pulse genera
method 5) in labview\examples\daq\counter\counter.llb . The 
diagram in Figure 28-2 shows how you can program a signal divide

counter
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device

your
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your
device

gate

source
out
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your
device gate

source
out

Frequency Division for a Signal Divider

Frequency Division for a Down Counter
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using the Down Counter or Divide Config, Counter Start, and Coun
Stop VIs.

Figure 28-2.  Programming a Single Divider for Frequency Division

The Down Counter or Divide Config VI configures the specified 
counter to divide the SOURCE signal by the timebase divisor value and 
output a signal when the counter reaches its terminal count (TC). Us
Down Counter or Divide Config VI, you can configure the type of 
output to be pulse or toggled. The diagram above outputs a high pu
lasting one cycle of the source signal once the counter reaches its 
For more information on the different types of signal outputs, refer 
the Down Counter or Divide Config VI description in Chapter 26, 
Intermediate Counter VIs, of the LabVIEW Function and VI Reference 
Manual, or the LabVIEW online help, available by selecting 
Help»Online Reference…. The diagram above counts the rising edge
of the SOURCE signal, the default value of the source edge input. In 
order to figure out where the inputs and outputs are located on this
remember to use the Help window. Open this window by choosing 
Help»Show Help.

The Counter Start VI tells the counter to start counting the SOURC
signal edges. The counter only stops the frequency division when t
stop button is pressed. The Counter Stop VI stops the counter 
immediately and clears the count register. It is a good idea to alwa
check your errors at the end of an operation to see if the operation 
successful.

You can alter the Down Counter or Divide Config VI to create a dow
counter. To do this, change the timebase value from 0.0  (external 
SOURCE) to a frequency available on your counter. With the Am95
chip, you can choose timebases of 1 MHz, 100 kHz, 10 kHz, 1 kHz, a
100 Hz. With the DAQ-STC chip, you can choose timebases of 20 M
and 100 kHz.
LabVIEW Data Acquisition Basics Manual 28-2 © National Instruments Corporation
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Instead of triggering frequency division for signal dividers and down
counters by software, as was previously described, you can trigger
using the GATE signal. You can trigger while the GATE signal is hig
low or on the rising or falling edge. For more information, look at th
Down Counter or Divide Config VI description in Chapter 26, 
Intermediate Counter VIs, of the LabVIEW Function and VI Reference 
Manual, or the LabVIEW online help, available by selecting 
Help»Online Reference…. 
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Debugging Your Data 
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This section contains an explanation of ways you can debug your d
acquisition application to make sure your application is accurate an
runs smoothly. 

Section Seven, Debugging Your Data Acquisition Application, contains 
the following chapter:

• Chapter 29, Debugging Techniques, shows you some tips to help 
figure out why your VI is not working.
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Is your VI not working as you expected it would? Well, this chapter
shows you some tips to help figure out why your VI is not working. 
First, find your LabVIEW User Manual and LabVIEW Tutorial Manual, 
because these manuals are references in this section. With LabVIE
data acquisition (DAQ) applications, you may find errors in hardwa
connections, software configuration, or VI construction. The goal o
this chapter is to help you narrow down where the problem is in you
program flow.

Hardware Connection Errors

When no error occurs, but the data is not what you expected, then 
may want to check your hardware connections and jumper settings.
instance, if you have an analog input application, make sure your 
signals are properly grounded. For more information on analog inp
configuration issues, refer to Chapter 5, Things You Should Know about
Analog Input. 

For SCXI modules, you must verify that gain jumpers are set up 
properly. To verify how a DAQ device gets set to a certain gain (or lim
setting as noted in the software), refer to Chapter 3, Basic Data 
Acquisition Concepts. Another common SCXI hardware error is using
digital lines on your DAQ device that are reserved for communicati
with the SCXI modules. 

In order to test that your hardware has not been damaged, connect
known voltage to the channels you are using. To check the location
any hardware connections, refer to your hardware user manual. 
isition Basics Manual
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Software Configuration Errors

As you check hardware connections, it is a good idea to verify that 
NI-DAQ software configuration reflects your hardware setup. For 
possible difficulties with software configuration, read Chapter 2, 
Installation and Configuration, the chapter of this manual that describe
your specific application, or the NI-DAQ User Manual.

(Windows)  In the NI-DAQ Configuration utility, you can use the 
NI-DAQ Test Panels to verify that your device is operating properly
Refer to the NI-DAQ Configuration Utility Help for more details.

VI Construction Errors

The various sections below describe methods to find problems with
construction. All the techniques described can be used by themselve
in conjunction with one another. 

Error Handling
The best way to determine if your application executed without an er
is to use one of the error handler VIs in your application. The Error
Handler VIs are located in Functions»Time & Dialog. You can only use 
these VIs with Intermediate and Advanced VIs. Easy I/O VIs alread
include error handling capabilities within each VI. Each Intermediat
and Advanced VI has an error input and output clusters (named error in  
and error out , respectively). The error clusters contain a Boolean th
indicates whether an error occurred, the error code for the error, and
name of the VI that returned the error. If error in  indicates an error, the 
VI returns the same error information in error out , and does not perform 
any DAQ operations.

When you use any of the Intermediate or Advanced VIs in a While 
Loop, you should stop the loop if the status in the error out  cluster reads 
TRUE. If you wire the error cluster to the General Error Handler VI 
LabVIEW Data Acquisition Basics Manual 29-2 © National Instruments Corporation
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the Simple Error Handler VI, the VI deciphers the error information a
describes the error to you. The following diagrams show how to wir
typical DAQ VI to an error handler.

Figure 29-1.  Error Checking Using the General Error Handler VI

Figure 29-2.  Error Checking Using the Simple Error Handler VI

The following shows an example of the dialog box the Error Handle
VIs display if an error occurs.

Please refer to the LabVIEW Function and VI Reference Manual or the 
LabVIEW online help, available by selecting Help»Online 
Reference…, for more information on the error handler VIs.

Single-Stepping through a VI
Single stepping through a VI allows you to execute one node at a t
in the block diagram. A node can be subVIs, functions, structures, 
formula nodes, and attribute nodes. Refer to Chapter 5, Executing and 
Debugging, in the LabVIEW User Manual and the LabVIEW Tutorial 
Manual for more information on single-stepping.
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Execution Highlighting
Execution highlighting (the light bulb button on the diagram) shows
you how the data passes from one node to another in your program
When you turn execution highlighting on, data movement is marked
bubbles moving along the wires. Refer to Chapter 5, Executing and 
Debugging, in the LabVIEW User Manual and the LabVIEW Tutorial 
Manual for more information on execution highlighting.

Using the Probe Tool
If your VI is producing questionable results, you may want to use th
Probe tool to check intermediate values in a VI. The 
Probe tool will help you narrow down where the incorrect results ar
occurring. Refer to Chapter 5, Executing and Debugging, in the 
LabVIEW User Manual and the LabVIEW Tutorial Manual for more 
information on using the probe.

Setting Breakpoints and Showing Advanced DAQ VIs
Once you have narrowed down the location of an error to a subVI, y
can set a breakpoint on that subVI to cause VI execution to pause be
executing the subVI. You can now see what values get passed in o
generated by the Advanced VIs, single-step through the subVI’s 
execution, probe wires to see data, or change values of front pane
controls. Refer to Chapter 5, Executing and Debugging, in the LabVIEW 
User Manual and the LabVIEW Tutorial Manual for more information on 
how to set a breakpoint.
LabVIEW Data Acquisition Basics Manual 29-4 © National Instruments Corporation
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Where is the best place to get up to speed quickly with data 
acquisition and LabVIEW?

Read the LabVIEW Data Acquisition Basics Manual and look at the 
run_me.llb  examples, in labview\examples\daq\run_me.llb , 
included with the package. In Windows, run the DAQ Channel Wiza
and the DAQ Solution Wizard.

What is the easiest way to address my AMUX-64T board with 
my MIO board?

Set the number of AMUX boards used in the NI-DAQ Configuration
utility (nidaqconf.exe  on Windows or NI-DAQ  control panel on 
Macintosh). Then in the channel string inputs specify the onboard 
channel. For example, with one AMUX-64T board, the channel 
string “0:1 ” will acquire data from AMUX channels 0 through 7, and
so on.

What are the advantages/disadvantages of reading AI Read's 
backlog rather than a fixed amount of data?

Reading the backlog is guaranteed not to cause a synchronous wa
the data to arrive. However, it adds more delay until the data is 
processed (because the data was really available on the last call) a
can require constant reallocation or size adjustments of the data 
acquisition read buffer in LabVIEW.

What is the easiest way to verify that my board works and is 
acquiring data from my signals?

Run one of the examples in the labview\examples\daq  folder or run 
the test panel for your board in the NI-DAQ Configuration utility.
uisition Basics Manual
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How can I tell when a continuous data acquisition operation 
does not have enough buffer capacity?

The scan backlog rises with time, either steadily or in jumps, or take
long time to drop to normal after an interrupting activity like mouse 
movement. If you can open another VI during the operation without
receiving an overrun error you should have adequate buffer capaci

I want to group two or more ports using my DIO32, DIO24, or 
DIO-96 board, but I do not want to use handshaking. I just 
want to read one group of ports just once. How can I set it up 
in software?

Use Easy I/O VIs (Write to Digital Port or Read from Digital Port) o
Advanced Digital VIs (DIO Port Config, DIO Port Write or DIO Port 
Read), and set multiple ports in the port list. For Easy I/O VIs, you c
specify up to four ports in the port list. Whatever data you try to outp
to each port of your “group” will correspond to each element of the data
array. This also applies for input.

I want to use the OUT1, OUT 2, OUT3 and IN1, IN2, IN3 pins 
on my DIO-32F board. How do I address those pins using the 
Easy I/O Digital VIs in LabVIEW?

These output and inputs pins are addressed together as port 4. OU
and IN1 are referred to as bit 0, OUT2 and IN2 are referred to as b
and OUT3 and IN3 are referred to as bit 2. Only the NB-DIO-32F h
three pins for each direction. If you use the Write To Digital Port VI
you will output on the OUT pins, and if you use the Read From Digi
Port VI, you will input from the IN pins.

I want to be able to write up to four lines on the digital port on 
my jumpered MIO (non E-series) board while also reading in 
four lines of digital data on the remaining free digital lines. 
How do I do this?

Use the DIO Port Config VI twice; once to configure four lines for 
output and once more to configure four lines for input. Now call the
DIO Port Write VI or the DIO Port Read VI for the appropriate lines
Avoid calling the Easy I/O VIs for digital I/O, as they reconfigure th
port direction each time the VI is called.
LabVIEW Data Acquisition Basics Manual A-2 © National Instruments Corporation
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I want to use a TTL digital trigger pulse to start data 
acquisition on my DAQ device. I noticed there are two types 
of triggers: Digital Trigger A, and Digital Trigger A&B. Which 
digital trigger setting should I use and where should I connect 
the signal?

You should use Digital Trigger A, which stands for “first trigger," to 
start a data acquisition. Digital Trigger B, which stands for “second
trigger," should only be used if you are doing both a start AND a st
trigger for your data acquisition. Connect your trigger signal to eith
STARTTRIG* (pin 38) if you are using an AT-MIO-16, AT-MIO-16D,
NB-MIO-16X, or EXTTRIG* or DTRIG for any other board that has 
that pin. If you are using an E-series device, you can select which 
PFI pin to connect to. If you do not specify the PFI pin, it uses the 
defaults as the PFI pin names suggest, for example, PFI0/TRIG1. T
only analog input boards on which you cannot do a digital trigger a
the LPM devices, DAQCard-700, DAQCard-500, and the 516 devic
Refer to the AI Trigger Config description in Chapter 17, Advanced 
Analog Input VIs, in the LabVIEW Function and VI Reference Manual, or 
the LabVIEW online help, available by selecting Help»Online 
Reference…, for more information on the use of digital triggers on you
DAQ device.

Note: The NB-MIO-16 has an EXTTRIG* pin, but cannot support start and stop
triggering.

When are the data acquisition devices initialized?

All data acquisition devices are initialized automatically when the fir
DAQ VI is loaded in on a diagram when you start LabVIEW. You ca
also initialize a particular device by calling the Device Reset VI.

(Windows) I open a VI that calls a DAQ VI, or drop a DAQ 
subVI on a block diagram, and crash.

The first time a DAQ VI is loaded into memory in LabVIEW, LabVIEW
opens the Dynamic Link Library (dll ) that controls data acquisition. A
crash at this time indicates a problem in communicating with the driv
This may indicate that there is a conflict with another device in the 
machine.

To determine the source of the problem, quit LabVIEW and Window
re-launch Windows, and run the NI-DAQ Configuration Utility. Run 
simple configuration test with the DAQ devices in the machine. If th
© National Instruments Corporation A-3 LabVIEW Data Acquisition Basics Manual
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results in a crash, there is probably a conflict with another device in 
machine or the driver’s file versions do not correspond for some reas
If not, you need to obtain the latest version of the DAQ driver from N
BBS, World Wide Web, or FTP site.

We have also seen cases where the video driver conflicts with both
NI-DAQ Configuration Utility and LabVIEW. You can obtain the Error 
Messages and Crashes Common Questions document from the NI 
Fax-on-Demand system.

(Windows) I bought LabVIEW for Windows and also have a 
slightly older DAQ device from National Instruments. I 
installed the entire LabVIEW package, but should I go ahead 
and install my NI-DAQ for Windows drivers that I originally 
got with the board?

In most cases, the answer is no. The LabVIEW installer installs a se
DAQ driver files that are guaranteed to work with LabVIEW, wherea
if you happen to install an older version of the drivers afterwards, y
may run into many problems. You may even end up crashing your 
computer every time you do any data acquisition. If you buy a new 
DAQ device and if you already have LabVIEW installed, it is safe to
install the NI-DAQ for Windows drivers from those disks. In any cas
make sure you install and use the latest version of the NI-DAQ drive
unless a dialog box at installation tells you your board is no longer 
supported on that version.
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For your convenience, this appendix contains forms to help you gather the information nece
to help us solve your technical problems and a form you can use to comment on the produ
documentation. When you contact us, we need the information on the Technical Support For
the configuration form, if your manual contains one, about your system configuration to an
your questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone syste
quickly provide the information you need. Our electronic services include a bulletin board ser
an FTP site, a fax-on-demand system, and e-mail support. If you have a hardware or softw
problem, first try the electronic support systems. If the information available on these syste
does not answer your questions, we offer fax and telephone support through our technical s
centers, which are staffed by applications engineers. 

Electronic Services

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collectio
files and documents to answer most common customer questions. From these sites, you c
download the latest instrument drivers, updates, and example programs. For recorded instru
on how to use the bulletin board and FTP services and for BBS automated information, ca
(512) 795-6990. You can access these services at:

United States:  (512) 794-5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635  551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files an
documents are located in the /support  directories.

Bulletin Board Support

FTP Support
uisition Basics Manual
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Fax-on-Demand is a 24-hour information retrieval system containing a library of documents
wide range of technical information. You can access Fax-on-Demand from a touch-tone tele
at (512) 418-1111.

You can submit technical support questions to the applications engineering team through e
at the Internet address listed below. Remember to include your name, address, and phone 
so we can contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the tech
support number for your country. If there is no National Instruments office in your country, 
contact the source from which you purchased your software to obtain support.

Telephone  Fax

Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 527 2321 09 502 2930
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 5734815 03 5734816
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
U.K. 01635 523545 01635 523154

Fax-on-Demand Support

E-Mail Support (currently U.S. only�
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardwar
use the completed copy of this form as a reference for your current configuration. Completin
form accurately before contacting National Instruments for technical support helps our 
applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this pro
include the configuration forms from their user manuals. Include additional pages if necess

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ )___________________ Phone ( ___ ) ___________________________________

Computer brand ________________ Model ________________ Processor_______________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB  Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed___________________________________

Hard disk capacity _____MB Brand __________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model__________  Revision ___________________

Configuration _______________________________________________________________

National Instruments software product ____________________________ Version _________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem:________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________
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LabVIEW Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of 
item. Complete a new copy of this form each time you revise your software or hardware 
configuration, and use this form as a reference for your current configuration. Completing t
form accurately before contacting National Instruments for technical support helps our 
applications engineers answer your questions more efficiently.

National Instruments Products

DAQ hardware ______________________________________________________________

Interrupt level of hardware _____________________________________________________

DMA channels of hardware ____________________________________________________

Base I/O address of hardware ___________________________________________________

Programming choice __________________________________________________________

NI-DAQ or LabVIEW version ____________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards ________________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________

Other Products

Computer make and model ____________________________________________________

Microprocessor ______________________________________________________________

Clock frequency or speed ______________________________________________________

Type of video board installed ___________________________________________________

Operating system version ______________________________________________________

Operating system mode _______________________________________________________

Programming language _______________________________________________________

Programming language version _________________________________________________

Other boards in system ________________________________________________________

Base I/O address of other boards ________________________________________________

DMA channels of other boards _________________________________________________

Interrupt level of other boards __________________________________________________
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Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our
products. This information helps us provide quality products to meet your needs.

Title: LabVIEW® Data Acquisition Basics Manual

Edition Date: May 1997

Part Number: 320997B-01

Please comment on the completeness, clarity, and organization of the manual.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

Thank you for your help.

Name _____________________________________________________________________

Title ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Phone ( ___ )__________________________  Fax ( ___ ) ____________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway (512) 794-5678
Austin, TX  78730-5039
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1D One-dimensional.

2D Two-dimensional. 

A

A Amperes.

AC Alternating current. 

A/D Analog-to-digital. 

ADC Analog-to-digital converter. An electronic device, often an 
integrated circuit, that converts an analog voltage to a digital 
number. 

ADC resolution The resolution of the ADC, which is measured in bits. An ADC
with 16 bits has a higher resolution, and thus a higher degree o
accuracy than a 12-bit ADC.

AI Analog input. 

Prefix Meaning Value

k- kilo- 103

M- mega- 106

m- milli- 10–3

µ- micro- 10–6

n- nano- 10–9
uisition Basics Manual
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AIGND The analog input ground pin on a DAQ device.

amplification A type of signal conditioning that improves accuracy in the 
resulting digitized signal and to reduce noise.

AMUX devices See analog multiplexers.

anlogin.llb A LabVIEW DAQ library containing VIs that perform analog inpu
with DAQ devices and can write or stream the acquired data to d

anlog_io.llb A LabVIEW DAQ library containing VIs for analog I/O control 
loops.

analog input group A collection of analog input channels. You can associate each
group with its own clock rates, trigger and buffer configurations
and so on. A channel cannot belong to more than one group. 

Because each board has one ADC, only one group can be activ
any given time. That is, once a control VI starts a timed acquisiti
with group n, subsequent control and read calls must also refer 
group n. You use the task ID to refer to the group. 

analog multiplexer Devices that increase the number of measurement channels w
still using an single instrumentation amplifier. Also called AMUX 
devices.

anlogout.llb A LabVIEW DAQ library containing VIs that generate single 
values or multiple values (waveforms) to output through analog
channels.

analog output group A collection of analog output channels. You can associate ea
group with its own clock rates, buffer configurations, and so on.
channel cannot belong to more than one group. 

analog trigger A trigger that occurs at a user-selected level and slope on an 
incoming analog signal. Triggering can be set to occur at a 
specified voltage on either an increasing or a decreasing signa
(positive or negative slope). 

AO Analog output. 

array Ordered, indexed set of data elements of the same type.
LabVIEW Data Acquisition Basics Manual G-2 © National Instruments Corporation
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BCD Binary-coded decimal. 

bipolar A signal range that includes both positive and negative values 
(for example, –5 to 5 V). 

buffer Temporary storage for acquired or generated data. 

C

cascading Process of extending the counting range of a counter chip by 
connecting to the next higher counter.

channel Pin or wire lead to which you apply or from which you read the
analog or digital signal. Analog signals can be single-ended or 
differential. For digital signals, you group channels to form port
Ports usually consist of either four or eight digital channels.

channel clock The clock controlling the time interval between individual chan
sampling within a scan. Boards with simultaneous sampling do n
have this clock.

channel name A unique name given to a channel configuration in the DAQ 
Channel Wizard.

circular-buffered I/O Input/output operation that reads or writes more data points th
can fit in the buffer. When LabVIEW reaches the end of the buffe
LabVIEW returns to the beginning of the buffer and continues t
transfer data. 

clock Hardware component that controls timing for reading from or 
writing to groups.

cluster A set of ordered, unindexed data elements of any data type 
including numeric, Boolean, string, array, or cluster. The elemen
must be all controls or all indicators.

code width The smallest detectable change in an input voltage of a DAQ 
device.

column-major order A way to organize the data in a 2D array by columns. 
© National Instruments Corporation G-3 LabVIEW Data Acquisition Basics Manual
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common-mode voltage Any voltage present at the instrumentation amplifier inputs w
respect to amplifier ground.

conditional retrieval A method of triggering in which you to simulate an analog trigg
using software. Also called software triggering.

conversion device Device that transforms a signal from one form to another. For
example, analog-to-digital converters (ADCs) for analog input, 
digital-to-analog converters (DACs) for analog output, digital inp
or output ports, and counter/timers are conversion devices. 

counter.llb A LabVIEW DAQ library containing VIs that count the rising and
falling edges of TTL signals, generate TTL pulses, and measure
frequency and period of TTL signals.

counter/timer group A collection of counter/timer channels. You can use this type 
group for simultaneous operation of multiple counter/timers.

coupling The manner in which a signal is connected from one location t
another. 

D

D/A Digital-to-analog. 

DAC Digital-to-analog converter. An electronic device, often an 
integrated circuit, that converts a digital number into a 
corresponding analog voltage or current.

DAQ Channel Wizard Utility that guides you through naming and configuring your DA
analog input channels.

DAQ Solution Wizard Utility that guides you through specifying your DAQ application
from which it provides a custom DAQ solution.

data acquisition Process of acquiring data, typically from A/D or digital input 
plug-in boards. 

data flow Programming system consisting of executable nodes in which 
nodes execute only when they have received all required input d
and produce output automatically when they have executed. 
LabVIEW is a dataflow system.

default input The default value of a front panel control. 
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default setting A default parameter value recorded in the driver. In many cases
default input of a control is a certain value (often 0) that means use 
the current default setting. For example, the default input for a 
parameter may be do not change current setting, and the default 
setting may be no AMUX-64T boards. If you do change the value 
of such a parameter, the new value becomes the new setting. Y
can set default settings for some parameters in the configuratio
utility. 

device A DAQ device inside your computer or attached directly to you
computer through a parallel port. Plug-in boards, PC cards, and
devices such as the DAQPad-1200, which connects to your 
computer’s parallel port, are all examples of DAQ devices. SCX
modules are distinct from devices, with the exception of the 
SCXI-1200, which is a hybrid. 

device number The slot number or board ID number assigned to the device w
you configured it.

DIFF Differential. A differential input is an analog input consisting of 
two terminals, both of which are isolated from computer ground
and whose difference you measure. 

differential measurement A way you can configure your device to read signals, in whic
system you do not need to connect either input to a fixed reference, suc

the earth or a building ground.

digio.llb A LabVIEW DAQ library containing VIs that perform immediate
digital I/O and digital handshaking with DAQ devices and SCXI
modules.

digital input group A collection of digital input ports. You can associate each grou
with its own clock rates, handshaking modes, buffer 
configurations, and so on. A port cannot belong to more than o
group. 

digital output group A collection of digital output ports. You can associate each gr
with its own clock rates, handshaking modes, buffer 
configurations, and so forth. A port cannot belong to more than o
group. 

digital trigger A TTL signal that you can use to start or stop a buffered data 
acquisition operation, such as buffered analog input or buffered
analog output.
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DIP Dual Inline Package. 

dithering The addition of Gaussian noise to an analog input signal. By 
applying dithering and then averaging the input data, you can 
effectively increase the resolution by another one-half bit.

DLL Dynamic Link Library. 

DMA Direct Memory Access. A method by which data you can transf
data to computer memory from a device or memory on the bus
(or from computer memory to a device) while the processor doe
something else. DMA is the fastest method of transferring data
or from computer memory. 

down counter Performing frequency division on an internal signal.

driver Software that controls a specific hardware device, such as a da
acquisition board. 

DSP Digital Signal Processing. 

E

E-series MIO board Boards, such as the PCI-MIO-16E-1 and the AT-MIO-16E-2 wh
use the MITE chip (on PCI boards for bus mastering), the 
DAQ-PnP chip for Plug and Play configuration, the DAQ-STC ch
for instrumentation class counting and timing, and the NI-PGIA f
high accuracy analog input measurements.

EEPROM Electrically erased programmable read-only memory. Read-on
memory that you can erase with an electrical signal and reprogra

EISA Extended Industry Standard Architecture. 

event The condition or state of an analog or digital signal.

external trigger A voltage pulse from an external source that triggers an event 
as A/D conversion. 

F

FIFO A first-in-first-out memory buffer. In a FIFO, the first data store
is the first data sent to the acceptor. 
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filtering A type of signal conditioning that allows you to filter unwanted 
signals from the signal you are trying to measure.

floating signal sources Signal sources with voltage signals that are not connected to
absolute reference or system ground. Some common example 
floating signal sources are batteries, transformers, or 
thermocouples. Also called nonreferenced signal sources. 

G

gain The amplification or attenuation of a signal.

GATE input pin A counter input pin that controls when counting in your applicati
occurs.

grounded measurement See referenced single-ended measurement system.
system

grounded signal sources Signal sources with voltage signals that are referenced to a s
ground, such as the earth or a building ground. Also called 
referenced signal sources

group A collection of input or output channels or ports that you define
Groups can contain analog input, analog output, digital input, 
digital output, or counter/timer channels. A group can contain on
one type of channel, however. You use a task ID number to refe
a group after you create it. You can define up to 16 groups at o
time. 

To erase a group, you pass an empty channel array and the gr
number to the group configuration VI. You do not need to erase
group to change its membership. If you reconfigure a group who
task is active, LabVIEW clears the task and returns a warning. 
LabVIEW does not restart the task after you reconfigure the gro

H

handle Pointer to a pointer to a block of memory; handles reference ar
and strings. An array of strings is a handle to a block of memor
containing handles to strings.
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handshaked digital I/O A type of digital acquisition/generation where a device or mod
accepts or transfers data after a digital pulse has been received.Also 
called latched digital I/O.

hardware triggering A form of triggering where you set the start time of an acquisi
and gather data at a known position in time relative to a trigger
signal. 

hex Hexadecimal. 

Hz Hertz. The number of scans read or updates written per second

I

IEEE Institute of Electrical and Electronic Engineers. 

immediate digital I/O A type of digital acquisition/generation where LabVIEW update
the digital lines or port states immediately or returns the digital 
value of an input line. Also called nonlatched digital I/O.

input limits The upper and lower voltage inputs for a channel. You must us
pair of numbers to express the input limits. The VIs can infer th
input limits from the input range, input polarity, and input gain(s
Similarly, if you wire the input limits, range, and polarity, the VIs
can infer the onboard gains when you do not use SCXI.

input range The difference between the maximum and minimum voltages 
analog input channel can measure at a gain of 1. The input rang
a scalar value, not a pair of numbers. By itself the input range d
not uniquely determine the upper and lower voltage limits. An inp
range of 10 V could mean an upper limit of +10 V and a lower o
0 V or an upper limit of +5 V and a lower limit of –5 V.

The combination of input range, polarity, and gain determines t
input limits of an analog input channel. For some boards, jump
set the input range and polarity, while you can program them fo
other boards. Most boards have programmable gains. When you
SCXI modules, you also need their gains to determine the inpu
limits.

interrupt A signal indicating that the central processing unit should susp
its current task to service a designated activity. 
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interval scanning Scanning method where there is a longer interval between sc
than there is between individual channels comprising a scan.

I/O Input/output. The transfer of data to or from a computer system
involving communications channels, operator interface devices
and/or data acquisition and control interfaces. 

ISA Industry Standard Architecture. 

isolation A type of signal conditioning in which you isolate the transduce
signals from the computer for safety purposes. This protects yo
and your computer from large voltage spikes and makes sure t
measurements from the DAQ device are not affected by differen
in ground potentials.

K

Kwords 1,024 words of memory. 

L

Lab/1200 boards Boards, such as the Lab-PC-1200 and the DAQCard-1200, w
use the 8253 type counter/timer chip.

LabVIEW Laboratory Virtual Instrument Engineering Workbench.

latched digital I/O A type of digital acquisition/generation where a device or mod
accepts or transfers data after a digital pulse has been received.Also 
called handshaked digital I/O.

Legacy MIO board Boards, such as the AT-MIO-16, which typically are configure
with jumpers and switches and are not Plug and Play compatib
They also use the 9513 type counter/timer chip.

limit settings The maximum and minimum voltages of the analog signals you
measuring or generating.

linearization A type of signal conditioning in which LabVIEW linearizes the 
voltage levels from transducers, so the voltages can be scaled 
measure physical phenomena.

LSB Least Significant Bit. 
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MB Megabytes of memory. 1 MB is equal to 1,024 KB.

memory buffer See buffer. 

multibuffered I/O Input operation for which you allocate more than one memory 
buffer so you can read and process data from one buffer while 
acquisition fills another. 

multiplexed mode An SCXI operating mode in which analog input channels are 
multiplexed into one module output so that your cabled DAQ 
device has access to the module’s multiplexed output as well as
outputs on all other multiplexed modules in the chassis through 
SCXI bus. Also called serial mode.

multiplexer A set of semiconductor or electromechanical switches with a 
common output that can select one of a number of input signals 
that you commonly use to increase the number of signals measu
by one ADC. 

N

NB NuBus.

NI-DAQ The NI-DAQ configuration utility on the Macintosh.

NI-PNP.EXE A stand-alone executable that NI-DAQ installs in your NI-DAQ 
root drive that detects and configures any Plug and Play device
you have in your computer.

NI-PNP.INI A file, generated by the NI-PNP.EXE , that contains information 
about all the National Instruments devices in your computer, 
including Plug and Play devices.

nodes Execution elements of a block diagram consisting of functions
structures, and subVIs.

nonlatched digital I/O A type of digital acquisition/generation where LabVIEW updat
the digital lines or port states immediately or returns the digital 
value of an input line. Also called immediate digital I/O.
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non-referenced signal Signal sources with voltage signals that are not connected to
sources absolute reference or system ground. Also called floating signal 

sources. Some common example of non-referenced signal sou
are batteries, transformers, or thermocouples.

NRSE Nonreferenced single-ended. 

Non-referenced All measurements are made with respect to a common
single-ended (NRSE) reference, but the voltage at this reference can vary with resp
measurement system to the measurement system ground.

O

onboard channels Channels provided by the plug-in data acquisition board. 

OUT output pin A counter output pin where the counter can generate various T
pulse waveforms.

output limits The upper and lower voltage or current outputs for an analog ou
channel. The output limits determine the polarity and voltage 
reference settings for a board.

P

parallel mode A type of SCXI operating mode in which the module sends eac
its input channels directly to a separate analog input channel of
device to the module.

pattern generation A type of handshaked (latched) digital I/O in which internal 
counters generate the handshaked signal, which in turn initiate
digital transfer. Because counters output digital pulses at a cons
rate, this means you can generate and retrieve patterns at a con
rate because the handshaked signal is produced at a constant 

PGIA Programmable Gain Instrumentation Amplifier. 

Plug and Play devices Devices that do not require dip switches or jumpers to config
resources on the devices. Also called switchless devices.

postriggering The technique you use on a data acquisition board to acquire 
programmed number of samples after trigger conditions are me
© National Instruments Corporation G-11 LabVIEW Data Acquisition Basics Manual
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pretriggering The technique you use on a data acquisition board to keep a 
continuous buffer filled with data, so that when the trigger 
conditions are met, the sample includes the data leading up to 
trigger condition. 

pulse trains Multiple pulses.

pulsed output A form of counter signal generation by which a pulse is outpu
when a counter reaches a certain value.

R

read mark Points to the scan at which a read operation begins. Analogous
file I/O pointer, the read mark moves every time you read data fro
an input buffer. After the read is finished, the read mark points 
the next unread scan. Because multiple buffers are possible, yo
need both the buffer number and the scan number to express t
position of the read mark. 

read mode Indicates one of the four reference marks within an input buffer 
provides the reference point for the read. This reference can be
read mark, the beginning of the buffer, the most recently acquir
data, or the trigger position. 

referenced signal sources Signal sources with voltage signals that are referenced to a 
ground, such as the earth or a building ground. Also called 
grounded signal sources.

referenced single-ended All measurements are made with respect to a common refer
(RSE) measurement system or a ground. Also called a grounded measurement system.

RMS Root Mean Square. 

row-major order A way to organize the data in a 2D array by rows. 

RSE Referenced Single-Ended. 

RTD Resistance Temperature Detector. A temperature-sensing devi
whose resistance increases with increases in temperature.

RTSI Real-Time System Integration bus. The National Instruments 
timing bus that interconnects data acquisition boards directly, b
means of connectors on top of the boards, for precise 
synchronization of functions. 
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run_me.llb A LabVIEW DAQ VI library containing VIs that perform basic 
operations concerning analog I/O, digital I/O, and counters.

S

sample A single (one and only one) analog or digital input or output 
data point.

sample counter The clock that counts the output of the channel clock, in othe
words, the number of samples taken. On boards with simultane
sampling, this counter counts the output of the scan clock and he
the number of scans.

scan One or more analog or digital input samples. Typically, the num
of input samples in a scan is equal to the number of channels n
input group. For example, one pulse from the scan clock produ
one scan which acquires one new sample from every analog in
channel in the group.

scan clock The clock controlling the time interval between scans. On boa
with interval scanning support (for example, the AT-MIO-16F-5
this clock gates the channel clock on and off. On boards with 
simultaneous sampling (for example, the EISA-A2000), this cloc
clocks the track-and-hold circuitry.

scan rate The number of times (or scans) per second that LabVIEW acqu
data from channels. For example, at a scan rate of 10Hz, LabVIE
samples each channel in a group 10 times per second.

scan width The number of channels in the channel list or number of ports in
port list you use to configure an analog or digital input group.

SCXI Signal Conditioning eXtensions for Instrumentation. The Nation
Instruments product line for conditional low-level signals within a
external chassis near sensors, so only high-level signals in a n
environment are sent to data acquisition boards. 

scxi_ai.llb A LabVIEW DAQ library containing VIs specific to analog input
SCXI modules.

scxi_ao.llb A LabVIEW DAQ library containing VIs specific to analog outpu
SCXI modules.
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scxi_dig.llb A LabVIEW DAQ library containing VIs specific to digital 
SCXI modules.

sec Seconds. 

settling time The amount of time required for a voltage to reach its final val
within specified limits. 

signal conditioning The manipulation of signals to prepare them for digitizing.

signal divider Performing frequency division on an external signal.

simple-buffered I/O Input/output operation that uses a single memory buffer big eno
for all of your data. LabVIEW transfers data into or out of this 
buffer at the specified rate, beginning at the start of the buffer a
stopping at the end of the buffer. You use simple buffered I/O wh
you acquire small amounts of data relative to memory constrain

single-ended inputs Analog inputs that you measure with respect to a common gro

software trigger A programmed event that triggers an event such as data acquis

software triggering A method of triggering in which you to simulate an analog trig
using software. Also called conditional retrieval.

SOURCE input pin An counter input pin where the counter counts the signal 
transitions.

STC System Timing Controller.   

strain gauge A thin conductor, which is attached to a material, that detects s
or vibrations in that material.

subVI VI used in the block diagram of another VI; comparable to a 
subroutine.

switchless device Devices that do not require dip switches or jumpers to configu
resources on the devices. Also called Plug and Play devices.

syntax The set of rules to which statements must conform in a particu
programming language. 
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task A timed I/O operation using a particular group. See task ID.

task ID A number generated by LabVIEW, which identifies to the NI-DA
drive the task at hand.

The following table gives the function code definitions.

TC Terminal count. The highest value of a counter.

toggled output A form of counter signal generation by which the output chang
the state of the output signal from high to low, or low to high whe
the counter reaches a certain value.

top-level VI VI at the top of the VI hierarchy. This term is used to distinguis
the VI from its subVIs.

track-and-hold A circuit that tracks an analog voltage and holds the value on 
command. 

transducer excitation A type of signal conditioning that uses external voltages and 
currents to excite the circuitry of a signal conditioning system in
measuring physical phenomena.

trigger Any event that causes or starts some form of data capture.

U

unipolar A signal range that is either always positive or negative, but ne
both (for example 0 to 10 V, not –10 to 10 V).

Function Code I/O Operation

1 analog input 

2 analog output

3 digital port I/O

4 digital group I/O

5 counter/timer I/O
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update One or more analog or digital output samples. Typically, the 
number of output samples in an update is equal to the number 
channels in the output group. For example, one pulse from the 
update clock produces one update which sends one new samp
every analog output channel in the group.

update rate The number of output updates per second.

update width The number of channels in the channel list or number of ports in
port list you use to configure an analog or digital output group.

V

V Volts.

VDC Volts, Direct Current. 

VI Virtual Instrument. A LabVIEW program; so called because it 
models the appearance and function of a physical instrument.

Vref Voltage reference. 

W

waveform Multiple voltage readings taken at a specific sampling rate. 

NIDAQCFG.EXE The NI-DAQ configuration utility in Windows.

wire Data path between nodes.

write mark Points to the update at which a write operation begins. Analog
to a file I/O pointer, the write mark moves every time you write da
into an output buffer. After the write is finished, the write mark 
points to the next update to be written. Because multiple buffers 
possible, you need both the buffer number and the update num
to express the position of the write mark. 
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Numbers
8253/8254 chip, 23-4

A
ACK (Acknowledge Input) line, 17-2
ACK (Acknowledge) line, 17-2
Acquire & Proc N Scans example VI, 7-10, 8-9
Acquire & Proc N Scans-Trig example VI, 8-5, 

8-9
Acquire 1 Point from 1 Channel VI, 6-2
Acquire and Average VI, 21-7 to 21-8
Acquire N Scans Analog Hardware Trig 

example VI, 8-7 to 8-9
Acquire N Scans Analog Software Trig example 

VI, 8-12
Acquire N Scans Digital Trig example VI, 

8-3 to 8-5
Acquire N Scans example VI, 7-4, 7-6
Acquire N Scans ExtChanClk example VI, 9-3
Acquire N Scans-DTrig example VI, 8-5
Acquire N Scans-ExtScanClk example VI, 9-6
Acquire N-Multi-Analog Hardware Trig VI, 8-9
Acquire N-multi-DTrig example VI, 8-5
Acquire N-multi-Start example VI, 7-7
acquisition rate. See external control of 

acquisition rate.
ADC

limit settings effects (figure), 5-6
measurement precision for various device 

ranges and limit settings (table), 5-8
range effects (figure), 5-5
resolution, 5-3 to 5-4

effects on precision (figure), 5-4
adjacent counters for counter chips (table), 

27-2 to 27-3

Advanced VIs. See also VIs.
analog output SCXI example, 

21-16 to 21-17
external control of channel clock, 9-4
non-buffered handshaking, 17-5
overview, 3-5
simple buffered handshaking, 17-7 to 17-9

AI Acquire Waveform VI
simple-buffered analog input with multiple 

starts, 7-7 to 7-8
single-waveform acquisition, 7-2 to 7-3

AI Acquire Waveforms VI
multiple-waveform acquisition, 7-3 to 7-4
simple-buffered analog input with graphing

7-5 to 7-6
AI Clear VI

asynchronous continuous acquisition 
(figure), 7-12

continuous acquisition from multiple 
channels (figure), 7-11

hardware-timed analog I/O control 
loops, 6-9

multiple-waveform acquisition, 7-4
SCXI temperature measurement, 

21-8 to 21-9
simple-buffered analog input with multiple 

starts (figure), 7-7
simultaneous buffered waveform 

acquisition and generation, 14-2
AI Clock Config VI

external control of channel clock, 9-4
external conversion pulses, 9-4
scan clock control, 9-6 to 9-7

AI Config VI
asynchronous continuous acquisition 

(figure), 7-12
isition Basics Manual
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, 
basic circular-buffered analog input, 
7-13 to 7-14

basic non-buffered application, 6-4
hardware-timed analog I/O control loops, 

6-8 to 6-10
interchannel delay, 9-3
multiple-channel single-point analog 

input, 6-5
multiple-waveform acquisition, 7-4
one-point calibration, 22-5
simple-buffered analog input with 

multiple starts (figure), 7-7
simultaneous buffered waveform 

acquisition and generation, 14-2
AI Continuous Scan VI, 7-11
AI Control VI, 9-6 to 9-7
AI Read One Scan VI, 6-7
AI Read VI

advantages and disadvantages of reading 
backlog, A-1

asynchronous continuous acquisition 
(figure), 7-12

basic circular-buffered analog input, 
7-13 to 7-14

conditional retrieval cluster, 8-10 to 8-11
continuous acquisition from multiple 

channels (figure), 7-11
controlling startup times (note), 7-8
multiple-waveform acquisition, 7-4
one-point calibration, 22-5
SCXI temperature measurement, 

21-8 to 21-9
simple-buffered analog input with 

multiple starts, 7-7 to 7-8
simultaneous buffered waveform 

acquisition and generation, 14-2
AI Sample Channel VI

multiple-channel single-point analog 
input, 6-3

single-channel single-point analog input, 
6-1 to 6-2

temperature measurement 
application, 21-4

AI Single Scan VI
basic non-buffered application, 6-4
hardware-timed analog I/O control loops

6-8 to 6-9
improving control loop performance, 6-9
multiple-channel single-point analog 

input, 6-4
one-point calibration, 22-5
software-timed analog I/O control 

loops, 6-6
AI Start VI

asynchronous continuous acquisition 
(figure), 7-12

basic circular-buffered analog input, 
7-13 to 7-14

continuous acquisition from multiple 
channels (figure), 7-11

hardware-timed analog I/O control 
loops, 6-9

multiple-waveform acquisition, 7-4
one-point calibration, 22-5
SCXI temperature measurement, 

21-8 to 21-9
simple-buffered analog input with 

multiple starts, 7-7 to 7-8
simultaneous buffered waveform 

acquisition and generation
E-Series MIO boards, 14-2, 14-3
legacy MIO boards, 14-6

AI/AO Buffered HW Trigger (E-series MIO) 
example VI, 14-3 to 14-4

AI/AO Buffered HW Trigger (legacy MIO) 
example VI, 14-6

AI/AO Buffered SW Trigger (E-series MIO) 
example VI, 14-1 to 14-3

AI/AO Buffered SW Trigger (legacy MIO) 
example VI, 14-4 to 14-5

Am9513 chip, 23-4
amplification

increasing signal-to-noise ratio 
(figure), 18-4

methods for minimizing noise 
(note), 18-4
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signal conditioning, 18-3 to 18-4
amplifier offset, reading, 21-5
AMUX-64T devices

addressing with MIO boards, A-1
analog input channel range (table), 5-14
channel addressing with 

AMUX-64T, 5-14
scanning order for DAQ devices, 

5-15 to 5-18
four AMUX-64Ts (table), 5-17
one or two AMUX-64Ts (table), 5-16

specifying number for AMUX-64T 
device (table), 5-18

analog input
AMUX-64T external multiplexer device, 

5-14 to 5-18
analog input/output control loops. See 

analog input/output control loops.
channel clock control, 9-3 to 9-5, 9-8
circular-buffered analog input examples, 

7-13 to 7-15
continuous acquisition from multiple 

channels, 7-10 to 7-11
defining signals, 5-1 to 5-3
digital triggering, 8-2 to 8-5
external control of acquisition rate, 

9-1 to 9-3
hardware triggering, 8-1 to 8-9
measurement systems, 5-3 to 5-6
multiple waveform acquisition, 7-3 to 7-5
multiple-channel single point analog 

input, 6-3 to 6-6
scan clock control, 9-5 to 9-8
SCXI applications

RTDs for measuring temperature 
(example), 21-10 to 21-13

strain gauges for measuring 
temperature (example), 
21-13 to 21-16

thermocouples for measuring 
temperature (example), 
21-2 to 21-9

selecting input settings, 5-6 to 5-13
calculating code width, 5-6 to 5-7
considerations for selecting, 

5-6 to 5-13
differential measurement system, 

5-9 to 5-11
measurement precision for various 

device ranges and limit settings 
(table), 5-8

nonreferenced single-ended 
measurement system, 5-12 to 5-13

referenced single-ended 
measurement system, 5-11 to 5-12

signals. See analog input signals.
single waveform acquisition, 7-2 to 7-3
single-buffered analog input examples, 

7-5 to 7-8
single-channel single point analog input,

6-1 to 6-2
software triggering, 8-9 to 8-12
terminology, 5-17
triggering, 8-5 to 8-9

analog input SCXI modules
multiplexed mode, 19-4 to 19-6
parallel mode, 19-6 to 19-7

analog input signals
choosing a measurement system, 

5-3 to 5-6
choosing between analog and digital 

signals, 4-3
defining signals, 5-1 to 5-3
device voltage range, 5-4 to 5-5
floating signal sources, 5-3
grounded signal sources, 5-2
referenced and non-referenced, 5-2
resolution of ADC, 5-3 to 5-4
signal voltage range (limit settings), 

5-5 to 5-6
types of analog signals (figure), 5-1

analog input with LabVIEW. See AMUX-64T 
devices.
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analog input/output control loops, 6-6 to 6-11
hardware-timed control loops, 6-8 to 6-10
improving performance, 6-10 to 6-11
overview, 6-6
software-timed control loops, 6-6 to 6-7

Analog IO Control Loop (hw timed) VI, 6-8
Analog IO Control Loop VI, 6-7
analog output

buffered analog output
circular-buffered output, 

12-3 to 12-5
overview, 10-1 to 10-2
waveform generation, 12-1 to 12-3

multiple-immediate updates, 11-3
SCXI analog output application example, 

21-16 to 21-17
single-immediate updates, 11-1 to 11-2
single-point output, 10-1

analog output SCXI modules, 19-6
analog triggering

description, 8-5 to 8-7
diagram, 8-6
examples, 8-7 to 8-9
using DAQ device (figure), 8-7

analog-to-digital converter (ADC). See ADC.
anlogin.llb example file, 3-2
anlog_io.llb example file, 3-2
anlogout.llb example file, 3-2
AO Clear VI

circular-buffered output, 12-4 to 12-5
simultaneous buffered waveform 

acquisition and generation, 14-2
waveform generation, 12-3

AO Config VI
analog output SCXI example, 

21-16 to 21-17
circular-buffered output, 12-4 to 12-5
simultaneous buffered waveform 

acquisition and generation, 14-2
waveform generation, 12-3

AO Continuous Gen VI, 12-3 to 12-4
AO Generate Waveforms VI, 12-1
AO Group Config VI, 21-16 to 21-17

AO Hardware Config VI, 21-16 to 21-17
AO Single Update VI

analog output SCXI example, 21-17
calibrating SCXI modules for signal 

generation, 22-8
AO Start VI

circular-buffered output, 12-4 to 12-5
simultaneous buffered waveform 

acquisition and generation
E-Series MIO boards, 14-2
legacy MIO boards, 14-5

waveform generation, 12-3
AO Trigger and Gate Config VI, 14-3
AO Update Channels VI, 11-1 to 11-2
AO Wait VI, 12-3
AO Waveform Gen VI, 12-2
AO Write One Update VI

multiple-immediate updates, 11-3
single-immediate updates, 11-2
software-timed analog I/O, 6-7

AO Write VI
circular-buffered output, 12-4 to 12-5
simultaneous buffered waveform 

acquisition and generation, 14-2
waveform generation, 12-3

arrays
transposing, 7-6
two-dimensional (2D) arrays, 

3-14 to 3-16
asynchronous continuous acquisition using 

DAQ Occurrences, 7-11 to 7-12

B
breakpoints, setting, 29-4
buffered analog input, 7-1 to 7-15

circular-buffered
asynchronous continuous acquisition

using DAQ Occurrences, 
7-11 to 7-12

continuous acquisition from multiple 
channels, 7-10 to 7-11
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determining adequate buffer 
capacity, A-2

examples
basic circular-buffered analog 

input, 7-13 to 7-14
Cont Acq to File (scaled).vi, 

7-15
Cont Acq to Spreadsheet File.vi, 

7-15
Cont Acq&Chart (buffered).vi, 

7-14
Cont Acq&Graph (buffered).vi, 

7-14
overview, 7-9 to 7-10

how buffers work, 7-2
simple-buffered

data buffer overview, 7-1 to 7-2
examples

displaying waveforms on 
graphs, 7-5 to 7-6

sampling with multiple starts, 
7-7 to 7-8

writing to spreadsheet file, 7-8
multiple-waveform acquisition, 

7-3 to 7-5
single-waveform acquisition, 

7-2 to 7-3
waiting to analyze data, 7-1 to 7-2

buffered analog output
choosing between single-point or 

multiple-point generation, 4-4
waveform generation, 12-1 to 12-3

circular-buffered output, 
12-3 to 12-5

eliminating errors from 
circular-buffered applications, 12-5

examples, 12-5 to 12-6
overview, 10-1 to 10-2

buffered handshaking, 17-6 to 17-10
circular buffered examples, 17-9 to 17-10
simple buffered examples, 17-7 to 17-9

buffered simultaneous waveform acquisition
and generation

E-Series MIO boards, 14-1 to 14-4
hardware triggered, 14-3 to 14-4
software triggered, 14-1 to 14-3

legacy MIO boards, 14-4 to 14-6
hardware triggered, 14-6
software triggered, 14-4 to 14-5

bulletin board support, B-1

C
calibration. See SCXI calibration.
cascading counters, 26-3, 27-2
channel addressing

AMUX-64T devices, 5-14
SCXI modules, 20-1 to 20-2
VI channel, port, and counter addressing

3-8 to 3-9
channel clock, 9-3 to 9-5

channel and scan intervals using channe
clock (figure), 9-1

considerations for specific boards (notes
9-5

controlling externally, 9-3 to 9-5
rate parameter, 5-18
setting channel clock rate, 9-3
simultaneous control of scan and channe

clocks, 9-8
TTL signal (example), 9-3

channel configuration, Windows 
environment, 2-12

circular buffered digital I/O examples, 
17-9 to 17-10

circular-buffered analog input
continuous acquisition from multiple 

channels, 7-10 to 7-11
examples

basic circular-buffered analog input,
7-13 to 7-14

Cont Acq to File (scaled).vi, 7-15
Cont Acq to Spreadsheet File.vi, 

7-15
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Cont Acq&Chart (buffered).vi, 7-14
Cont Acq&Graph (buffered).vi, 7-14

how circular buffers work (figure), 7-9
overview, 7-9 to 7-10

circular-buffered analog output
changing waveform during generation, 

12-3 to 12-5
eliminating errors, 12-5

clocks. See channel clock; scan clock; update 
clock.

code width, calculating, 5-6 to 5-7
cold junction compensation, 21-3 to 21-4
column major order, 3-15 to 3-16
common questions about LabVIEW data 

acquisition, A-1 to A-4
common-mode voltage

definition, 5-11
illustration, 5-11

conditional retrieval
definition of, 8-9
timeline of conditional retrieval 

(figure), 8-10
conditional retrieval cluster of AI Read VI, 

8-10 to 8-11
Cont Acq to File (scaled).vi, 7-15, 12-6
Cont Acq to Spreadsheet File.vi, 7-15
Cont Acq&Chart (buffered).vi, 7-14
Cont Acq&Graph (buffered).vi, 7-14
Cont Acquire&Chart (immediate).vi, 6-5
continuous acquisition

asynchronous, using DAQ Occurrences, 
7-11 to 7-12

from multiple channels, 7-10 to 7-11
Continuous Generation example VI, 12-4
Continuous Pulse Generator Config VI, 

24-6, 24-8
Continuous Transducer Measurement VI, 21-6
control loops. See analog input/output control 

loops.
Convert RTD Reading VI, 21-12 to 21-13
Convert Strain Gauge Reading VI, 

21-15 to 21-16

Convert Thermocouple Reading VI, 21-8
Count Events or Time VI, 27-3 to 27-5
counter addressing for VIs, 3-8 to 3-9
Counter Read VI

controlling pulse width measurement, 
25-3 to 25-4

measuring frequency and period
high frequency signals, 26-6
low frequency signals, 26-4 to 26-5

Counter Start VI
controlling pulse width measurement, 

25-3 to 25-4
dividing frequencies, 28-2
finite pulse train generation, 24-8
measuring frequency and period

high frequency signals, 26-6
low frequency signals, 26-4 to 26-5

single square pulse generation, 24-4
Counter Stop VI

controlling pulse width measurement, 
25-3 to 25-4

counting external events, 27-5 to 27-6
dividing frequencies, 28-2
measuring frequency and period

high frequency signals, 26-6
low frequency signals, 26-4 to 26-5

stopping counter generations, 24-9
counter.llb example file, 3-2
counters

accuracy of counters, 24-8 to 24-9
basic model (figure), 23-2
capabilities, 23-1
choosing between counting methods, 4-
choosing between digital or counter 

interfacing, 4-3 to 4-4
counter chips used in National 

Instruments devices, 23-4
counting signal highs and lows, 

27-1 to 27-3
dividing frequencies, 28-2 to 28-3
events or elapsed time counting, 

27-1 to 27-5
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frequency and period measurement, 
26-1 to 26-7

connecting counters for measuring, 
26-2 to 26-3

high frequency signals, 26-5 to 26-7
how and when to measure, 

26-1 to 26-2
low frequency signals, 26-4 to 26-5

gaining more control over counting 
operations, 27-5 to 27-6

gating levels (figure), 23-3
parts of counters, 23-2 to 23-4
pulse train generation, 24-5 to 24-8

continuous pulse train, 24-5 to 24-7
finite pulse train, 24-7 to 24-8

pulse width measurement, 25-1 to 25-4
controlling pulse width 

measurement, 25-3 to 25-4
determining pulse width, 

25-2 to 25-3
increasing measurable width 

range, 25-4
square pulse generation, 24-1 to 24-5

single square pulse generation, 
24-3 to 24-5

square wave generation with no counters 
available, 23-5

stopping counter generations, 
24-9 to 24-30

timebase uncertainty, 24-8 to 24-9
CTR Control VI

enabling and disabling FOUT signal, 23-5
measuring frequency and period, 26-6

CTR Mode Config VI, 23-3
current setting for VIs, 3-6 to 3-7
current value conventions for VIs, 3-6 to 3-7
customer communication, xxii, B-1 to B-2

D
daisy chaining SCXI chassis, 21-20 to 21-21
DAQ examples

list of example files, 3-2
locations, 3-1 to 3-2

DAQ hardware. See hardware.
DAQ Occurrence Config VI, 7-12
DAQ Occurrences, for asynchronous 

continuous acquisition, 7-11 to 7-12
DAQ VIs. See VIs.
DAQ-STC chip, 23-4
data acquisition. See also analog input.

analog input/output control loops, 
6-6 to 6-11

basic LabVIEW data acquisition 
concepts, 3-1 to 3-16. See also VIs.

data organization for analog 
applications, 3-14 to 3-16

limit settings, 3-11 to 3-14
location of common DAQ examples,

3-1 to 3-2
buffered. See buffered analog input.
common questions about LabVIEW data

acquisition, A-1 to A-4
important terms, 5-18
multiple-channel single-point, 6-3 to 6-6
single-channel single-point, 6-1 to 6-2
triggered. See triggered data acquisition.

data acquisition hardware. See hardware.
Data Acquisition palette, 3-4
data organization for analog applications, 

3-14 to 3-16
column major order, 3-15 to 3-16
row major order, 3-14 to 3-15
two-dimensional (2D) arrays, 

3-14 to 3-16
data types for LabVIEW, xxii-xxiii
debugging VIs, 29-1 to 29-4

error handling, 29-2 to 29-3
execution highlighting, 29-4
hardware connection errors, 29-1
setting breakpoints and showing 

advanced DAQ VIs, 29-4
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single-stepping through VIs, 29-3
software configuration errors, 29-2
using Probe tool, 29-4
VI construction errors, 29-2 to 29-4

default input for VIs, 3-6
default setting for VIs, 3-6
Delayed Pulse Generator Config VI

finite pulse train generation, 24-8
measuring frequency and period, 26-6
single square pulse generation, 24-4

delays for improving control loop 
performance, 6-10 to 6-11

device configuration. See installation and 
configuration.

device voltage range, 5-4 to 5-5
considerations for selecting analog input 

settings, 5-6 to 5-8
description, 5-4 to 5-5
effect on ADC precision (figure), 5-5
measurement precision for various device 

ranges and limit settings (table), 5-8
differential measurement system, 5-9 to 5-11

channel differential system (figure), 5-10
common mode voltage (figure), 5-11
when to use, 5-11

digio.llb example file, 3-2
digital and relay SCXI modules, 19-6
Digital Buffered Handshaking example VI, 

17-7
Digital Clock Config VI, 17-7 to 17-8
digital I/O

buffered handshaking, 17-6 to 17-10
choosing between digital or counter 

interfacing, 4-3 to 4-4
choosing between non-latched or latched 

digital I/O, 4-5
handshaking (latched) digital I/O, 

17-1 to 17-2
immediate (non-latched) digital I/O, 

16-1 to 16-3
non-buffered handshaking, 17-5 to 17-6
overview, 15-1 to 15-2

SCXI application examples
digital input, 21-17 to 21-18
digital output, 21-19 to 21-20

sending out multiple digital values, 
17-2 to 17-4

Digital Mode Config VI, 17-8
digital ports and lines, 15-1. See also ports.
digital SCXI modules, 19-7
digital triggering

definition, 8-2
description, 8-2 to 8-3
examples, 8-3 to 8-5

DIO Buffer Control VI, 17-7 to 17-9
DIO Clear VI, 17-7
DIO Config VI, 17-8
DIO Group Config VI, 17-5
DIO Port Config VI

digital input application example, 21-18
digital output application example, 21-19
immediate digital I/O, 16-2

DIO Single Read/Write VI, 17-5 to 17-6
DIO Start VI, 17-7 to 17-8
DIO Wait VI, 17-7
Display and Output Acq'd File (scaled) 

example VI, 12-5 to 12-6
Divide Config VI, 28-2
dividing frequencies. See frequency division.
documentation

conventions used in manual, xxi-xxiii
flowchart for finding information, 4-2
how to use this book, 1-1 to 1-4
organization of manual, xix-xxi
related documentation, xxii

down counter, 28-1
Down Counter VI, 28-2

E
E Series Calibrate VI (note), 22-5
Easy VIs. See also VIs.

addressing OUT and IN pins on DIO-32F
board, A-2

continuous pulse train generation, 24-6
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counting events or elapsed time, 
27-3 to 27-5

digital input application, 21-17
digital output application, 21-19 to 21-20
finite pulse train generation, 24-7
grouping two or more ports, A-2
immediate digital I/O, 16-1 to 16-2
limitations, 6-3
measuring frequency and period

high frequency signals, 26-5 to 26-6
low frequency signals, 26-4

multiple-channel single-point analog 
input, 6-3 to 6-4

multiple-immediate updates, 11-3
multiple-waveform acquisition, 

7-3 to 7-4
overview, 3-4 to 3-5
single square pulse generation, 24-4
single-channel single-point analog input, 

6-1 to 6-2
single-immediate updates, 11-1 to 11-2
single-waveform acquisition, 7-2 to 7-3
strain gauge application, 21-15
waveform generation, 12-1 to 12-2

edges of signals, 23-2
EEPROM for storing calibration constants, 

22-1 to 22-3
default load area, 22-2
factory area, 22-2
user area, 22-2 to 22-3

elapsed time counting. See events or elapsed 
time counting.

electronic support services, B-1 to B-2
e-mail support, B-2
Error Handler VIs, 29-2 to 29-3
error handling

debugging VIs, 29-2 to 29-3
VIs, 3-8

E-Series MIO boards
hardware triggered waveform acquisition 

and generation, 14-3 to 14-4
software triggered waveform acquisition 

and generation, 14-1 to 14-3

Event or Time Counter Config VI
counting external events, 27-5 to 27-6
measuring frequency and period, 26-6

events or elapsed time counting, 27-1 to 27-
adjacent counters for counter chips 

(table), 27-2 to 27-3
cascading counters, 27-2
connecting counters to device 

(figure), 27-1
counting events or elapsed time, 

27-3 to 27-5
gaining more control over counting 

operations, 27-5 to 27-6
overview, 27-1 to 27-3

execution highlighting, 29-4
external control of acquisition rate, 9-1 to 9-8

channel and scan intervals using channe
clock (figure), 9-1

channel clock control, 9-3 to 9-5
choosing between triggering and externa

clock control, 4-4
description, 9-1 to 9-3
round-robin scanning (figure), 9-2
scan clock control, 9-5 to 9-8
simultaneous control of scan and channe

clocks, 9-8
external control of update rate, 13-1 to 13-3

creating external test clock, 13-3
Generate N Updates-ExtUpdateClk 

example VI, 13-1 to 13-2
input pins for external update clock 

(table), 13-2
external conversion pulses, 9-4 to 9-5

F
fax and telephone support, B-2
Fax-on-Demand support, B-2
filtering, 18-5
floating signal sources, 5-3
FOUT output, 23-5, 25-4
FREQ_OUT output, 23-5, 25-4
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frequency and period measurement, 
26-1 to 26-7

cascading counters, 26-3
connecting counters for measuring, 

26-2 to 26-3
equation for obtaining 

measurements, 26-2
high frequency signals, 26-5 to 26-7
how and when to measure, 26-1 to 26-2
low frequency signals, 26-4 to 26-5
physical connections for period 

measurement
high frequency signals (figure), 26-3
low frequency signals (figure), 26-3

square wave period measurement 
(figure), 26-2

frequency division, 28-1 to 28-3
FTP support, B-1
Function Generator VI, 12-5
Functions palette

illustration, 3-3
locating VIs, 3-2

G
gain, definition, 3-13
gains (SCXI)

description, 20-2 to 20-5
SCXI-1100 channel arrays, input limits 

array, and gains (table), 20-4
GATE input, 23-2 to 23-3
GATE input pin, 23-2
gating levels (figure), 23-3
General Error Handler VI, 29-2 to 29-3
Generate 1 Point on 1 Channel example VI, 

11-1 to 11-2
Generate Continuous Sinewave example 

VI, 12-3
Generate Delayed Pulse VI, 24-4, 24-9
Generate N Updates example VI, 12-2
Generate N Updates-ExtUpdateClk example 

VI, 13-1 to 13-2

Generate Pulse Train on FOUT or FREQ-OU
example VI, 13-3, 23-5

Generate Pulse Train VI
continuous pulse train generation, 24-6
finite pulse train generation, 24-7 to 24-8
stopping counter generations, 

24-9 to 24-10
Get DAQ Device Information VI, 2-1
Getting Started Analog Input example VI

channel clock control, 9-4
reading amplifier offset, 21-5
reading channels from different SCXI 

chassis, 21-21
scan clock control, 9-7
temperature sensor, 21-4

Getting Started Counters VI, 27-3
graphing simple-buffered analog input 

(example), 7-5 to 7-6
grounded signal sources, 5-2

H
handshaking (latched) digital I/O, 

17-1 to 17-10
buffered handshaking, 17-6 to 17-10

circular buffered examples, 
17-9 to 17-10

simple buffered examples, 
17-7 to 17-9

connecting signal lines
digital input (figure), 17-3
digital output (figure), 17-4

DAQ devices supporting digital 
handshaking, 17-1

grouping ports for DIO-32F devices 
(note), 17-4

non-buffered handshaking, 17-5 to 17-6
overview, 17-1 to 17-2
sending out multiple digital values, 

17-2 to 17-4
hardware. See also installation and 

configuration.
debugging connection errors, 29-1
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LabVIEW data acquisition hardware 
support

Macintosh systems (table), 2-5
Windows environment (table), 2-4

relationship between LabVIEW, 
NI-DAQ, and DAQ hardware 
(figure), 2-3

hardware triggering, 8-1 to 8-9
analog

description, 8-5 to 8-7
examples, 8-7 to 8-9

digital
description, 8-2 to 8-3
examples, 8-3 to 8-5

overview, 8-1
hardware-timed analog I/O control loops, 

6-8 to 6-10
How to Count VI, 27-3
How to Generate a Pulse Train (8253) 

example VI, 13-3
How to Generate Pulses and Pulse Trains 

example VI
dividing frequencies, 28-1
generating pulse train, 24-5 to 24-6
generating single square pulse, 24-3
MIO devices, 13-3

How to Measure Frequency and period 
VI, 26-3

I
IBF (Input Buffer Full) line, 17-2
immediate digital I/O, 16-1 to 16-3
immediate updates

multiple, 11-3
single, 11-1 to 11-2

initialization of data acquisition boards, A-3
Input Buffer Full (IBF) line, 17-2
input range, and input setting selection, 

5-6 to 5-8
installation and configuration

debugging software configuration 
errors, 29-2

installing and configuring DAQ devices 
(figure), 2-2

LabVIEW data acquisition hardware 
support

Macintosh systems (table), 2-5
Windows environment (table), 2-4

Macintosh systems, 2-6 to 2-8
National Instruments devices, 2-5
relationship between LabVIEW, 

NI-DAQ, and DAQ hardware 
(figure), 2-3

SCXI chassis
hardware configuration, 2-8 to 2-10
software configuration for Macintosh

systems, 2-10 to 2-12
Windows environment, 2-6

channel configuration, 2-12
Intermediate VIs. See also VIs.

advantages, 6-4, 6-5
asynchronous continuous acquisition 

using DAQ Occurrences, 7-11 to 7-12
circular-buffered output, 12-3 to 12-5
continuous acquisition from multiple 

channels, 7-10 to 7-11
continuous pulse train generation, 

24-6 to 24-7
controlling pulse width measurement, 

25-3 to 25-4
counting events or elapsed time, 

27-5 to 27-6
dividing frequencies, 28-1 to 28-2
finite pulse train generation, 24-7 to 24-8
measuring frequency and period

high frequency signals, 26-6
low frequency signals, 26-4 to 26-5

multiple-channel single-point analog 
input, 6-4 to 6-5

multiple-waveform acquisition, 
7-4 to 7-5

non-buffered handshaking, 17-5 to 17-6
overview, 3-5
SCXI temperature measurement 

examples, 21-6, 21-8 to 21-9
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simple buffered handshaking, 17-7
single square pulse generation, 

24-4 to 24-5
single-immediate updates, 11-1 to 11-2
strain gauge application, 21-15
waveform generation, 12-3

interval scanning, 5-17
isolation of transducer signals, 18-4 to 18-5

J
jumper settings, 2-5, 2-8

L
LabVIEW software

basic LABVIEW data acquisition 
concepts, 3-1 to 3-16. See also VIs.

data organization for analog 
applications, 3-14 to 3-16

location of common DAQ examples, 
3-1 to 3-2

common questions about LabVIEW, 
A-1 to A-4

data acquisition hardware support
Macintosh systems (table), 2-5
Windows environment (table), 2-4

data types, xxii-xxiii
relationship between LabVIEW, 

NI-DAQ, and DAQ hardware 
(figure), 2-3

latched digital I/O. See handshaking (latched) 
digital I/O.

legacy MIO boards
hardware triggered waveform acquisition 

and generation, 14-6
software triggered waveform acquisition 

and generation, 14-4 to 14-5
limit settings, 5-5 to 5-6

considerations for selecting analog input 
settings, 5-6 to 5-8

description, 5-5 to 5-6
effect on ADC precision (figure), 5-6

measurement precision for various devic
ranges and limit settings (table), 5-8

SCXI gains, 20-2 to 20-5
VI limit settings, 3-11 to 3-14

linearizing voltage levels, 18-5
loops. See analog input/output control loops.

M
Macintosh systems

configuring DAQ devices, 2-6 to 2-8
LabVIEW data acquisition hardware 

support (table), 2-5
NI-DAQ drivers, 2-3
SCXI chassis

hardware configuration, 2-8 to 2-9
software configuration, 2-10 to 2-12

manual. See documentation.
maximum sampling rate per channel, 7-5
Measure Frequency VI, 26-5 to 26-6
Measure Pulse Width or Period VI

determining pulse width, 25-2 to 25-3
measuring frequency and period, 26-4

measurement system
choosing, 5-3 to 5-6
differential measurement system, 

5-9 to 5-11
nonreferenced single-ended measureme

system, 5-12 to 5-13
referenced single-ended measurement 

system, 5-11 to 5-12
Microsoft Windows. See Windows 

environment.
MIO boards, for waveform acquisition and 

generation
E-Series MIO boards, 14-1 to 14-4
legacy MIO boards, 14-4 to 14-6

MIO Calibrate VI (note), 22-5
MIO Configure VI, 22-5
multiple-channel single-point analog input, 

6-3 to 6-6
multiple-immediate updates, 11-3
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multiple-waveform acquisition
choosing between single-point and 

multi-point acquisition, 4-4
procedure for acquiring, 7-3 to 7-5

multiplexed mode (SCXI)
analog input modules, 19-5 to 19-6
analog output modules, 19-6
channel addressing, 20-1 to 20-2
digital and relay modules, 19-6
SCXI-1200 (Windows), 19-5 to 19-6

My Single Scan Processing VI, 6-5

N
NI-DAQ file for Macintosh, 2-3
NI-DAQ software

deciding which driver version to use, A-4
Macintosh device drivers, 2-3
relationship between LabVIEW, 

NI-DAQ, and DAQ hardware 
(figure), 2-3

versions of NI-DAQ drivers (note), 2-1
Windows 95 device drivers, 2-3
Windows device drivers, 2-3

NIDAQ32.DLL file, 2-3
NIDAQ.DLL file, 2-3
non-buffered handshaking, 17-5 to 17-6
nonlatched digital I/O, 16-1 to 16-3
non-referenced signal sources, 5-2
nonreferenced single-ended (NRSE) 

measurement system, 5-12 to 5-13
16-channel NRSE system (figure), 5-13
when to use, 5-13

NRSE. See nonreferenced single-ended 
(NRSE) measurement system.

Nyquist frequency, 5-2
Nyquist Theorem, 5-2

O
OBF (Output Buffer Full) line, 17-2
one-point calibration, 22-5 to 22-6
one-shots, 24-6

OUT output pin, 23-2
OUT signal, 23-3 to 23-4
Output Buffer Full (OBF) line, 17-2

P
parallel mode (SCXI)

analog input modules, 19-6 to 19-7
channel addressing, 20-1 to 20-2
digital modules (Macintosh and 

Windows), 19-7
SCXI-1200 (Windows), 19-7

parameters for VIs
common DAQ VI parameters, 3-7 to 3-8
conventions, 3-5 to 3-6

pattern generation, 17-1 to 17-2
period measurement. See frequency and period 

measurement.
platinum RTDs (note), 21-12
polling for analog input, 6-10
ports

digital ports and lines, 15-1
grouping ports without handshaking, A-2
VI port addressing, 3-9 to 3-11
writing and reading lines 

simultaneously, A-2
pressure measurement with strain gauges 

(example), 21-13 to 21-16
Probe tool, 29-4
Pulse Generator Config VI, 26-6
pulse train generation, 24-5 to 24-8

continuous pulse train, 24-5 to 24-7
duty cycles, 24-2 to 24-3
finite pulse train, 24-7 to 24-8
illustration, 24-2
physical connections for generating

continuous pulse train (figure), 24-5
finite pulse train (figure), 24-7

supplying external test clock from DAQ 
device, 13-3

terminology related to, 24-2
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pulse width measurement, 25-1 to 25-4
controlling pulse width measurement, 

25-3 to 25-4
counting input signals (figure), 25-2
determining pulse width, 25-2 to 25-3
increasing measurable width range, 25-4
overview, 25-1 to 25-2
physical connections for determining 

pulse width (figure), 25-2
Pulse Width or Period Meas Config VI

controlling pulse width measurement, 
25-3 to 25-4

measuring frequency and period, 
26-4 to 26-5

pulsed counter signal generation, 24-1

Q
questions

about using DAQ devices, 4-3 to 4-5
common questions LabVIEW data 

acquisition, A-1 to A-4

R
range of device voltage, 5-4 to 5-5

considerations for selecting analog input 
settings, 5-6 to 5-8

description, 5-4 to 5-5
effect on ADC precision (figure), 5-5
measurement precision for various device 

ranges and limit settings (table), 5-8
Read 1 Point from Digital Line example 

VI, 16-1
Read from Digital Line VI, 16-2
Read from Digital Port example VI

digital input application, 21-17 to 21-18
immediate digital I/O, 16-2

referenced signal sources, 5-2
referenced single-ended (RSE) measurement 

system, 5-11 to 5-12
relay SCXI modules, 19-6

REQ (Request) line, 17-2
Resistance-Temperature Detectors (RTDs), 

21-10 to 21-13
resolution of ADC, 5-3 to 5-4

effects on ADC precision (figure), 5-4
round-robin scanning (figure), 9-2
row major order, 3-14 to 3-15
RSE (referenced single-ended) measuremen

system, 5-11 to 5-12
RTD Conversion VI, 21-12 to 21-13
RTDs for measuring temperature, 

21-10 to 21-13
run_me.llb example file, 3-2

S
SC-2042 RTD device, 21-11
Scale Constant Tuner VIs, 22-7
Scaling Constant Tuner VI, 21-5, 21-8
scan clock, 9-5 to 9-8

channel and scan intervals using channe
clock (figure), 9-1

devices without scan clocks (note), 9-6
input pins (table), 9-6
lack of external scan clock support in 

some devices (note), 9-6
MIO device ScanClock output (note), 9-5
scan-clock orientation of LabVIEW, 9-2
simultaneous control of scan and channe

clocks, 9-8
scans

channel clock rate parameter, 5-17
definition, 5-17
interval scanning, 5-17
maximum scan rate, calculating, 7-5
number of samples parameter, 5-17
number of scans to acquire 

parameter, 5-17
round-robin scanning (figure), 9-2
scan rate parameter, 5-17

SCXI 1124 Update Channels VI, 
21-16 to 21-17
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, 
SCXI application examples, 21-1 to 21-21
analog input applications for measuring 

temperature, 21-2 to 21-16
amplifier offset, 21-5
RTDs, 21-10 to 21-13
sensors for cold-junction 

compensation, 21-3 to 21-4
strain gauges, 21-13 to 21-16
thermocouples, 21-2 to 21-3
VI examples, 21-6 to 21-10

analog output application, 21-16 to 21-17
digital input application, 21-17 to 21-18
digital output application, 21-19 to 21-20
multi-chassis applications, 

21-20 to 21-21
overview, 21-1 to 21-2
pressure measurement with strain gauges, 

21-13 to 21-16
temperature measurement applications

amplifier offset, 21-5
sensors for cold-junction 

compensation, 21-3 to 21-4
using RTDs, 21-10 to 21-13
using thermocouples, 21-2 to 21-10
VI examples, 21-6 to 21-10

SCXI Cal Constants VI
automatic calculation of calibration 

constants, 22-3
calibrating SCXI modules for signal 

generation, 22-8
loading saved calibration constants, 

22-7, 22-8
one-point calibration, 22-5, 22-6
overwriting default constants in 

EEPROM, 22-2
two-point calibration, 22-6 to 22-7

SCXI calibration, 22-1 to 22-8
EEPROM for storing calibration 

constants, 22-1 to 22-3
default load area, 22-2
factory area, 22-2
user area, 22-2 to 22-3

one-point calibration, 22-5 to 22-6

signal acquisition, 22-3 to 22-7
signal generation, 22-7 to 22-8
two-point calibration, 22-6 to 22-7

SCXI DAQ example files, 3-2
SCXI modules

components
chassis (figure), 19-4
illustration, 19-3
overview, 19-2 to 19-3

hardware configurations
illustration, 19-2
overview, 19-1
Windows or Macintosh systems, 

2-5 to 2-9
software installation and 

configuration, 19-8
configuration for Macintosh systems,

2-9 to 2-12
when to use, 4-3

SCXI operating modes, 19-5 to 19-7
multiplexed mode

analog input modules, 19-4 to 19-6
analog output modules, 19-6
channel addressing, 20-1 to 20-2
digital and relay modules, 19-6
SCXI-1200 (Windows), 19-5 to 19-6

parallel mode
analog input modules, 19-6 to 19-7
channel addressing, 20-1 to 20-2
digital modules (Macintosh and 

Windows), 19-7
SCXI-1200 (Windows), 19-7

SCXI programming considerations, 
20-1 to 20-5

channel addressing, 20-1 to 20-2
gains, 20-2 to 20-5

SCXI-1100 channel arrays, input 
limits array, and gains (table), 20-4

settling time, 20-5
SCXI Temperature Monitor VI, 21-9
SCXI Thermocouple example VIs, 21-4
SCXI-1100 channel arrays, input limits array

and gains (table), 20-4
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SCXI-1100 Thermocouple example VI, 21-6
SCXI-1100 Voltage example VI, 21-5
SCXI-1100/1122

one-point calibration, 22-5
two-point calibration, 22-7

SCXI-1120/1121 Thermocouple example 
VI, 21-10

SCXI-116x Digital Output VI, 21-20
SCXI-1162/1162HV Digital Input VI, 21-18
SCXI-1200 module

multiplexed mode (Windows), 
19-5 to 19-6

parallel mode (Windows), 19-7
settling time (SCXI), 20-5
signal conditioning

amplification, 18-3 to 18-4
common transducers (table), 18-1 to 18-2
common types of signal conditioning 

(figure), 18-3
definition, 18-2
filtering, 18-5
isolation, 18-4 to 18-5
linearization, 18-5
transducer excitation, 18-5

signal divider, 28-1
signal edges, 23-2
signal voltage range. See limit settings.
signals. See also analog input signals.

choosing between analog and digital 
signal analysis, 4-3

Simple Error Handler VI
analog output SCXI example, 21-17
debugging VIs, 29-3
multiple-channel single-point analog 

input, 6-5
simple-buffered analog input

data buffer overview, 7-1 to 7-2
examples

displaying waveforms on graphs, 
7-5 to 7-6

sampling with multiple starts, 
7-7 to 7-8

writing to spreadsheet file, 7-8

multiple-waveform acquisition, 
7-3 to 7-5

single-waveform acquisition, 7-2 to 7-3
waiting to analyze data, 7-1 to 7-2

single-channel single-point analog input
choosing between single-point and 

multi-point acquisition, 4-4
description, 6-1 to 6-2

single-ended measurement system
nonreferenced, 5-12 to 5-13
referenced, 5-11 to 5-12

single-immediate updates, 11-1 to 11-2
single-point analog output

choosing between single-point or 
multiple-point generation, 4-4

overview, 10-1
single-stepping through VIs, 29-3
single-waveform acquisition, 7-2 to 7-3
software. See LabVIEW software; NI-DAQ 

software.
software installation and configuration

debugging configuration errors, 29-2
SCXI modules, 19-8

on Macintosh computers, 
2-10 to 2-12

software timing, 10-1
software triggering

description, 8-9 to 8-12
examples, 8-12
timeline of conditional retrieval 

(figure), 8-10
software-timed analog input/output control 

loops, 6-6 to 6-7
solution DAQ example files, 3-2
SOURCE input

gating levels (figure), 23-3
increasing measurable width range, 25-4
measuring pulse width, 25-1 to 25-2

SOURCE input pin, 23-2
spreadsheet files

Cont Acq to Spreadsheet File.vi, 7-15
simple buffered-analog input 

example, 7-8
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l 
square pulse generation, 24-1 to 24-5
overview, 24-1 to 24-3
single square pulse generation, 

24-3 to 24-5
Generate Delayed Pulse VI, 24-4
physical connections (figure), 24-4
using Intermediate VIs, 24-4 to 24-5

square wave period measurement 
(figure), 26-2

STB (Strobe Input) line, 17-2
strain gauges for measuring pressure 

(example), 21-13 to 21-16
Strobe Input (STB) line, 17-2

T
technical support, B-1 to B-2
telephone and fax support, B-2
temperature measurement applications (SCXI)

amplifier offset, 21-5
sensors for cold-junction compensation, 

21-3 to 21-4
using RTDs, 21-10 to 21-13
using thermocouples, 21-2 to 21-10
VI examples, 21-6 to 21-10

terminal count (TC), 23-4
Thermocouple VI example VI, 21-6
thermocouples

definition of, 21-2
measuring temperature (example), 

21-2 to 21-10
timebase period uncertainty, 24-8 to 24-9
toggled counter signal generation, 24-1
transducers

common transducers (table), 18-1 to 18-2
excitation, 18-5
linearization, 18-5
signal conditioning for common types of 

transducers/signals (figure), 18-3
Transistor-Transistor Logic (TTL) 

signals, 23-1
transposing arrays, 7-6

triggered buffered waveform acquisition and
generation

E-Series MIO boards
hardware triggered, 14-3 to 14-4
software triggered, 14-1 to 14-3

legacy MIO boards
hardware triggered, 14-6
software triggered, 14-4 to 14-5

triggered data acquisition, 8-1 to 8-12
analog triggering

description, 8-5 to 8-7
examples, 8-7 to 8-9

choosing between triggering and externa
clock control, 4-4

deciding which digital trigger 
setting to use, A-3

digital triggering
description, 8-2 to 8-3
examples, 8-3 to 8-5

hardware triggering, 8-1 to 8-9
overview, 8-1
software triggering

description, 8-9 to 8-12
examples, 8-12

triggering, definition, 8-1
triggers, definition, 8-1
TTL signals, 23-1
two-dimensional (2D) arrays, 3-14 to 3-16
two-point calibration, 22-6 to 22-7

U
update clock

controlling externally, 13-1 to 13-3
Generate N Updates-ExtUpdateClk 

example VI, 13-1 to 13-2
input pins for external update clock 

(table), 13-2
supplying external test clock from DAQ 

device, 13-3
Utility VIs, 3-5
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V
VIs. See also specific VIs.

Advanced. See Advanced VIs.
channel, port, and counter addressing, 

3-9 to 3-11
common DAQ VI parameters, 3-7 to 3-8
crashing VIs in Windows, A-3 to A-4
data organization for analog applications, 

3-14 to 3-16
debugging, 29-1 to 29-4
default and current value conventions, 

3-6 to 3-7
Easy VIs. See Easy VIs.
error handling, 3-8
finding VIs in LabVIEW, 3-2
Intermediate VIs. See Intermediate VIs.
limit settings, 3-11 to 3-14
organization, 3-4 to 3-5
parameter conventions, 3-5 to 3-6
SCXI examples, 21-6 to 21-10
Utility VIs, 3-5

W
Wait (ms) VI, 6-10, 24-9
Wait on Occurrence function, 7-12
Wait Until Next ms Multiple VI

improving control loop 
performance, 6-10

multiple-channel single-point analog 
input, 6-5

software-timed analog I/O control 
loops, 6-6

waveform acquisition and generation
buffered analog output, 12-1 to 12-3

circular-buffered output, 
12-3 to 12-5

eliminating errors from 
circular-buffered applications, 12-5

examples, 12-5 to 12-6
overview, 10-1 to 10-2

simple-buffered analog input
multiple-waveform acquisition, 

7-3 to 7-5
single-waveform acquisition, 

7-2 to 7-3
simultaneous buffered, 14-1 to 14-6

E-Series MIO boards, 14-1 to 14-4
legacy MIO boards, 14-4 to 14-6

Wheatstone bridge, 21-13
Windows environment

installation and configuration
channel configuration, 2-12
DAQ devices, 2-6
SCXI hardware, 2-8 to 2-9

LabVIEW data acquisition hardware 
support (table), 2-4

NI-DAQ drivers, 2-3
questions and answers, A-3 to A-4

Write 1 Point to Digital Line example VI, 16-1
Write N Updates example VI, 11-3
Write to Digital Line VI, 16-2
Write to Digital Port VI

digital output application, 21-19 to 21-20
immediate digital I/O, 16-2

Write to Spreadsheet File VI, 7-8
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